CONTENT

INTRODUCTION

WHAT IS QLIKVIEW? ................................................................. 11
ABOUT THE TUTORIAL ............................................................. 13
FILES NEEDED FOR THE TUTORIAL ........................................ 15
CONVENTIONS ........................................................................... 17
  General conventions ............................................................... 17
  Keyboard conventions ............................................................ 17
  Regional settings ................................................................. 18
BASICS ..................................................................................... 19
  Starting QlikView ................................................................. 19
  The Start Page ......................................................................... 19
  Opening a document ............................................................. 20
  Saving a document ............................................................... 20
  Closing a document ............................................................. 20
  QlikView Help ........................................................................ 20
  Using Documents on a QlikView Server ................................. 21

WORKING WITH QLIKVIEW

INTRODUCTION ........................................................................... 25

LESSON 1. MAKING QUERIES IN QLIKVIEW ............................. 27
  Opening the document .......................................................... 27
  Basic QlikView terminology .................................................. 28
  Selections ............................................................................... 28
  Stepping back or forward in the list of selections ...................... 32
  Locking and unlocking selections ......................................... 32
  Searching values ..................................................................... 33
  Selection bookmarks ............................................................ 35
  Saving your work .................................................................... 37
  Checking your work ............................................................. 37

LESSON 2. HANDLING SHEETS AND SHEET OBJECTS .................. 39
<table>
<thead>
<tr>
<th>Lesson</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>List Boxes and Statistics Boxes</td>
</tr>
<tr>
<td>4</td>
<td>Bar Charts and Pie Charts</td>
</tr>
<tr>
<td>5</td>
<td>Pivot Tables and Straight Tables</td>
</tr>
<tr>
<td>6</td>
<td>More Chart Types</td>
</tr>
</tbody>
</table>
LESSON 7. MULTI BOXES, TABLE BOXES AND INPUT BOXES  ...... 101
Opening the document .............................................................. 101
The multi box ........................................................................... 101
The table box ............................................................................. 104
Using an input box .................................................................... 107
Saving, closing and exiting ....................................................... 110

LESSON 8. BUTTONS, TEXT OBJECTS AND LINE/ARROW OBJECTS ...
111
Opening the document .............................................................. 111
The text object ........................................................................... 112
The line/arrow object ................................................................. 113
The button .................................................................................. 114
Saving, closing and exiting ....................................................... 118

LESSON 9. SLIDERS, CURRENT SELECTION OBJECTS AND BOOKMARK OBJECTS 119
Opening the document .............................................................. 119
The slider/calendar object (in slider mode) ................................. 119
Creating a Current Selections box ............................................ 121
Creating a bookmark object ..................................................... 121
Saving, closing and exiting ....................................................... 122

LESSON 10. DOCUMENT PROPERTIES, USER PREFERENCES AND RE-
LOAD 123
Opening the document .............................................................. 123
Setting Document Properties .................................................. 123
User Preferences ........................................................................ 128
Reloading data .......................................................................... 128
Saving, closing and exiting ....................................................... 129
Checking your work .................................................................... 129
What’s next? .............................................................................. 129

CREATING A DOCUMENT

INTRODUCTION ................................................................. 133

LESSON 11. LOADING DATA INTO QLIKVIEW ............................ 135
Looking at a delimited text file .................................................................136
Creating a new QlikView document ..........................................................137
Loading a text file into QlikView ...............................................................137
Saving, closing and exiting .................................................................143

LESSON 12. ASSOCIATING DATA FROM MANY TABLES .................. 145
Associations ...............................................................................................145
Opening the document ..............................................................................146
Loading and associating a second table ....................................................147
Renaming fields .........................................................................................148
Saving, closing and exiting .......................................................................151

LESSON 13. CONCATENATING TABLES ........................................ 153
Opening the document ...............................................................................153
Automatic concatenation ...........................................................................153
Forced concatenation .................................................................................155
Saving, closing and exiting .......................................................................158

LESSON 14. THE TABLE STRUCTURE ........................................ 159
Using the Table Viewer .............................................................................159
Labelling tables in the script .....................................................................161
Improving the layout .................................................................................162
Saving, closing and exiting .......................................................................162

LESSON 15. LAYOUT THEMES .................................................. 163
Creating a theme ........................................................................................163
Applying a theme .......................................................................................165
Saving, closing and exiting .......................................................................166

LESSON 16. LOADING ADDITIONAL FILES ............................... 167
Opening the document ...............................................................................167
Loading a tab separated file without labels ...............................................167
Loading a file via OLE DB ........................................................................168
Saving, closing and exiting .......................................................................171

LESSON 17. LINKING EXTERNAL INFORMATION TO A DOCUMENT 173
Opening the document ...............................................................................173
Looking at an info table .............................................................................173
Loading the info table ..............................................................................174
Viewing the linked information ..................................................................175
Embedding external info ...........................................................................176
Displaying info in a text object .................................................................176
Saving, closing and exiting .......................................................................177
What’s next? ..............................................................................................177
ADVANCED FEATURES

INTRODUCTION ................................................................. 181

LESSON 18. MORE ABOUT ASSOCIATIONS ......................... 183
Creating a system sheet .................................................... 183
Using the system sheet ..................................................... 184
Creating a system table ................................................... 186
Showing frequency in key fields ....................................... 187

LESSON 19. LOAD INLINE ......................................................... 191
Adding a record with load inline ....................................... 191
Adding a table with load inline ......................................... 192

LESSON 20. FIELD GROUPS AND CYCLIC DISPLAY ............ 195
Field groups ..................................................................... 195
Cyclic display of expressions ............................................ 200

LESSON 21. LOADING CROSS TABLES ................................. 203
Loading a cross table ....................................................... 203
Loading a cross table with more than one regular column ... 205

LESSON 22. AND-MODE IN A LIST BOX ............................... 209
Making an and-selection .................................................. 209
Making a not selection ..................................................... 210
Characteristics of the and table ......................................... 211

LESSON 23. NUMBER FORMATS ........................................... 213
Handling of numeric data ................................................ 213
Interpretation of numeric data ......................................... 214
Formatting of data ......................................................... 218

LESSON 24. SECURITY ............................................................ 221
Sections in the Script ....................................................... 221
Access levels .................................................................... 221
Security fields ............................................................... 222
Loading security tables .................................................. 224
Using the Security pages ................................................ 226
Opening a document with access restriction ..................... 228

5. WHAT’S NEXT? ................................................................. 229
QlikView Training Program ................................................ 229
QlikCommunity ............................................................... 229
QlikView Demo Applications ............................................ 230
INTRODUCTION

• What is QlikView?
• About the Tutorial
• Basics
WHAT IS QLIKVIEW?

QlikView is a software that enables all kinds of users from beginners to experts to retrieve and assimilate data easily from any source: databases like SQL Server or Oracle as well as Excel, XML or text files. Enterprise applications such as SAP may also be used as data source for a QlikView analysis.

Once loaded into the program, the data is presented in an intuitive and easy-to-use interface. To make selections in QlikView, you don’t need any previous knowledge of databases or search routines: you simply click on the item of which you want to know more, and the program immediately filters the data and presents all associated items. Extensive search options - direct and indirect - allow you to find any information and deliver instant answers to your questions.

QlikView offers a wide variety of graphs, charts and tables in different formats to present your data the way you want. Different views, zoom, grouping or animation create a deeper understanding and provide an even better overview. Creating the interface is very easy and does not require help from the IT department. Any graphic or table can be printed or exported to other programs for further processing.

QlikView standalone can be used for free, as a Personal Edition. With QlikView Personal Edition you can make full use of the QlikView functionality, but it is not possible to open documents created by other users. To do this, you need a QlikView license.

The QlikView product group also includes QlikView Server and QlikView Publisher that can be used for centralized management of QlikView applications, for automated updates and for distribution of documents to several users. Documents published on a QlikView Server can be accessed by different clients including Internet Explorer Plugin, AJAX Zero Footprint and several mobile clients such as IPhone, IPad, Android and Blackberry.

For more information on QlikView see www.qlikview.com.
ABOUT THE TUTORIAL

The QlikView Tutorial is a self-study course for beginners. It contains explanations and lessons that take you step by step through various features. No prior QlikView experience or database knowledge is required to take the tutorial. Working through the entire tutorial will take about 8 hours, but not all parts are equally relevant to every user.

The Tutorial consists of three parts: Working with QlikView, Creating a Document, and Advanced Features.

The first part, Working with QlikView, starts with a thorough description of how to make selections and searches in an existing QlikView document. For end users who do not have the intention to build or modify QlikView documents, the very first chapter of the tutorial may already provide sufficient information for the daily work.

Working with QlikView continues with an introduction to the components of the user interface of a QlikView document and demonstrates the use and creation of these components. This part is relevant to all users in charge of building or modifying the user interface of QlikView documents. Application designers will find valuable information here, but interested end users or application developers may also take advantage from it.

The second part, Creating a Document, presents the procedure of loading data into QlikView. You will learn how to load data from different sources, how QlikView builds associations between different sets of data and how to link external information to the data. This part is crucial to application developers who are creating QlikView documents from scratch or modifying the data structures in existing documents.

Finally, Advanced Features can be seen as a continuation of both of the previous parts. Here you will learn how to build more complicated documents, as well as how to use more advanced features in the script. Access restriction and number formats are examples of topics to be discussed. Whereas the lessons in the first two parts build on each other, the lessons in the third part are independent from each other and users can directly pick the interesting topics.

Apart from this tutorial, there are many other resources for new and advanced QlikView users. See “What’s next?” on page 229 for details.
FILES NEEDED FOR THE TUTORIAL

If you have not yet installed QlikView standalone on your computer, you should do so. The software can be downloaded for free from the QlikView download page on www.qlikview.com. To access the download page, you must register, or log in to your QlikView account if you are already registered.

Please download the installation package in your language, and suitable for your hardware and operating system, and install it on your computer.

If you have purchased a QlikView license, you can enter it when starting the program for the first time. Otherwise you can use QlikView without a license as Personal Edition. As the name says, this is for personal usage only, so you are not allowed to work with files created by other users on other computers when working with Personal Edition.

To go through the lessons in this tutorial, you need a number of sample files. They are located in a folder called Tutorial that can also be downloaded from the QlikView download page under Documentation. If you have already installed QlikView, a hyperlink on the Getting Started tab of the start page will bring you directly to the download page. As an alternative, the file package is available on under Services - Training - Free Training on the QlikView homepage.

Please install the file package to your computer. By default it is installed in C:\Program Files\QlikView\Tutorial. Of course you can install it to any other folder of your choice. Just be sure to remember where to find the files.

Before you start working with the lessons, read the two following sections of this introduction, Conventions and Basic. Conventions informs you about the terms used in the Tutorial, whereas Basics familiarizes you with basic actions such as starting QlikView, opening, saving and closing a document, and using the help.
CONVENTIONS

Before you start using QlikView, it is important to understand the terms and notational conventions used in the Tutorial. In this section some of the terms will be explained.

General conventions

• The word "choose" is used for carrying out a menu command or a command button in the tool bar or in a dialog.

• The word "select" is used for highlighting an object in a list or on a sheet that you want your next action to affect. It is also used for highlighting field values, thereby making logical selections within the data.

• Numbered lists (e.g. 1, 2, 3, ...) indicate procedures with two or more sequential steps.

• Bulleted lists, such as this one, provide information, and do not indicate procedural steps.

Keyboard conventions

• Key names appear in small capital letters, e.g. "Press ENTER".

• The RETURN key and the ENTER key perform the same action in QlikView.

• A plus sign "+" used between two key names indicates that you must press both keys at the same time. E.g., CTRL+S means that you should hold down the CTRL-key, then press the S key while still holding down CTRL.

• A comma sign ",," used between two key names indicates that you must press the keys sequentially.
Regional settings

Please note that your computer’s regional settings might affect your work in QlikView. For example, the default date and number formats differ between Swedish and English, which might affect calculations if you run English QlikView on a computer with Swedish regional settings. In order to get the best possible results, run this tutorial on a computer with the same language settings as the QlikView document.
BASICS

Starting QlikView

You find QlikView on the Start menu, under Programs.

It is also possible to start QlikView by double-clicking the icon of a QlikView file. After QlikView has started, the file will be opened.

The Start Page

The start page contains several tabs. Only two of the tabs are mentioned here but there are many other useful tabs and functions. For more information about the start page, please consult the QlikView Reference Manual or the QlikView html help.

Getting started

Contains information and links that can help you explore the wealth of possibilities in QlikView. This includes direct links to download this Tutorial, links to selected demo examples, a link to the QlikView demo example folder on your local computer and links to selected resources at www.qlik-tech.com.

Recently Opened Documents

The list on this page shows your recently opened documents. Just click a document or web page in this list to re-open it.

If you don't want the start page to appear when you start the program, deselect the Show Start Page When Launching QlikView check box at the bottom of the start page. If you close the start page, it can be reopened at any time by choosing Show Start Page from the Help menu.
Opening a document

Use the Open command on the File menu or the Open button on the toolbar to open an existing file. If the file was one of the latest QlikView documents used, you can also open it by choosing the file name from the Start Page or the File menu.

Several files can be open simultaneously. Each document appears in its own window. In this case, you can activate another file by choosing it from the list on the Window menu, or by using the key combination CTRL+TAB.

Saving a document

Use the Save command on the File menu or the Save button on the toolbar to save an open document. When developing documents, you should save periodically so that you do not lose your work in the event of hardware or software problems or a power failure.

There are two save commands on the File menu: Save and Save As. Use the Save As command to save your document under a new file name.

Note It is usually a good idea to save the document before making any major changes or a lengthy operation.

Closing a document

You can close a document at any time by using the Close command in the File menu. If you have made any changes, QlikView will display a message asking whether you want to save the changes or not. Selections are considered as changes. Choose the Yes button to save, the No button to close the document without saving, or the Cancel button to cancel the closing procedure.

QlikView Help

QlikView Help is a conventional Help program. To find out how to use the Help program, choose Using Help from the Help menu. For specific help on QlikView, choose Contents from the Help menu. On the Search page you can perform text searches for topics containing the information that you are looking for.
Context sensitive help can be obtained by pressing the F1 key or by pressing the Context help button in the toolbar.

**Using Documents on a QlikView Server**

All variants of QlikView can be used to access documents on a QlikView Server. This is done via the Open in Server command on the File menu, or from the Open in Server tab on the Start page.

However, since we cannot assume that you have access to any QlikView Server, this tutorial deals only with the use of local documents.
WORKING WITH QLIKVIEW

• Making selections in QlikView
• Working with sheets and sheet objects
• Creating sheets and sheet objects
• Exporting and printing data
INTRODUCTION

This part of the Tutorial will show you how to work with an existing QlikView document. Once familiar with the basic terminology, you will learn how to make selections in QlikView. Subsequently, the components of the QlikView document will be described one by one: you will learn how to modify and work with the different sheet objects to get the results you are looking for.

Where to find the Tutorial files

In case you have not yet installed the Tutorial files, please do so now. You can download the latest Tutorial files from the Internet, see “About the Tutorial” on page 13.

By default the tutorial folder is installed in C:\Program Files\QlikView\Tutorial. It has a subfolder named Working with QlikView, which contains the necessary files for this first part of the Tutorial.

Checking your results

Working with QlikView contains two QlikView files: Tutorial.qvw and TutorialFinal.qvw. Tutorial.qvw is the file you will be working with. If you follow all steps correctly, your final document will look like TutorialFinal.qvw. At the end of Part 1 of the Tutorial you can compare your file to TutorialFinal.qvw.
LESSON 1  MAKING QUERIES IN QLIKVIEW

In this lesson you will get an overview of the basic components of a QlikView document and learn how to make queries in QlikView.

Opening the document

1. Start QlikView by double-clicking the QlikView icon (for other ways of starting the program see page 19).
2. Choose Open from the File menu.
3. Select the file Tutorial.qvw under C:\Program Files\QlikView\Tutorial\Working with QlikView, or where your program files are normally installed, then click Open.

You have now opened this QlikView document.
Basic QlikView terminology

First of all, familiarize yourself with the QlikView terminology.

At the top of the screen you have the QlikView menu bar; below this, a toolbar. One or more tabs are shown under the toolbar. Each tab is attached to a sheet.

On each sheet there is a number of sheet objects. The most basic sheet object is the list box. Each list box represents a column (field) of the loaded database table, and contains a number of (field) values. Statistics boxes, charts, multi boxes and table boxes are sheet objects that can be created to get a better overview of data. Buttons are used for performing certain commands.

Selections

In QlikView, the main way of making queries is through the selection of field values. When you make a selection, the program instantaneously shows all the field values in the document that are related to the selected field value.
Making queries in QlikView

To make a query, or a search, in the database, you just click on something you want to know more about.

1. Click on the tab Geography to open the Geography sheet.

2. In the list box Country, place the mouse cursor on the value Albania and click.

The color of the cell turns green. In QlikView terms, the value is selected. This means that this is the item of which you want to know more. The result of the search is displayed instantaneously in all the other sheet objects. You immediately see which of the values in the other list boxes are compatible with the selection and which are not.

The cells of associated field values are white. Selected and associated values are referred to as possible values in this Tutorial.

A cell whose contents are not associated (whose value does not occur in combination with that of the selected item) is called excluded. The cells of excluded values are gray.

To facilitate the overview of the query result, the contents of the list boxes have been sorted, not only alphabetically, but also by their state: optional values are put at the beginning of the list, excluded values at the end.
To undo your selection, simply click on the selected cell again, or click on another cell in the same list box. The new selection will replace your previous selection.

To select more than one item in the same list box, hold the CTRL key down while selecting additional values. If the items you are selecting are adjacent to your first selection, you can instead hold the left mouse button down while dragging the mouse cursor.

After this multiple selection within a field, QlikView shows the combinations belonging to any of the field values (logical or) as optional values.

Combining selections

An optional value in another list box can be selected in combination with a previously selected value. When you select an optional value from a list box and then select another optional value from another list box, QlikView will show the combinations belonging to both selections (logical and) as options.

1. Clear your selections by clicking the Clear button in the toolbar.
2. Click on the tab Sales.
3. Suppose you want to know which salesman has sold products to Captain Cook’s Surfing School in Monaco. Go to the list box Customer and search for the value Captain Cook’s Surfing School.
4. Select the value by clicking it.
5. Seven values in the list box Country are white, i.e. compatible with the selection. Select Monaco.

You now see that Joe Cheng is the salesman you are looking for. The value Joe Cheng is the only one compatible with both Captain Cook’s Surfing School and Monaco.

By making consecutive selections this way, it is thus possible to step by step get closer to the answer you are looking for.

Keeping track of your selections

When you make many selections at the same time it can sometimes be hard to keep track of them. In order to help you with this QlikView has two good tools, the Current Selections box and the Current Selections window.
MAKING QUERIES IN QLIKVIEW

On the Geography sheet you will find a current selections box. This sheet object lists all fields in which selections have been made and the values selected. If too many values are selected, only the number of selected values is shown.

1. Make some additional selections in the list boxes and watch how they are reflected in the current selections box.

    | Fields  | Values                                                                 |
    |---------|----------------------------------------------------------------------|
    | Country | Afghanistan, Monaco                                                  |
    | Customer| Captain Cook’s Surfing School                                        |

Not all QlikView documents have current selections boxes on all sheets. If you want to keep track of your selections anyway, you can use the Current Selections window.

2. Click the Current Selections button in the toolbar.

A new window will now appear on top of the QlikView window. This window resembles the current selections box quite a bit, but can be moved around as you please and will stay in place even if you go to a different sheet or start working with another document.

3. Make some selections and watch how they are reflected in the Current Selections window.

4. Close the Current Selections window by once again clicking the Current Selections button in the toolbar.

Moving selections

The current selections in an active list box can be moved by means of keyboard keys:

1. Clear your selections by clicking the Clear button in the toolbar.

2. Still on the Geography sheet, select the value Afghanistan. The values related to this value are now shown in the other list boxes.

3. Use the ↓ key of your keyboard to move the current selection one step downwards in the list box. Note that the other sheet objects are updated to show the result of the new selection.
To move the selection upwards, use the $\uparrow$ key. Pressing an arrow key when no selection is made is equivalent to scrolling the active list box.

**Stepping back or forward in the list of selections**

QlikView remembers the last 100 selections. By clicking the **Back** button in the toolbar, you go back to your previous selection:

1. Click the **Back** button in the toolbar. Note that your previous selection is displayed.
2. Click **Back** again to go back another step.

To move forward in the list of selections, do the following:

3. Click the **Forward** button in the toolbar and study the result.

This way, you can go back and forth in the list of selections as you wish. Note that the **Back** and **Forward** buttons only apply to selections: other changes, like the removal of an object or the change of a setting, are not affected.

**Locking and unlocking selections**

The logic of QlikView by default replaces a previous selection with the new selection if the previous selection is in conflict with the new selection.

1. Select an excluded (gray) value. Note that your old selection disappears.

To prevent this, selections may be **locked**. Locked cells are blue. A selection in conflict with a locked selection will not be performed.

2. Choose **Lock** from the **Selections** menu or from the toolbar. This will lock all selections, preventing them from being cleared by mistake.
3. Try to select an excluded value in another list box and note that it is not possible.
4. To unlock all selections, choose **Unlock** from the **Selections** menu or from the toolbar.

It is also possible to lock fields individually:

5. Select *Albania* in the list box *Country*.
MAKING QUERIES IN QLIKVIEW

6 Click with the right mouse button on the list box \textit{Country}, then choose the \textbf{Lock} command from the float menu. This will lock the selected field values of this specific field. Because the field \textit{Albania} also exist in the multi box called \textit{Multi Box}, it is also locked there.

If there are no selected items in the list, the \textbf{Lock} command in the float menu is inactive (dimmed).

7 To unlock the selection in one field, choose \textbf{Unlock} from the float menu (or the \textbf{Object} menu) of the list box containing it.

Searching values

Normal text search

To find values in list boxes, especially in list boxes with many values, you can use the text search. Suppose you are looking for the value \textit{Greece}.

1 Clear your selections by choosing \textbf{Clear} from the \textbf{Selections} menu.

2 Click on the title bar of the list box \textit{Country} (on the \textit{Geography} sheet) to make it active. Active sheet objects have a green title bar in this document.

3 Type the letters “gr”. The search string appears in a separate window. Now the list box shows only countries containing a word starting with “gr”. The search string is highlighted in the values.

Instead of just starting to type you may also choose \textbf{Search} from the \textbf{Edit} menu or click the \textbf{Search} icon in the toolbar. List boxes can also be configured to hold a little search icon in the captions. These icons can be clicked directly to open the search window.

Hitting the \textbf{ENTER} key will select all values matching your search string. It is also possible to click on the country you wish to select.

Text search with wildcards

By means of the wildcard search you can extend the number of hits to all values containing your search string at any place. It is also possible to find values ending or starting with the search string.
Click on the title bar of the list box Country and type the letters “co”. The result of the search are values containing a word starting with “co”.

Add the wildcard * at the end of your search string. It stands for one or several arbitrary characters. Now only values starting with “co” at the very beginning are shown. Ivory Coast is no longer matching the search.

Add another wildcard * at the beginning of the search string, so that it reads “*co*”. The result of this search are all values containing “co” at any place in the string.

Remove the trailing wildcard * at the end of the search string. The result of this search are all values ending with “co”.

**Numeric search**

Similarly, if the search is made in a field containing numeric data, you can start your search string with greater than “>” or less than “<” and then enter a number. Suppose you want to select all countries with a population above 1 billion:

Clear your selections by clicking the Clear button in the toolbar.

Click on the title bar of the list box Population(mio).

Type >1000. The string appears in a separate window.

Only numbers above 1000 are now optional in the list box. Press ENTER to select them.

The sheet objects are updated to reflect the result of the selection.

**Using a search object**

With the search object you can search simultaneously in multiple fields or all fields in the document.
Clear your selections by clicking the **Clear** button in the toolbar.

Click into the search object on the **Geography** sheet.

Type “par”. As you can see, the search object offers you several hits for this search string, grouped by the fields containing these values.

To select values you can click on a value or on a field name to select all hits for this field. You can even select several hits by holding the CTRL key while clicking, provided that the selected values are logically compatible with each other.

You can use this kind of general search to find associated values in a list box. To do so, click the chevron in the search window when searching in a list box.

Apart from the search options explained here, you can perform a fuzzy search to find values similar to your search string or an advanced search to use search expressions. Please refer to the QlikView help or manual for details.

**Selection bookmarks**

It is possible to save a set of selections for later use:

Select one or several values, then choose **Add Bookmark** from the **Bookmarks** menu.
The default name for the created bookmark is that of the current date (displayed in the Create Bookmark dialog, see the picture). In addition, the first bookmark created on a specific day gets number 1, the second number 2, etc. However, you can change the default name to a more explanatory text:

2 Type an appropriate bookmark name in the dialog, then click OK.

3 Go to the Bookmarks menu again and note that your bookmark has appeared in the list of created bookmarks.

4 Clear the current selections by clicking Clear in the toolbar.

To show the saved set of selections again, simply select the bookmark in the list.

A maximum of ten bookmarks can be displayed in the list. To see further bookmarks, to get more details on a specific bookmark or to delete a bookmark, choose More from the Bookmarks menu.

Bookmarks can also be created and selected via a bookmark object in the layout. More about this on page 121 and in the QlikView Reference Manual.

Now that you have learned how to make selections in QlikView, it is time to describe the components of the document more thoroughly. The most basic component is the sheet, which will be introduced in the next lesson.
MAKING QUERIES IN QLIKVIEW

 Saving your work

If you don’t want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.

1. Choose **Save As** from the **File** menu to save a copy of the document.

2. Type *MyTutorial.qvw* or something similar in the **File name** box, then click **Save**.

QlikView saves the copy. *MyTutorial.qvw* now contains all the changes you have made since you opened the document, whereas the original document (*Tutorial.qvw*) remains unchanged.

You can now close the file:

3. Choose **Close** from the **File** menu.

If you will not be working with QlikView for a while, you can also exit the program:

4. Choose **Exit** from the **File** menu.

 Checking your work

The folder *Working with QlikView* contains not only the file *Tutorial.qvw* that you have been working with, but also a file called *TutorialFinal*. If you want to, you can open this file to compare it with the one you just saved.
LESSON 2  HANDLING SHEETS AND SHEET OBJECTS

This lesson introduces the sheet, which is the most basic component of the QlikView document. You will learn about the logical connection between the sheets. Another objective is to create a sheet, to add sheet objects to it, and to size and position them. To facilitate these tasks you will display and use the layout toolbar. Basic formatting of objects are at the end of this lesson.

Opening the document

If you closed the document and exited QlikView after the previous lesson, you need to open it again.

1. Start QlikView by double-clicking the QlikView icon (for other ways of starting the program see page 19).

2. Open the file MyTutorial.qvw. If you used the file recently you can open it directly from the Recently Opened Documents tab on the Start Page. The Start Page can be opened at any time under Help - Show Start Page.

Figure 3. The start page in QlikView
Sheets

Holding all the different objects, the sheet can be considered the most basic component in QlikView. A document usually contains several sheets, which is useful when one wants to achieve a more structured layout. Any sheet object can be put on any sheet. The sheets will, however, still be logically connected, i.e. a selection made on one sheet will affect all sheet objects on all other sheets.

Each sheet has a tab attached to it. Containing the name of the sheet, the tab helps you find the sheet you are looking for. By clicking on a tab, you activate the sheet attached to it. You recognize an active tab from the bold text.

Logical connections between sheets

There are two sheets in your document: Geography and Sales. Geography is the active sheet.

1. Click on the tab Sales.
   The tab name changes from normal to bold, and the sheet attached to it is shown.

2. Select the value Albania in the list box Country.
   The cell of the selected value turns green and you immediately see all the values of all other fields that are compatible with the selection (white). You see that the fictive company has one customer in Albania, Moe’s Laundromat, and that John Lemon is responsible for the sales.
   The sheets are logically connected, i.e. a selection made on one sheet will affect all sheet objects on all other sheets.

3. Go to the sheet Geography by clicking on its tab.
   The sheet Geography, on which you learn more about the geographical data related to the value Albania, also contains a Country list box. Note that the value Albania is selected (green) in this list box too, although you made your selection on the sheet Sales.
   Note the green dot on the tab Sales. This is a selection indicator, helping the user to keep track of selections made on other sheets. Especially in large documents containing many selections, this kind of reference to sheets where the selections can be changed is indispensable.
   If referring to a locked selection, the selection indicator is blue.

4. Go back to the sheet Sales.
5 Select the item Cezar Sandu (currently excluded, i.e. gray) in the list box Salesman.

You immediately see that Cezar Sandu has been active in France, Germany, and Mongolia. The item Albania, which is not compatible with the selected item Cezar Sandu, has been excluded.

6 Go back to the sheet Geography.

The data displayed in the sheet objects has been updated to show the result of the new selection: France, Germany and Mongolia, as well as the items related to these countries, are shown as optional (white).

Clear all selections by clicking the Clear button in the toolbar.

Adding a sheet

1 Choose Add Sheet from the Layout menu. A new sheet appears.

2 Click somewhere on the empty sheet with the right mouse button and choose Properties from the menu that appears. The Sheet Properties dialog will now appear.

![Sheet Properties dialog](image)

Figure 4. The Sheet Properties dialog

Working with QlikView
On the General page, change the title from Sheet2 to Customers.

By default, a new sheet inherits the default background that is set in the document properties. If you want the sheet to have a different background, you could set a special background color or image for the sheet in the Background group on the General page. We will leave this setting unchanged.

Still in the Sheet Properties dialog, click the Fields tab.

This dialog page contains a list of available fields. Select Customer, then click the Add > button. The field has now been moved to the column of displayed fields, which means that it will appear as a list box on your sheet.

You can also double-click fields in the left column to move them to the right (Fields Displayed in Listboxes). Double-click the field name Customer ID.

Click OK to close the dialog.

You have now created a new sheet containing two list boxes. Instead of creating a new sheet, it is also possible to right-click an existing sheet and choose Copy Sheet. When copying a sheet, all sheet objects on that sheet are copied at the same time.

The list boxes are not placed where you want them. You will fix this soon (under “Selecting and moving several sheet objects simultaneously” on page 45).
HANDLING SHEETS AND SHEET OBJECTS

Moving a sheet

Your new sheet Customers, containing the list boxes Customer and Customer ID, is placed to the right of the sheet Sales. Suppose you want it in the middle:

1. Click on the tab of your newly created sheet with the right mouse button. From the float menu that opens, choose Promote Sheet.

The new sheet has now been placed between the sheets Geography and Sales.

Adding new sheet objects

If you right-click somewhere on the sheet Customers, then select New Sheet Object, you see this list of all the sheet objects that can be used in QlikView.

All the sheet objects except buttons, text objects and line/arrow objects can be used for making selections in the data. All sheet objects may be used for viewing the result of selections.

The Customers sheet created in the previous lesson contains two list boxes, Customer and Customer ID. Suppose you want to add a third sheet object: a list box containing countries.

1. Make sure that the sheet Customers is active, then right-click somewhere on the sheet. Select New Sheet Object, then List Box. The dialog New List Box opens.

2. On the General page of the New List Box dialog, select Country from the drop-down list Field. Country will automatically become the title of the new list box. If you like, you can change the title on the same page under Title.

3. Click OK.

The field Country now appears as a list box on your sheet Customers.

In the following lessons, the most important sheet objects, including list boxes, will be introduced one by one. But first of all you need to learn how to present and position sheet objects on the sheet.
Moving a sheet object

To move a sheet object you select it with the mouse button, then keep the mouse button depressed while dragging it.

1 On the sheet Customers, align all sheet objects vertically on the left hand side of the sheet.

To move a sheet object step by step, use CTRL+arrow. For bigger steps, use CTRL+SHIFT+arrow.

Undo Layout Change

**Undo layout Change** in the toolbar is a very useful function that you can use to undo your latest layout change.

1 Undo your latest layout change. The list box moves back to its previous position.

You can also use the Windows command CTRL+Z to undo your changes.

**Undo layout Change** refers to moving, sizing and removing sheet objects as well as changes to document, sheet and sheet object properties.

QlikView maintains a list of the latest layout changes. Each **Undo Layout Change** command will take you backwards one step in the list. You can use this command in whenever something goes wrong or the result of the last change was not satisfactory.
Selecting and moving several sheet objects simultaneously

To move several sheet objects at the same time, start by selecting them. This is done in the following way:

1. On the sheet Customers, place the mouse cursor in the top left corner, then press it and drag a rectangle enclosing all the list boxes that you want to move. Note that the title bars of the enclosed list boxes turn green after you let go of the mouse button. This means that they are selected, i.e. active.

2. Place the mouse cursor on the title bar of one of the list boxes, then press the mouse button and drag. All the selected list boxes are moved.

If the list boxes are not perfectly aligned, don’t worry - you will fix this in a moment.

It is also possible to select several sheet objects by SHIFT-clicking their title bars. To activate all objects on a sheet, use the CTRL+A keys.

Figure 6. Activating several sheet objects
Copying sheet objects

To copy a sheet object on the same sheet, press the CTRL key and keep it depressed while placing the cursor on the title bar of the object that you want to copy. Drag the cursor to the place where you want to put the copy of the sheet object. You can either copy sheet objects to another place on the same sheet, or to another sheet.

In case you want to add a sheet object that is found on another sheet, you can simply copy it. The list box *Country*, e.g., is found on the sheet *Geography*:

1. Click on the tab of the sheet *Geography* to make it active.
2. Press the CTRL key and keep it depressed while placing the cursor on the title bar of the list box *Country*.
3. Press the mouse button and drag the list box to the tab *Customers*. While dragging, make sure that a small plus sign appears; if it does not, this means that you have released the CTRL key.
4. When the cursor turns into a white arrow on the tab *Customers*, release the mouse button, then the CTRL key.
5. Go to the sheet *Customer* to make sure that the list box *Country* has appeared. Its position on the sheet is now the same as on the sheet from which it was copied. Move it to the right of the other *Country* list box.

If you prefer the standard Windows Copy and Paste commands, they can be used as well. You find them in the Edit menu. The standard Windows shortcuts CTRL+C and CTRL+V also work.

Sizing a sheet object

You can size list boxes (and other sheet objects) by dragging the window frame of the object.

Figure 7. Sizing a sheet object
HANDLING SHEETS AND SHEET OBJECTS

1 Click on the title bar of the list box Customer ID (on the sheet Customers) to make it the only active list box. If other list boxes are active, they will be sized as well.

2 Move the pointer to one of the corners of the list box until the appearance of the pointer changes.

3 Press the mouse button and drag.

The list box Customer ID now overlaps the list box next to it. You will deal with this in the next section.

Aligning and distributing sheet objects on the sheet

There are several commands that help you tidy up the layout of your sheets by aligning and spacing your sheet objects.

1 Select all list boxes on the Customers sheet. If you have forgotten how to do this, see “Selecting and moving several sheet objects simultaneously” on page 45. You can tell from the green title bars which list boxes are selected (active).

2 As you are going to align the list boxes vertically, you may want to make them a little smaller. While several list boxes are active (selected) at the same time, you can size them all at once by dragging one of the window frames. See “Copying sheet objects” on page 46.

3 In the Layout menu, place the mouse cursor on the Align/Distribute command. The cascade menu that opens contains several commands. Choose Adjust Top.

4 The list boxes are now evenly spaced horizontally, but you also want them to be aligned to the left. Select all listboxes again if necessary, then choose Left Align.

5 While the list boxes are still active (green), move them down a little on the sheet.

Note Feel free to experiment with the layout. You can always use Undo Layout Change or CTRL+Z (Windows standard) to undo your layout changes.
Displaying and using the design toolbar

If you use a QlikView document only for making selections, the standard and navigation toolbars are sufficient: they contain the most common commands for working with a document.

However, as soon as you modify the layout, add objects etc., the design toolbar may be helpful. The design toolbar contains commands for adding sheet objects, moving sheets, and adjusting the layout.

1. Select View - Toolbars - Design to show the design toolbar.

Here you find the Align Left command that you used before. You used a corresponding menu command when aligning sheet objects.

See “Aligning and distributing sheet objects on the sheet” on page 47.

Minimizing and restoring a sheet object

List boxes and other sheet objects can be minimized if, for some reason, you don’t want them on the screen now but might need them again later.

Note the symbol in the upper right corner of the chart and the table box on your Geography sheet. This symbol indicates that the sheet object can be minimized. To make a list box minimizable, do the following:

1. Click on the list box Capital with the right mouse button and choose Properties... from the float menu.

2. Go to the Caption page and mark the check box Allow Minimize, then click OK.

The minimize symbol appears in the top right corner of the list box.

3. Click the symbol or double-click on the title bar of the list box.

The list box turns into an icon, which is placed where there is space on the sheet. The icon can be moved freely.

4. Restore the list box by double-clicking the icon.

You can also minimize a list box by right-clicking it and choosing Minimize from the float menu, and restore it by choosing Restore from the menu.
Auto Minimize

Auto Minimize is a useful function where only one of the charts on a certain sheet will have its full size at any given time. The others are minimized in order to save space on the sheet. The charts Area and Population on the Geography sheet have been preset to Auto Minimize.

Container Object

The container object is another useful tool for showing several object types in a limited space. Read more about the container object in the QlikView Reference Manual and QlikView Help.

Removing a sheet object

If you have followed all the steps above, there are two Country list boxes on your sheet Customers. You only need one:

1. Click on one of the Country list boxes of the sheet Customers with the right mouse button.
2. From the float menu that appears, choose Remove.
3. Confirm that you are sure about removing the list box by clicking OK.

The list box disappears from the screen.

Another possibility is to choose the Remove command from the Object menu. The Object menu is equivalent to the float menu of the active sheet object (the one whose title bar is green). If no sheet object is active, the Object menu belongs to the active sheet. If several sheet objects are active, the Object menu contains the commands that are common to the active objects.

A further possibility for removing a sheet object is by selecting it and pressing the DELETE key.

Changing the border of a sheet object

Every sheet object has a border that can be given a number of different appearances.

1. Click on a list box with the right mouse button, and choose Properties...
2. Go to the Layout page.
3. Pick a border format of your choice.
4. Click OK.
If you want all the sheet objects in the document to have the same border, you should change the setting in the Document Properties dialog instead (see page 124).

5 In order to keep a consistent layout, you should undo your change regarding the border. Click Undo Layout.

### Changing the font of a sheet object
Most sheet objects contain text. The text is written in a certain font. To change the font of a single object, open the Font page in the Properties dialog of the particular object. To change the font of the entire document, open the Font page of the Document Properties dialog (see page 124).

### Copying layout formats between sheet objects
If you want to copy formats from an existing sheet object to the other sheet objects, you can do this in a click using the Format Painter. The statistics box Population (mio) on the Geography sheet does not have the same layout as the other sheet objects. You can easily change that:

1 Select a sheet object that has the correct layout, for example the table box, so that its caption turns green.

2 Click the Format Painter button on the Design toolbar.

3 Click the statistics box Population (mio).

4 The layout (in this case: border and caption) of the statistics box changes.

You can use the Format Painter tool for any sheet object. You can also use it for several sheet objects at one time. Just click on the source object, then double-click on the Format Painter button and click on each of the target objects. To end the “painting”, click the Format Painter button again or click Esc.

### Linked Objects
If you want several objects to have the same layout properties, you can use linked objects. These are objects that share all properties with the exception of size, position and display state (minimized, normal or maximized). When you change the properties of one object the change is immediately reflected in the other linked objects. Linked objects can reside on the same sheet or on different sheets. To create a linked object:

1 Right-click a sheet object and select Copy to Clipboard - Object.
HANDLING SHEETS AND SHEET OBJECTS

2 Right-click somewhere on the sheet (or on a different sheet) and select **Paste Sheet Object as Link**.

Saving, closing and exiting

If you don’t want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 3  LIST BOXES AND STATISTICS BOXES

In the previous lesson you learned to add, copy, move, size and remove list boxes and other sheet objects. You will now learn to modify a list box and its way of displaying data. The sort order and the number format are examples of properties that you will change. At the end of the lesson, you will also learn how to create and use a statistics box.

Opening the document

1  Start QlikView.
2  Open the file you worked with in the previous lesson. It should be called something like MyTutorial.qvw.

If MyTutorial.qvw is among the most recently used files, you can normally open it directly from the start page.

The list box

The list box, which is the most basic object on the screen, contains a list of all the values of a specific field (column) in the database.

All the values contained in the database field are shown in the listbox. If there is not enough space to show all values in the visible part of the list box, scroll bar are displayed on the right in the bottom.

If a value occurs several times in one and the same field, it will only be displayed once in the list box.

Changing the properties of a list box

Every sheet object has a properties dialog, containing several pages where you can change the object’s settings. You will now make some changes to the list box settings, using the pages in the List Box Properties dialog.

Showing frequency

Suppose you are interested in knowing how many customers you have in different Cities.

Working with QlikView
1 Clear your selections by clicking the **Clear** button in the toolbar.

2 Go to the *Sales* sheet.

3 Click on the list box *City* with the right mouse button and choose **Properties**... from the float menu.

4 On the *General* page of the *List Box Properties* dialog, select the **Show Frequency** check box by clicking in it.

5 Choose **OK**.

Any city in the list box is now followed by its number of occurrences in the data. As the field *City* is part of the customer data, we can interpret this as the number of customers. In Alma-Ata we have two customers, for example.

**Undo Layout Change**

Any layout change in the document can be undone by a single click.

1 Use the **Undo Layout Change** button to undo the change that you made in the previous exercise.

**Changing the number and order of columns**

To display the contents of a list box in several columns, do the following:

1 Clear your selections.

2 Go to the *Sales* tab. Click on the list box *Day* with the right mouse button, then choose **Properties**... from the float menu.

3 Go to the *Presentation* page.

4 Deselect **Single Column**. Select **Cell Borders**. Click **OK**.

5 If necessary, drag the border of the list box *Day* until its contents are displayed in seven columns.

The values are ordered by column, i.e. vertically. You may prefer to have the values of the *Day* list box ordered by row:

6 Click on the list box *Day* with the right mouse button, then choose **Properties**... from the float menu.

7 Go to the *Presentation* page.

8 Deselect **Order by Column**, then click **OK**.
The field values, instead of being ordered by column (vertically), are now ordered by row (horizontally). Your list box now looks like the one to the right. You can change the number of columns by changing the width of the list box. Drag the borders with the mouse pointer.

9 Repeat for the Month list box so that the months are grouped by quarters.

**Changing the sort order**

A number of different sort orders are available for each list box.

Numeric fields are usually sorted by numeric value, whereas fields containing text tend to be sorted in alphabetical order (Text).

In addition, list boxes whose values are not all visible (list boxes with scroll bars) are set to **Sort by State**, which means that the values are sorted according to their logical state (selected, optional, excluded). This way, selected and optional values are always visible in the document.

1 On the Sales sheet, click on the list box Sales with the right mouse button, and choose **Properties**...

2 Go to the **Sort** page.

The list box Sales, as we see, is sorted by **State** and **Numeric value, Ascending**. The order of the sort options in the list corresponds to the priority sort order.

Thus, as long as no selection is made, the values in the list box Sales are sorted by numeric value; as soon as a selection is made, however, the state of the values determines the sort order.

3 Keep the option **Numeric value** selected, but change the order to **Descending** by choosing it from the drop-down box (click the arrow to the right).

4 Click **OK**.

The highest number is now at the top. As soon as a selection is made, however, the selected (green) value(s) or optional (white) values will be placed at the top.
5 Make a selection in the list box and study the result.
6 Clear your selections.

**Changing the number format**

![Figure 9. The dialog page on which the number format is set](image)

Numeric data can be of different types and can be formatted in different ways.

1 Click on the *Sales* list box with the right mouse button, and choose **Properties...**
2 Go to the **Number** page.

The number format of the field *Sales* is disabled because all number formats are inherited from the document’s default settings. Furthermore, the default settings in the document are affected by your computer’s regional settings.

To set the number format for the *Sales* list box in US dollars do the following:

3 Click in the **Override Document Settings** check box in order to create a separate number format for this list box.
4 Select the option **Money**, then click **OK**.
LIST BOXES AND STATISTICS BOXES

Note that the values in the list box Sales are now differently formatted (you may need to size it first): a comma has appeared as thousands separator and the values are preceded by a $. Two decimals have been added.

5  Open the Properties dialog again.

6  Study the Number dialog page. The current format is displayed in the Format box, and below this a preview is given. The format can be changed manually. Erase the two decimals (the zeros) and view the result of the change in the Preview box.

If you cannot erase the zeros, or have different number formats by default, this could be caused by your computer’s regional settings.

7  Click OK to close the dialog.

Aligning the values

Text is usually left-aligned, numbers right-aligned. This setting can be changed on the Presentation page.

1  Click on the list box Year with the right mouse button, then choose Properties... from the float menu.

2  Go to the Presentation page.

3  In the Alignment group, click Left for numbers.

4  Click OK.

The statistics box

The statistics box is a compact way of showing a numeric field in which the separate records are not interesting until their sum or average has been calculated.

A number of different statistical functions can be used in a statistics box. It is also possible to make selections in the statistics box by clicking on some of the functions, e.g. Min, Max etc.

The sheet Geography in your document contains a statistics box based on the field Population (mio).
As long as no selections are made in the document, the values shown in the statistics box are calculated using all the possible values of the corresponding list box. As soon as you click a value, however, the statistics box is updated just like the other sheet objects.

1 Select the items *Albania, Algeria, Andorra* and *Angola* in the list box *Country* and see how the values in the statistics box change.

Statistics boxes can be moved, sized, copied and closed just like list boxes.

**Creating a statistics box**

1 Make sure that no selection is made by clicking the *Clear* button in the toolbar.

2 Click on the list box *Sales* on the *Sales* sheet with the right mouse button, and choose *Create statistics box* from the float menu.

A statistics box with the same name as the active list box now appears on the screen. You might need to size it to see all the numbers properly:

3 Put the cursor inside the right border of the statistics box. When it looks like the picture you can start dragging.

The statistics box shows too many decimals at the moment. To limit the number of decimals shown for each value:

4 Right-click the statistics box to open the *Properties* dialog.

5 Go to the *Number* tab. Under *Functions*, select the field *Average* and mark the check box *Override Default Settings*.

6 Select the radio button *Fixed to* and select *2 decimals*. Click *OK*.

You immediately see that the fictive company has sold products for a total amount of 2,317,233 USD, that 713 sales have been performed, etc.

You can also create statistics boxes by choosing *New Sheet Object, Statistics Box* from the *New Sheet Object* menu or clicking the *Create Statistics Box* button in the toolbar.

In that case, the *New Statistics box* dialog of the statistics box is opened. This dialog looks similar to that of the list box, but it only contains four pages. On the *General* page, you select the statistical functions you wish to use.

**Making selections in a statistics box**

You can make selections in a statistics box by clicking on the non calculated functions, e.g. *Min* or *Max*. 
LIST BOXES AND STATISTICS BOXES

1 Click the function Max to find the customer who made the biggest purchase.
   The selection is made in the list box to which the statistical value belongs.

2 Clear all selections by clicking the Clear button in the toolbar.
   The list box and the statistics box are only two of the sheet objects available. In the next three lessons, different kinds of charts and tables - calculated objects allowing you to get an even better overview of your data - will be introduced.

Saving, closing and exiting
If you don’t want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 4  BAR CHARTS AND PIE CHARTS

Due to the variety of chart subtypes, and considering the great number of available settings, the Tutorial provides three lessons on charts. This lesson will start by giving you a general introduction to working with charts; subsequently, you will create a simple bar chart. Once familiar with the basics, you will modify the properties of the chart and finally turn it into a pie chart.

Introduction

Charts and tables are sheet objects that can show numbers very compactly. You can e.g. show sums of money distributed over different fields such as year, month, account number, etc. Numbers that are calculated using several records in the input tables (sums, averages, min, max) can only be shown in charts or statistics boxes.

Charts, pivot tables and straight tables are logically the same thing, even though they look different. Hence, we will from here on simply refer to them as charts. Charts can thus be shown as bar charts, pie charts, scatter charts, line charts, combo charts (bar/line), radar charts, grid charts, gauge charts, funnel charts, mekko charts, straight tables, pivot tables or block charts. All the chart types are shown below.
Combo chart

Scatter chart

Line chart

Straight table

Pivot table

Radar chart

Grid chart

Gauge chart
BAR CHARTS AND PIE CHARTS

Opening the document
1. Start QlikView.
2. Open the file *MyTutorial.qvw*.

If *MyTutorial.qvw* is among the most recently used files, you can normally open it directly from the start page.

Making selections in a chart
Until now, we have only studied selections in list boxes. It is however also possible to select data in charts. Go back to the bar chart called *Area* on the *Geography* sheet. It shows the world’s ten largest countries.

1. Place the cursor in the chart, then press the mouse button and select a few bars by "painting" the area (dragging the cursor). When this is done, release the mouse button.
2 The countries represented by the bars you painted have been selected. The change is reflected in the list box Country.

It is also possible to make selections by clicking on the country names (labels) in the chart:

3 Select one or several countries by clicking on their labels.

4 Clear your selections.

Changing chart types using a fast type change icon

Some charts in QlikView are prepared for being displayed as more than one type. This is shown as a little icon, either in the chart’s title bar or in the chart itself. The icon is a miniature of the next chart type that will appear if you click on it.

1 Take a look at the bar chart Area in the Geography sheet. In the caption next to the minimize icon you will find a fast type change icon.

2 Click the icon with the left mouse button. The chart will turn into a line chart.

3 This chart has been prepared for changing between three types of charts: bar, line and pie. If you click again the chart will turn into a pie chart.

4 Now click with the right mouse button on the fast type change icon. A drop-down menu will appear with the possible chart types. Click the bar chart icon and we are back where we started.

All charts can be turned into any of the chart types available by going through the chart’s Properties dialog that you reach by right-clicking somewhere in the chart. More about this later.
Creating a bar chart using the Quick Chart Wizard

The toolbars contain two buttons for creating charts. The button called **Quick Chart Wizard**, helps you create some of the most common chart types in a few simple steps. The number of options is limited in the Quick Chart Wizard to start with, but you can add any number of properties once the chart is finished.

The button called **Create Chart**, opens the full chart wizard in which you can set a greater number of properties from the very beginning.

No matter which wizard you choose, you will get a full-blown chart whose settings can be modified at any time. If the toolbars should not be visible, you reach them by selecting **View - Toolbars**.

You will start by creating a simple chart showing the sum of sales per country.

1. Go to the sheet **Sales**, and click the **Quick Chart Wizard** button in the main toolbar. The start page of the **Quick Chart Wizard** opens. Click **Next >**.

2. Step 1 of the **Quick Chart Wizard** contains icons representing different chart types. The icon representing the bar chart is preselected. Click **Next >**.

The next page, **Define dimension(s)**, of the QuickChart wizard opens. Here you define the meaning of each bar in the bar chart. In this case each bar corresponds to a **Country**.

3. Select the field **Country** in the combo box **First Dimension**. Click **Next**.

On the next page, **Define Expression**, you define what value the height of the bars in the bar chart corresponds to. The answer, in this case, is the **Sum of Sales** for each country.

4. Select the option **Sum** to get the sum of sales per country. Select **Sales** from the drop-down box. Click **Next >**.

5. On the fourth page you select a **Chart format** by clicking the icons for **Style**, **Orientation** and **Mode**. Keep the preselected settings and mark the checkbox **Show Numbers** in order to show numbers above each bar.

6. Click **Finish**. The chart now appears on your screen.

Due to different default settings on different computers, its colors may differ from the pictures in this Tutorial. You can go back and make adjustments at any time using the created chart’s properties dialog:

7. Right-click the chart and choose **Properties**...
8 Under the **General** tab, type *Sales 1* in the **Window Title** box and *Sales per Country* in the **Show Title in Chart** box. Make sure that the corresponding check box is marked.

9 Under the **Caption** tab, click **Auto Minimize**. This will be explained in more detail under “Auto Minimize” on page 87.

10 Click **OK**.

The chart’s layout is by no means optimal: among other things, the great number of bars in the chart makes it difficult to get an overview. You will soon be able to change this. However, you can already use the chart to make selections or to view the result of selections:

11 Select *Ann Lindquist* in the list box *Salesman*.

The chart immediately displays the countries to which Ann Lindquist has sold products, as well as the amounts of money involved.

![Figure 10. The countries to which Ann Lindquist has sold products.](image-url)
Creating a bar chart using the full chart wizard

1. While on the sheet Sales, click the Create Chart button in the design toolbar. (Select View - Toolbars - Design to show the toolbar). The first page, General, of the chart wizard appears. On this page you can choose the type of chart you would like to work with. The bar chart option is preselected; leave it that way.

2. Type Sales 2 in the box Window Title and Sales per Country in the box under Show Title in Chart. Make sure the corresponding check box is marked.

3. Click Next >.

The second page of the wizard, Dimensions, opens. Here you can set the dimensions to be shown on the x-axis (in this case you want each bar to symbolize a country).
The left list contains all the fields or groups (you will learn more about groups on page 195) available.

4 Select the field Country, then click Add> to move it to the list of displayed fields. (You can also double-click the field to move it.)

5 Click Next >.

The dialogs Expression and Edit Expression open. Use them to set one or more expressions to be displayed on the y-axis (in this case you want the height of each bar to show the sum of sales for that country). You can enter an expression directly into the edit box below Expression OK, but it is also possible to use the predefined functions in the fields Aggregation and Field.

6 Click the arrow belonging to the Aggregation drop-down list and select Sum. Then click the arrow belonging to the Field drop-down list (containing the field names) and select Sales.

7 Click Paste. The expression appears in the edit box in the upper part of the dialog. Alternatively, you can also write the expression directly into the edit box.

8 Click OK. The dialog closes. The expression you just defined appears in the Definition field (the left part) of the Expressions dialog. You have now selected one dimension and one expression, i.e. performed the basic steps of the creation of a chart.
Type Sales into the Label box of the Expressions dialog. This changes the name of the expression.

Select Ann Lindquist in the Salesman box if she is not already selected. Compare this chart to the chart (Sales 1) that you created in the previous section. You will notice that there are no numbers displayed on top of the bars. The bars are also sorted differently. This is due to different property settings. Below you will learn how to modify the properties to change the appearance of your chart.

Click Next > several times until you reach the Caption page.

Mark the check box Auto Minimize.

Click Finish to close the wizard. This closes the wizard immediately.

Figure 13. The Expressions dialog

-working with QlikView
Removing a chart

You only need one of the charts you created.

1. Right-click on the chart Sales 1, then choose Remove from the float menu.
2. Confirm that you want to remove the chart.

Changing a few properties

The chart wizard that helped you create the chart contains several pages, of which you only used three. No need to worry: all the pages of the chart wizard are also found in the Properties dialog of the chart, which can be opened at any time by right-clicking somewhere in the chart.

The pages of the Properties dialog differ a little depending on the chart type that you have chosen. However, they look the same no matter if you have used the QuickChart or the full chart wizard to create your chart. You will now use a few of the settings found on the remaining pages.

Changing the sort order

The chart is currently sorted in alphabetical order. You may prefer to put the main customer country furthest to the left:

1. Click on the chart with the right mouse button, then choose Properties... from the float menu.
2. Go to the Sort page.
3. Select the option Y-value to sort the countries according to their sums of sales.
4. Select Descending to put the highest bars to the left.
5. Click OK.
6. Clear your selections by clicking the Clear button in the toolbar.

Limiting the number of bars

In order to improve the overview of the chart, you can limit the maximum number of bars to be displayed:

1. Click in the chart with the right mouse button, then choose Properties... from the float menu
2. Go to the Dimension Limits dialog page by clicking its tab.
3 Mark the check box **Restrict which values are displayed using the first expression** and select the radio button **Show only**. Select **Largest** from the drop-down list and enter the number 10.

4 Click **Apply**, then **OK**.

Clear your selections. Only 10 bars are shown in the chart, which improves the overview.

**Displaying numbers on the bars**

The next thing we want to do is to display numbers on top of the bars in our chart.

1 Open the **Expressions** page in the **Chart properties** dialog.
2 Select **Values on Data Points**.
3 Click **OK**.

You have now added the y-value numbers (in this case sales figures) on top of the bars.

**Changing the number format**

Displaying the numbers on top of the bars is very useful, but when a large range of values is shown, there is not enough room for all the numbers. You can solve the problem by changing the number format:

1 Open the **Number** page in the **Chart Properties...** dialog.
2 Highlight the expression **Sales**.
3 **Expression default** is the preselected number format. This means, the values have the number format of the underlying field **Sales**. Change the number format to **Number**.
4 Enter $ in the box **Symbol**.
5 Click **OK**.
6 Resize the chart in order to have all numbers displayed properly.
The numbers on top of the bars now have a thousand separator.

![Chart Image]

**Figure 14.** The bar chart now shows the sum of sales for different countries sorted by y-value (sum of sales).

### Cloning and detaching your chart

You can clone (copy) a chart in the same way as a list box (by CTRL-dragging), but there is also another way of doing it:

1. Click on the chart with the right mouse button to open the float menu.
2. Click **Clone**.

A second chart, identical with the first one, appears on the screen.

3. Move the chart so that all sheet objects are visible again.
4. Click on the new chart with the right mouse button to open the float menu.
5. Choose **Detach**.

A detached chart is not updated when selections are made. This can be useful when you want to keep the overview while making selections.

6. Make a few selections. See how the original chart is updated, whereas the detached chart stays the same.
7. Attach the chart again by choosing **Attach** from the float menu.
8. Clear your selections by clicking the **Clear** button in the toolbar.
BAR CHARTS AND PIE CHARTS

Turning the bar chart into a pie chart

There are several different chart types to choose between, each one with properties that suit certain purposes. You will now turn the second bar chart into a pie chart.

1. Click one of the *Sales 2* charts with the right mouse button, then choose **Properties...** from the float menu.
2. On the **General** page, select the option **Pie chart**.
3. On the **General** page change the Window Title to *Sales* and the chart title to *Most important countries*.

Go to the **Presentation** page.

5. Mark the check box **Show Numbers in Legend** (corresponds to **Numbers on Data Points** for bar charts).
6. On the **Style** page pick a style of your choice for the pie chart.

*Figure 15. Window title and chart title*
Click **OK**. The result is a pie chart where each slice represents the sales in a particular country.

![Pie chart showing sales in different countries](image)

**Figure 16. The resulting pie chart**

**Changing the color settings**

Go to the previously created bar chart (*Sales 2*). Note that all the bars have the same color. This can be changed on the **Colors** page:

1. Click on the bar chart with the right mouse button, then choose **Properties...** from the float menu.
2. Go to the **Colors** page.
3. Select the check box **Multicolored**.
4. Choose **OK**.

Compare the colors used in the bar chart with those of the pie chart. You see that the same colors are used for the same countries. This default setting is very useful in that it enhances the consistency between different charts and sheets.
The colors of the color map can be customized: on the **Colors** page, simply click a color that you would like to change and pick the color of your choice from the map that opens.

Since the pie chart illustrates proportions, one might be more interested in knowing the percentage than the actual sum of sales.

1. Click on the pie chart with the right mouse button, then choose **Properties**.
2. Go to the **Expressions** page.
3. Mark the check box **Relative**.
4. Click **OK**.

The percentage numbers now appear in the legend.

To save space, you can minimize the pie chart:

---

**Figure 17. The dialog where the colors used in the bar chart are set.**

**Showing the percentage**

Since the pie chart illustrates proportions, one might be more interested in knowing the percentage than the actual sum of sales.

1. Click on the pie chart with the right mouse button, then choose **Properties**.
2. Go to the **Expressions** page.
3. Mark the check box **Relative**.
4. Click **OK**.

The percentage numbers now appear in the legend.
5 Click on the pie chart with the right mouse button, then choose **Minimize**.

The chart turns into an icon and is placed where there is space on the screen. You can move the icon freely.

6 Repeat these steps to minimize the bar chart that you created in the previous lesson.

In the next lesson, you will add another dimension to an existing bar chart and create pivot tables and straight tables.

**Saving, closing and exiting**

If you don’t want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 5  PIVOT TABLES AND STRAIGHT TABLES

In this lesson, you will continue creating and using charts. After adding a dimension to an existing bar chart, you will turn it into a pivot table. Subsequently, you will create a straight table containing the same information to compare these two ways of presenting data.

Opening the document

1. Start QlikView.
2. Open the file MyTutorial.qvw.

If MyTutorial.qvw is among the most recently used files, you can normally open it directly from the start page.

Adding a dimension to a bar chart

Until now you have worked with only one dimension and one expression. Charts can be very complex, though. They can show several dimensions and/or expressions simultaneously or sequentially.

You will start by creating a chart with two dimensions and one expression. It will still show the sum of sales per country, but grouped over different years:

1. On the Sales sheet you find the minimized chart Sales per Country. It is very similar to the bar chart Sales 2 that you created in the previous lesson.
2. Restore the chart and right-click it, then choose Properties....
3. On the Dimensions page, move Year to the list of Used Dimensions.
4. On the Style page, set Subtype to Stacked.
5. On the Dimension Limits page, mark the check box Restrict which values are displayed using the first expression and select the radio button Show only. Select Largest from the drop-down list and enter the number 5 for the dimension Country.
Click **OK** to finish the chart.

A bar still represents the sum of sales of a specific country, but it is now divided into different color sections representing different years.

**Turning a bar chart into a multidimensional pivot table**

Displaying data graphically is very illustrative, but you can’t show too much information at the same time without losing clarity. To display calculated data for several dimensions, your choice of chart may be a pivot table:

1. Right-click to open the **Properties** dialog of the bar chart you just added a dimension to (*Sales per Country*).
2. On the **General** page, change the **Window Title** to **Pivot Table**.
3. Select **Pivot table** as chart type.
4. Go to the **Dimensions** page. Double-click the dimension **Salesman** to move it to the list of displayed fields.
5. Go to the **Sort** page and highlight the dimension **Country**. To sort the **Country** column from A to Z, deselect the sort order **Y-value**. Now the values are sorted according **Text**.
6. Click **OK**.

*Figure 18. A bar chart with two dimensions*
PIVOT TABLES AND STRAIGHT TABLES

Expanding and collapsing dimensions

You have now created a pivot table with three dimensions, but you only see the dimension Country at the moment. Pivot tables provide a useful feature: the possibility of expanding and collapsing dimensions on value level. By collapsing the values you are currently not interested in, you considerably enhance the overview of your data.

You have probably noted the small sign in the Country column. It indicates that the next level is hidden (collapsed).

1. Click in the Country column with the right mouse button, then choose Expand all.
2. Right-click in the Year column, then choose Expand all.

Now all levels are fully expanded. The table does not hold any more levels as there are no plus signs in the right-most column Salesman.

In the expanded levels, the values have a minus sign displayed next to them. It indicates that the next level is visible (expanded). By means of the plus and minus signs you can expand and collapse single values in the table. Use them to look exactly at the data you are interested in.

3. Click in the Year column with the right mouse button, then choose Collapse all.
4. Right-click in the Country column, then choose Collapse all.

Now, all the values of the dimensions Year and Salesman are hidden again.

Suppose that you are only interested in the sales performed in Belgium:

5. Click the plus sign of the value Belgium.
6. Click the plus sign of the values 2008 and 2009.

Figure 19. The pivot table showing details for Belgium
You are now showing only those values of the following columns that are related to the value Belgium. Details on salesmen are only visible for 2008 and 2009.

**Dragging dimensions**

The pivot table is a very flexible sheet object that allows you to freely drag and drop the different dimensions and expressions to any position on the vertical or horizontal axis.

In our case, you may prefer to present the dimension Year on the horizontal axis. Do the following:

1. Position the mouse cursor on the field Year.
2. Press the mouse button and drag the field upwards, to the right, to the desired position (below the header row). A blue arrow appears when the cursor is in the right place.
3. Release the mouse button. The dimension Year, as well as the expression values, are now displayed on the horizontal axis.

![Figure 20. Dragging the Year column to the horizontal axis](image)

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Salesman</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afghanistan</td>
<td>2008</td>
<td>-</td>
<td>2,150</td>
</tr>
<tr>
<td>Albania</td>
<td>2009</td>
<td>0,592</td>
<td>-</td>
</tr>
<tr>
<td>Armenia</td>
<td>2008</td>
<td>-</td>
<td>1,850</td>
</tr>
<tr>
<td>Australia</td>
<td>2008</td>
<td>-</td>
<td>2,240</td>
</tr>
<tr>
<td>Austria</td>
<td>2008</td>
<td>5,029</td>
<td>-</td>
</tr>
<tr>
<td>Belgium</td>
<td>2008</td>
<td>1,683</td>
<td>-</td>
</tr>
<tr>
<td>Bangladesh</td>
<td>2008</td>
<td>4,248</td>
<td>-</td>
</tr>
<tr>
<td>Belarus</td>
<td>2008</td>
<td>26,685</td>
<td>-</td>
</tr>
<tr>
<td>Belgium</td>
<td>2008</td>
<td>1,210</td>
<td>-</td>
</tr>
</tbody>
</table>

![Figure 21. The years are displayed on the horizontal axis](image)

80
The fields *Country* and *Salesman* are shown as a regular column. The values in the field *Year* act as headers for the remaining columns. The columns contain the values of the expression (*Sum of Sales*).

4. Drag the dimension *Year* back to form a vertical column and place it to the right of the dimension *Salesman*.

**Adjusting the columns**

The *Country* and *Salesman* columns of the pivot table are not wide enough for certain values.

1. Place the cursor on the line separating the *Country* column from the *Salesman* column.

2. When the cursor looks like the one shown in the figure, press the mouse button and drag.

3. Adjust the *Salesman* column accordingly.

All the columns can be sized this way. To adjust the rightmost column, place the cursor within the border (to the left of the scroll bar) and drag.

You can also adjust the columns using the command *Fit Columns to Data* in the float menu (opens on a right-click).

**Showing partial sums**

At the moment, the table shows the sales for Belgium made by different sales persons during the years. Suppose you wish to know the sum of sales made by all sales persons and for all years together.

1. Choose *Properties...* from the float menu.

2. Go to the *Presentation* page.

3. In the *Dimensions and Expressions* list, select the dimensions *Salesman* and *Year*.

4. Mark the check box *Show Partial Sums*.

5. Click *OK*.

The pivot table now shows partial sums per sales person and on year level.
Creating a straight table

In opposition to the pivot table, the straight table cannot display sub-totals or serve as a cross table. On the other hand, any of the columns of the straight table can be sorted and each of its rows contains one combination of dimension(s)+expression(s).

1. Minimize the pivot table on the Sales sheet to increase the free space.
2. Right-click somewhere on the sheet and select **New Sheet Object**, then choose **Chart**.
3. In the wizard that opens, select **Straight table**.
4. Type **Straight Table** in the box **Window title**.
5. Click **Next >**.
6. On the **Dimensions** page, move **Year**, **Country** and **Salesman** to the **Used Dimensions** box. Use the **Promote** and **Demote** buttons in order to sort the dimensions as shown in the picture.
7. Click **Next >**.
8. The **Edit Expression** dialog opens.
9. Compose the expression **Sum of Sales** by selecting the corresponding items from the lists in the combo boxes (**Aggregation** and **Field**).
10. Click **Paste**.
11. Click **OK**.
12. Type **Sales** in the **Label** box in the **Expressions** dialog.
13. Click **Finish**.

![Figure 22. The resulting straight table](image)

82
You now have a straight table containing the same information as the pivot table. Compare the two tables. Notice that in the straight table, the total sum of sales is shown at the top, that each row in the straight table represents a possible combination of data (in the pivot table, data is grouped by field values), and that no partial sums are given.

**Sorting the table**

The straight table provides excellent possibilities for sorting columns.

Currently, the column *Year* is placed furthest to the left, and the table is sorted according to the sort order specified for this field (*Sort page*). You can see this from the little arrow sort indicator in the column header. You can change the sort order of the table with two simple clicks of the mouse:

1. Right-click on the column *Salesman* to open the float menu.
2. Choose *Sort*.

The order of the columns remains the same, but it is now the sort order defined for the field *Salesman* that determines the order of the values in the table. Note how the sort indicator (arrow) has moved to the *Salesman* column.

The sort priority can also be set on the *Sort* page of the *Properties* dialog.

**Moving a column**

Suppose you want the dimension *Salesman* to the left of the *Country* column. Do the following:

1. Press the mouse button while on the column header *Salesman* and drag the column to the desired position. The selected column is highlighted and the target is marked with an arrow while you are dragging.
Release the mouse button. The dimension *Salesman* is now placed further to the left.

**Visual cues**

You can use visual cues to highlight expression values in the table. Values belonging to different value categories can be given separate colors and/or font styles.

1. Right-click on the straight table and choose Properties... from the float menu.

2. Go to the Visual Cues page. *Sales* is the expression available.

There are four value categories to choose between: upper, normal, lower and text. Suppose you want to highlight all the expression values above 10,000:

3. Type 10000 in the Upper > edit box.

Next to the edit box, you find two color buttons and three check boxes. This is where you set the appearance of the text and/or the background of the values you wish to highlight.

4. Suppose you want to apply a red color to the values belonging to the upper value category. Click the Text button, then choose a red color from the color map. Click OK.

![Figure 23. Dragging the Salesman column](image)
5 In addition, check the **Bold** check box.

6 Click **OK**.

All expression values above 10,000 are now highlighted.

**Selections in table charts**

It is of course possible to make selections in pivot tables and straight tables as well. Clicking those columns (or rows in a pivot table) which contain chart dimensions implies direct selection of the values clicked on.

1 In the straight table, click the value 2008 in the *Year* column. The effect is the same as selecting 2008 in the list box *Year*.

2 Clear your selections.

Clicking a column containing a chart expression implies an indirect selection of those values in the dimension columns (rows) that are used to calculate that expression value.

3 Click the value $11,379 in the column *Sales*. You have now selected the value 2009 in *Year*, the value *Pakistan* in *Country* and *Ann Lindquist* in *Salesman*.

4 Clear your selections.

If you need to make more complex or multiple selections in a table chart there is yet another option, called drop-down select. This feature makes it possible to turn a dimension column into a drop-down list with full selection and search possibilities.

1 Right-click the straight table and select **Properties...** from the float menu.

2 Go to the **Presentation** page.

3 Mark *Year* in the list of **Columns** and check the check box **Drop-down Select**.

4 Repeat for the *Country* and *Salesman* columns.

5 Click **OK**.

You will now find that all three dimension columns have a drop-down icon to the left in the column header.
6 Click the icon for Year and a temporary list with all the years will appear. Hold down the CTRL key and click the years 2006, 2009 and 2010. Then release the CTRL key. The three years are now selected and the drop-down list is closed.

7 Click the drop-down icon in the Country column. When the drop-down list appears, type “sw”. This text search will result in Sweden, Switzerland and Swaziland. Press ENTER. Now you see available information about the countries. Only Sweden and Switzerland are shown in the straight table because there are no sales in the other countries.

8 Clear your selections.

Moving the pivot table and the straight table to a new sheet
The Sales sheet is looking crowded. To improve the overview, you will create a new sheet for the tables.

1 From the Layout menu, choose Add Sheet. The tab Sheet 3 appears to the right of the Sales tab.

2 Right-click somewhere in the new sheet to open the sheet’s Properties dialog.

3 On the General page, enter Tables in the Title box and click OK.

4 Go back to the Sales sheet.

5 Select the pivot table and keep the mouse pointer depressed while dragging it to the Tables tab. Release the mouse button when the cursor turns into a white arrow. See “Copying sheet objects” on page 46.

6 Select the straight table and move it to the Tables tab the same way.

7 Go to the new Tables sheet. The pivot and straight tables are placed in the same position as on the Sales sheet. You may want to move them to a different position on the sheet.

There is now room for further charts on the Sales sheet.
Auto Minimize

In order to improve the overview on the Sales sheet even more, you want to set some of the charts to Auto Minimize, meaning that only one of the Auto Minimized charts will be shown at any one time.

1. On the Sales sheet, right-click the Sales Forecast chart and go to the Caption page of the Properties dialog.
2. Mark the check box Auto Minimize and click OK to close the dialog.
3. Repeat steps 1 and 2 for the bar chart called Drill-down. If a chart is minimized, you can also right-click its icon to reach the Properties dialog.
4. Restore the pie chart by double-clicking its icon. Note that the other charts on the sheet are minimized and shown as icons.
5. Now restore the Drill-down chart. The pie chart is automatically minimized.

You can also make this change for several charts at once:

1. “Paint” a rectangle with the mouse pointer around the charts (or icons of minimized charts) that you want to modify. Their captions or minimized icons turn green.
2. Right-click one of the selected charts or icons to reach the Properties dialog for all the objects. Note that the dialog in this case is limited to the Font, Layout, and Caption pages.
3. Go to the Caption page and select Minimize and Auto Minimize.
4. Click OK.

If it is already selected, this means that one of the charts that you selected already has the Auto Minimize setting. In this case, you must first deselect the Auto Minimize check box and then select it again.

In the next lesson, you will work with line charts, combo charts, scatter charts and bar charts with drill-down functionality. The next lesson also contains information on printing and exporting charts.
**Saving, closing and exiting**

If you don’t want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 6  MORE CHART TYPES

This lesson introduces further chart types. The line chart is useful for showing trends or changes. Working with a combo chart, you can combine the features of the bar chart with those of the line chart. As for scatter charts, they show pairs of values from two expressions. Gauge charts are used for displaying one specific value. You will also encounter drill-down functionality in a hierarchic bar chart created out of a field group. At the end of the lesson, you will print and export a chart.

Opening the document

1  Start QlikView.
2  Open the file MyTutorial.qvw.

If MyTutorial.qvw is among the most recently used files, you can normally open it directly from the start page.

Creating a line chart

Instead of being displayed as bars, data can be presented as lines between value points, as value points only or as both lines and value points. Line charts are useful for showing changes or trends.

You will create a line chart illustrating how the sales per customer have changed over the years.

1  Go to the Sales sheet.
2  Click the Create Chart button in the toolbar.
3  Select Line Chart, and type Customer as Window Title.
4  Click Next >.
5  On the Dimensions page, move the fields Year and Customer to the column of displayed fields. It is important that Year comes before Customer in this example. Use the Promote and Demote buttons to define the order.
6  Click Next > to create an expression in the Edit Expression dialog.
7  In the fields Aggregation and Fields, create the expression Sum(Sales), then click Paste.
8  Click OK. The Edit Expression dialog closes and you are back on the Expression page.
9 Label the expression Sales.
10 Under Display Options, select Smooth in the drop-down box behind Line.
11 Click Finish.

When no values are selected, the chart looks a bit overcrowded; as soon as you make a selection, though, the trends will appear very clearly.

12 Clear previous selections by clicking the Clear button in the toolbar.
13 Select Atlantic Marketing in the list box Customer and study the result.

14 Undo your selection by clicking on the list box Customer with the right mouse button and choosing Clear from the float menu.
15 Select John Doe in the list box Salesman.

One now gets a clear picture of Mr. Doe’s doings. We see that he has had business contacts with Carlsborg since 2005, and that the company Mary Kay has meant a lot to his career so far. We also see that he was not very successful with Captain Cook’s Surfing School.

Suppose you want to know if Captain Cook’s Surfing School is still our customer after all.

16 Select Captain Cook’s Surfing School in the list box Customer.
17 Right-click the field Captain Cook’s Surfing School and choose Clear Other Fields. All other fields (including John Doe) are automatically deselected.
No need to worry: the surfing school is still our customer, even though it purchased less during 2010 and 2011. In the pivot table that we moved to the Tables sheet you can study the exact data.

18 Clear your selections and minimize the chart.

### Adding an expression to a bar chart

Suppose you would like to see how the number of customers is related to the population of a certain country.

1 Go to the Geography sheet where you find a bar chart called Population.

2 Copy the chart to the Sales sheet (see page 46 if you do not remember how this is done).

3 On the Sales sheet, click on the chart with the right mouse button, then choose Properties... from the float menu.

4 On the General page, change the window title to Customers/Population.

5 Select the check box Show Title in Chart, and type Customers/Population in this box too.

6 On the Expressions page, click Add to open the Edit Expression dialog.

7 Compose Count (distinct Customer) by selecting Total Count in the field Aggregation and Customer in the field Field.

8 Select the option Distinct in order to count customer names that occur several times only once. Then click Paste.

9 Click OK to close the Edit Expression dialog.

10 Make sure the expression Count (distinct Customer) is selected in the list to the left, and type Customers (nr) into the Label box.

11 Still in the Expressions dialog, select the expression Population and type Population (mio) in the label box.

12 Click OK.

Study the chart. You have set both population and number of customers as expressions, but only the population is shown. The reason for this is that both expressions are shown on a single axis, and that the magnitude of the numbers of the two expressions differs so much that the number of customers is not visible.

13 Right-click in the chart, select Properties. Go to the Axes page.
Select Customers (nr) in the Expression Axes box, then click Right (Top) under Position.

Click OK.

The chart shows the ten countries with the biggest population and the number of customers in these countries.

Turning the bar chart into a combo chart

You will now turn the bar chart above into a combo chart. In a combo chart, you can combine the features of the bar chart with those of the line chart, e.g. by showing one expression as bars and the second as lines and/or symbols.

1. Open the chart’s Properties dialog.
2. On the General page, select Combo Chart.
3. Go to the Expressions page.

The expressions Population (mio) and Customers (nr) are listed in the Expressions box.

4. Select Population (mio), then mark the Bar check box under Display Options. The boxes named Line and Symbol must not be marked.
5. Now select Customers (nr) in the Expressions box, then mark the check boxes Symbol and Line, leaving the check box Bar deselected. If you like, you can also mark the check box Smooth Line.
6. Click OK.
Instead of displaying both expressions as bars, the chart now shows the number of customers as symbols and lines.

![Figure 26. A combo chart showing how the population and the number of customers in different countries are related to each other.](image)

### Turning the combo chart into a scatter chart

When showing data where each instance has two numbers, like in this case (each country has a number of customers and a population), you might find the scatter chart a useful representation form:

1. Click on the combo chart with the right mouse button, then open the **Properties** dialog.
2. On the **General** page, select **Scatter Chart**.
3. Go to the **Dimension Limits** page and deselect **Restrict which values are displayed using the first expression**.
4. Click **OK**.

The dimension (**Country**) is represented by the symbols, and the expressions (**Population** and **Customers**) are displayed on the axes. You immediately see that some of the countries are placed far out to the right on the x-axis, which means that their populations are far above the average. In two countries we already have more than 10 customers.

5. Select the countries with the most customers by "painting" the area in the chart using the mouse button.

You see that the countries are Japan and USA.
Creating a scatter chart from scratch

You will now create a similar scatter chart, showing population and population growth:

1. Go to the Geography sheet.
2. Click the Create Chart button in the toolbar.
3. On the General page, type Population Growth under Window Title and Show Title in Chart. Select the option Scatter Chart.
4. Choose Next >.
5. On the Dimensions page, move Country to the column of displayed fields.
6. Choose Next >.
7. The Expressions page of the scatter chart differs from that of the other charts. Choose Pop. Growth in the X combo box, and Population (mio) in the Y combo box.
8. Click Finish.

Your new scatter chart is finished. Move it, size it, and try it by making selections.
10. Clear your selections and minimize the chart.

Figure 27. A scatter chart showing how population and number of customers are related to each other.
Creating a gauge chart

Quite often you want to view the changing value of a single measurement as you change your selections. For this purpose the gauge chart is ideal. QlikView offers a wide range of gauge charts for graphic visualization of values. In this section we will create a simple circular gauge chart indicating average gross margin for whatever set of customers and/or periods etc. that we have selected.

1. Go to the Sales sheet.
2. Click the Create Chart button in the toolbar.
3. Select Gauge Chart, and type in Gross margin as Chart Title and Window Title.
4. Click Next >.
5. On the Dimensions page, we do nothing at all, as gauge charts are calculated without any dimensions resulting in one single value over the entire data set.
6. Click Next > to create an expression in the Edit Expression dialog.
7. Create the expression avg([Gross Margin]) by selecting Average in the field Aggregation and Gross Margin in the field Field, then click Paste.
8. Click OK. Label the expression Gross Margin, then click Next > and Next >.
9. On the Style page, make sure that a circular gauge icon under Look is selected.
10. Click Next >.
11. On the Presentation page, enter the value 3000 under Max in the Gauge settings group. Change the color of segment 1 (left) to red and segment 2 (right) to green by clicking the colored buttons.
12. Still on the Presentation page, make sure that the checkbox Show Scale is selected and select 7 Major Units, Show Labels on Every 1 Major Unit and 2 Minor Units per Major Unit. Click Next > several times until you reach the Caption page.
13. On the Caption page, mark the check box Auto Minimize.
14. Click Finish. A semi-circular gauge with two segments, one green and one red, appears.
Let’s do a bit of analysis!

15  Click the **Clear** button in the toolbar. The gauge now shows the average gross margin for all customers.

16  Select *Atlantic Marketing* in the *Customer* list box. This is a good customer!

17  Select *Barley Foods* instead. Room for improvement!

**Working with drill-down functionality**

A dimension used in a chart is usually equivalent to a single field, e.g. *Year*. However, you will sometimes encounter charts created out of field *groups*. These charts can be of two types, drill-down or cyclic. In a drill-down chart, the field group defined usually consists of fields forming a natural hierarchy, e.g. *Year, Quarter, Month*.

The *Sales* sheet in your document contains a minimized chart with drill-down functionality.

1  Clear all selections.

2  Go to the *Sales* sheet.

3  Restore the minimized chart called *Drill-Down* by double-clicking it.

The chart, showing the sum of sales per year, looks like any other bar chart. However, as soon as you make a selection causing the field *Year* to have only one possible value, you discover its drill-down character:

4  Select the bar 2008 in the chart.
An ordinary chart would now display one bar, representing the sum of sales for 2008. This chart, however, shows the sum of sales for each quarter of the year 2008. This is due to the fact that it holds a drill-down group as dimension. Year is the first field in the group and when selecting a single year, the display changes to the second field being Quarter.

5 Select the bar representing the fourth quarter.

![Figure 29. Drill-down functionality](image)

The chart turns to showing the sales for each month of the selected quarter. Month is the third, and last, field in the field group.

Note the selections in the Current Selection box on the same sheet. Keeping track of selections is very important when working with drill-down charts.

6 To go back in the hierarchy, click on the drill-down button next to the field name.

As soon as more than one value becomes possible in the fields further up in the hierarchy, the chart is automatically drilled back up.

The creation of field groups will be discussed in Advanced Features (page 195).

You should now be familiar with most of the chart types available in QlikView: bar chart, line chart, combo chart, scatter chart, pie chart, pivot table, straight table and gauge chart as well as drill-down functionality in charts. The last section of this lesson will show you how to copy charts to Clipboard and how to print them.
Copying to Clipboard and printing

All sheet objects can be copied as images to the clipboard. Charts and tables can be printed. It is also possible to export the data contents of charts and tables to the clipboard.

Copying a sheet object to Clipboard

1. Click with the right mouse button on any chart to open the float menu.
2. Choose Copy to Clipboard and select Values. The other options are explained below.
   
   You have a choice between Values (you copy the values from the chart and can paste them into another program), Image (you copy the chart as an image and you can paste it into other programs as an image) or Object (the copy is a clickable sheet object that can be pasted into another QlikView document).
3. To view the result, open a blank document in e.g. Word, and click Paste (in Word).

Printing

1. Go back to QlikView.
2. Click on a chart with the right mouse button, then click Print....
   
   The Print... dialog opens. For detailed information about printing, see the QlikView Reference Manual.
3. Click Print.
   
   It is also possible to choose the Print... command from the File menu or from the toolbar.
   
   In objects that are printed often, you can display a little print icon in the caption of the object. This is done in the sheet object’s Properties dialog on the Caption page under Special Icons.
   
   In the next lesson, the presentation tour goes on with the multi box and the table box.
Saving, closing and exiting

If you don’t want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 7 MULTI BOXES, TABLE BOXES AND INPUT BOXES

This lesson features the multi box, which allows you to show data in a very compact way; the input box, which can be used for interactive input of data; and the table box which presents data in table format.

Opening the document

1. Start QlikView.
2. Open the file MyTutorial.qvw.

If MyTutorial.qvw is among the most recently used files, you can normally open it directly from the start page.

The multi box

The multi box, or multiple drop-down list box, is a sheet object that shows several fields simultaneously in a very compact way.

The multi box makes it possible to show a great number of fields on a single sheet without losing the overview.

How results of selections are shown in multi boxes

The Geography sheet contains a multi box showing country information.

For each field in the multi box, there is a selection indicator telling you if the values of the field are selected, optional or excluded.

A value will be shown in the multi box only if it is the single possible (optional or selected) one.

1. Clear all your selections by clicking the Clear button in the toolbar.
2. Select Aus Dollar in the Currency list box.

Most of the fields still have white selection indicators in the left column, and show nothing in the right column. This means that these fields contain several optional values. Aus Dollar and Not known being the only possible values in their respective fields, they are shown in the multi box.
3. Now select Australia in the Country list box. Values appear in all the fields. The multi box allows you to display a great amount of information in a limited space.

<table>
<thead>
<tr>
<th>Multi box</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capital</td>
<td>Caribbans</td>
</tr>
<tr>
<td>Country</td>
<td>Australia</td>
</tr>
<tr>
<td>Official name</td>
<td>Commonwealth of Australia</td>
</tr>
<tr>
<td>Population</td>
<td>22,57</td>
</tr>
<tr>
<td>Pop. Growth</td>
<td>1.20%</td>
</tr>
<tr>
<td>Currency</td>
<td>Aus Dollar</td>
</tr>
<tr>
<td>Inflation</td>
<td>Not known</td>
</tr>
</tbody>
</table>

Creating a multi box

1. Go to the Customers sheet.
2. Clear your selections.
3. Click the Create Multi box button in the toolbar or choose New Sheet Object, Multi box from the Layout menu. The General page of the Multi Box Properties dialog box now appears. Here you can choose the fields to display in the multi box.
4. Type Customer info in the Title box.
5. Select Customer in the column listing available fields, then click Add>.

The field Customer is moved to the column of displayed fields, which means that it will appear in the multi box. Select a few more fields:
6. Select Address by clicking the field in the list.
7. Press CTRL while clicking the fields City, Country, and Zip..
8. Click Add>.
9. Click OK.

The multi box appears on your sheet.

Making selections in the multi box

You make selections in a multi box in the following way:
1. Clear your selections.
2. Open the field Customer by clicking the arrow.

There are optional values in all the boxes.
4. Open the field Country by clicking the arrow.
5 Belgium and France are optional. The French address is the one you need: click France.

The requested information appears in the remaining fields of the multi box.

The properties of the multi box can be changed just like those of other sheet objects.

6 Right-click on the caption of the multi box. Have a look at the float menu before you open the dialog Multi Box Properties.

The Properties dialog of the multi box contains seven pages that look similar to those of the list box. Here you make changes that affect the entire multi box.

7 Close the dialog Multi Box Properties and go back to the multi box. Right-click on the field Customer.

Look closely at the float menu that opens. You will see that the commands in the second group (as shown in the picture) apply to the field you have clicked on, whereas the other groups of options are the same as for the entire multi box. These operate on all its fields.

Promoting a field

Maybe you would prefer to let the field Zip precede Country.

1 Click in the white area in the field Zip and keep the mouse button depressed while dragging upwards. A blue arrow appears.

2 Let go of the mouse button when the arrow is above the field Country.

3 Clear your selections.

You can also change the order of the field using the Promote and Demote buttons on the General page of the Multi Box Properties dialog.
The table box

The table box is a sheet object that shows several fields simultaneously. The contents are record-oriented in the same way as a normal table, i.e. the contents of one row are logically connected.

The columns of the table box can be loaded from different input tables, which allows the user to create a new table from the logically possible combinations of the input tables.

At the first glance, the table box may look similar to the straight table: both are record-oriented, i.e. each row contains a possible combination of data. However, there are fundamental differences between the two sheet objects, the most important one being that table boxes cannot show calculated values.

Making selections in a table box

The sheet Geography contains a table box called Table Box.

Just like the other sheet objects, the table box immediately reflects selections made in other sheet objects.

1. Select a few countries in the list box Country and study the result.

You can make selections in a table box by clicking any of the available field values or by "painting" an area:

2. Select a range of values in the table box. See how the contents change.

3. Clear your selections.

Creating a table box

1. Go to the sheet Customer.

The sheet contains a multi box with the fields Customer, Address, City, Zip, and Country. You will now create a table box with the same fields:

2. Click the Create Table Box button in the toolbar.

3. The General page of the Table Box Properties dialog is now open. Enter the text Customer info in the Title box.
MULTI BOXES, TABLE BOXES AND INPUT BOXES

4 Double-click the fields mentioned above to move them to the column of displayed fields. Use the Promote and Demote buttons if you need to change the order of the fields, then click OK.

A table box containing the selected fields now appears on your screen. Size it until you see all the columns, and move it to an appropriate position.

As you see, the field values found in one and the same row are logically connected just like in a straight table.

<table>
<thead>
<tr>
<th>Customer info</th>
<th>Address</th>
<th>City</th>
<th>Country</th>
<th>Zip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adder Inc.</td>
<td>9, rue de la Poste</td>
<td>Montreal</td>
<td>Canada</td>
<td></td>
</tr>
<tr>
<td>Al Albar News Services</td>
<td>Kabul</td>
<td>Afghanistan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>All Depeche</td>
<td>Rue de Galle 10</td>
<td>Paris</td>
<td>France</td>
<td>75064</td>
</tr>
<tr>
<td>Asian Pizza</td>
<td>Chittagong</td>
<td>Bangladesh</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asian Pizza</td>
<td>Khartoum</td>
<td>Sudan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asian Pizza</td>
<td>Thimpu</td>
<td>Bhutan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asian Pizza</td>
<td>55, Han Kow St.</td>
<td>Taipei</td>
<td>Taiwan</td>
<td></td>
</tr>
<tr>
<td>Atlantic Marketing</td>
<td>174, rue Drouckamp</td>
<td>Liège</td>
<td>Belgium</td>
<td></td>
</tr>
<tr>
<td>Atlantic Marketing</td>
<td>Bahnhof Strasse 8</td>
<td>Berlin</td>
<td>Germany</td>
<td>74933</td>
</tr>
<tr>
<td>Atlantic Marketing</td>
<td>Weesuperweg 8</td>
<td>Amstel</td>
<td>Netherlands</td>
<td></td>
</tr>
</tbody>
</table>

Figure 30. A table box containing the same information as the multi box created in the previous lesson.

Adjusting columns

The columns of the table box can be adjusted just like those of the other tables:

1. Place the cursor on one of the vertical lines, then drag.

To adjust the rightmost column, place the cursor as far to the right as you can, but within the border and the scroll bar.

To adjust all the columns, you could do the following:

1. Click on one of the columns with the right mouse button.

2. Choose Fit Columns to Data or Equal Column Width from the float menu.

Note The float menu (and the Object menu, which is equivalent to the float menu of the currently active object) of the table box has different appearances depending on whether you right-click on the title bar or on a field. Field-specific commands such as Select

Working with QlikView 105
Possible, Sort etc. are either non-existent or dimmed when you right-click on the title bar of the table box.

Sorting the table box

Just like the straight table, the table box provides excellent possibilities for sorting.

1 Right-click on the column header of the column Country, then choose Sort from the float menu.

Customer is still the first column of the table box, but the values are now sorted according to the sort order of the field Country. Note how the sort indicator in the table header has changed position.

Since this sheet mainly contains customer information, it makes more sense to have the table sorted by customer, though.

2 Double-click the header of the column Customer.

The table is now again sorted according to the sort order of the field Customer.

The sort orders of the different fields can be set on the Sort page of the Table Box Properties dialog. Here you can also change the sort priority of the columns by means of the Promote and Demote buttons.

Printing a table box

Suppose you want to print a list of all the French customers.

1 Clear all previous selections by clicking Clear in the toolbar.

2 In the Country list box of the Customers sheet, select France. The table box now shows all the customers that have offices in France.

3 Click on the table box with the right mouse button, then choose Print....

The Print dialog opens.

4 Click Print Preview to have a look at the list over French customers. For more information about printing, see the QlikView Reference Manual.

It is also possible to choose the Print... command from the Object menu, from the File menu or from the toolbar.

5 Close the Print dialog.
Exporting values from a table box

Instead of printing the table box, you can export its contents to a file:

1. Click on the table box with the right mouse button, then choose Export... from the float menu.

In the dialog that opens, .qvo is preselected as type of file. This is a QlikView-specific type, which can be freely associated with any program, for example Excel.

2. Type Customers in France.qvo or something similar in the File name box.

3. Click Save.

4. You can now open the Explorer and double-click the .qvo file to open it with e.g. Excel.

5. Close Excel and go back to QlikView.

Using an input box

Sometimes there is a need to enter data interactively into the QlikView document. It is normally not possible to change data in the fields (list boxes etc.) interactively. However, QlikView has something called variables, which can be changed at any time. The typical way of entering data in a variable is through the Input Box.

Entering data in an input box

In this chapter we will use an input box to enter a forecasted sales increase and see the result in a chart.

1. Clear all selections.

2. Go to the Geography sheet. There you will find an input box and a text object.

3. Select the input box and the explanatory text object next to it. Move both objects to the Sales sheet tab. If you have forgotten how to do this, see “Selecting and moving several sheet objects simultaneously” on page 45.

4. Go to the Sales sheet. The input box and the text object are now found on this sheet.

5. Double-click the icon to restore the minimized chart Sales Forecast.
The chart Sales Forecast shows sales per year as well as a red bar for a forecast of next year’s sales to the right. The forecast is calculated using an expression based on the sales in the current year, increased by a percent factor in a variable called Increase%.

This percent factor is the variable shown in the input box. It is currently set to 10 percent. Since we are optimistic about sales, we will now raise the forecast to 20 percent sales increase.

6. Click with the mouse in the area to the right of the “=” in the input box. The figure "10" will be marked. You are now in edit mode for the input box.

7. Type "20" and press ENTER.

The value of the variable has changed and the chart is recalculated. You can see how the Forecast bar grows higher.

8. Minimize the chart.

Figure 31. The sales forecast for the next year
Input box constraints.

In principle variables in input boxes can hold any data. The document designer often sets limits to what is allowed to enter. In the example in front of you a non-numeric value would not make sense, so this input box has a constraint only allowing input of numbers between -50 and 50. See the picture. Now try entering a value outside the constraints to see what happens.

1 Click inside the input box and enter the value "99". Press Enter.

The input box will not accept this value as it falls outside the set constraints. You will remain in edit mode in the input box with the old value marked.

2 Enter 10 and press ENTER and we are back where we started.

In the next lesson, you will get acquainted with buttons, text objects and line/arrow objects.
Saving, closing and exiting

If you don’t want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 8 BUTTONS, TEXT OBJECTS AND LINE/ARROW OBJECTS

In this lesson, you will learn how to create buttons, text objects and line/arrow objects. These objects are not displaying any data. Instead they are used to enhance the layout and usability of the document.

Buttons are used for carrying out commands in an easy way, or for exporting data. Text objects also have several areas of use; among other things, you can improve the appearance of your document by displaying text or pictures in text objects. Lines and arrows can be used for different layout purposes.

Opening the document

1. Start QlikView.
2. Open the file MyTutorial.qvw.

If MyTutorial.qvw is among the most recently used files, you can normally open it directly from the start page.
The text object

Text objects can be used in several different ways, e.g. for displaying explanatory text or pictures or for creating multi-colored sheet areas.

We will use text objects to display text and images for the layout of a welcome page for the document.

2. Right-click somewhere in the new sheet to open the sheet’s Properties dialog.
3. On the General page, enter Welcome in the Title box. Click OK to close the dialog.
4. Click the Create Text Object button in the design toolbar.
5. In the upper part of the New Text Object dialog type QlikView Tutorial in the Text field.
6. Under Background set the Transparency slider to 100 %.
8. Set the font size to 36 and choose a grey font color.

Figure 33. New Welcome sheet with text objects, line/arrow object and button
9  Click **OK** to close the dialog.
10  Size and position the text object (see Figure 33 on page 112).

Let’s create another text object showing the latest reload of the document.

1  Click the **Create Text Object** button in the design toolbar.
2  In the upper part of the New Text Object dialog type the following in the Text field: ‘Last update: ’&reloadtime(). This is an expression for a calculated text. It delivers the text “Last update:” followed by the timestamp of the last reload of the document. The timestamp is calculated by the function `reloadtime()`.
3  Under **Background** set the Transparency slider to 100%.
4  Move on to the Font tab of the New Text Object dialog. Choose an appropriate font.
5  Click **OK** to close the dialog.
6  Size and position the text object (see Figure 33 on page 112).

Now we will create a third text object, showing a picture.

1  Click the **Create Text Object** button in the design toolbar.
2  This time we will leave the Text field in the upper part of the New Text Object dialog empty as this text object should not show any text.
3  Under **Background** select the option Image and click the Change button.
4  Browse to the folder Working with QlikView. Select the file QlikViewWater.gif and click Open.
5  Click **OK** to close the dialog.
6  Size and position the text object (see Figure 33 on page 112).

**The line/arrow object**

Line/arrow objects can be used e.g. for dividing the sheet into different areas or to visualize relations between certain sheet object etc. We will use a horizontal line to enhance the layout of our Welcome sheet (see Figure 33 on page 112).

1  Go to the sheet Welcome.
2  Click the **Create Line/Arrow** button in the design toolbar.

The New Line/Arrow dialog appears.

3  Choose Horizontal orientation.

Working with QlikView
4. Click the **Color** button.
5. Choose a black color.
6. Click **OK** to close the **Color** dialog.
7. Choose a **Line Weight** of 1 and a continuous line as **Line Style**.
8. Choose a line without arrow as **Arrow Style**.
9. Go to the **Layout** page. Choose **Layer - Bottom**.
10. Click **OK**.

A black horizontal line will now appear on the sheet.

11. Enlarge the line/arrow object.
12. Place it right above the text object showing the reload date.

It could be that the line/arrow object overlaps the text objects next to it. In this case you can either make the line/arrow object narrower or you can display the text objects in the normal layer instead of the bottom layer in which they reside by default. To do so, open the properties dialog of the text objects on the **Layout** page and choose **Layer - Normal**.

### The button

Buttons can be used in QlikView to perform commands or actions, e.g. exporting data to files or launching other documents. Buttons can perform different types of actions, e.g. clear selections in a document, launch an external application or create a bookmark. You can read more about this in the *QlikView Reference Manual*.

### Using a shortcut button

All the commands available for a shortcut button can also be performed in other ways in QlikView, but it is often very convenient to use a shortcut button. Shortcut buttons make it possible to perform commands quickly and easily. The **Geography** sheet contains a shortcut button with the text **Clear selections**.

1. Go to the **Geography** sheet.
2. Select one or several countries.
3. Click the shortcut button **Clear selections**.

Your selections have disappeared.
You will now create a button on the Welcome sheet.

1. Go to the sheet Welcome.
2. Click the Create Button icon in the toolbar.
3. On the General page of the New Button Object dialog, type the text Go to QlikView Homepage in the Text box.
4. Aqua is preselected for the button background. Keep it like that.
5. Click the Color button and choose a green color for the button.
6. Go to the Actions page and click the Add button. This opens the Add action dialog.
7. In the External group, choose Open URL.

8. Click OK to close the Add Action dialog.
10. Click OK to close the dialog.
Creating an Export button

You have already learned how to export data from a table box. It is also possible to use a button to export data from specific fields.

1. Go to the Sales sheet.
2. Click the Create Button icon in the toolbar.
3. Type the text Export in the Text box.
4. Aqua is preselected for the button background. Keep it that way.
5. Click the Color button and choose a green color for the button.
6. Go to the Actions page and click the Add button to open the Add Action dialog.
7. From the External group, select Export.
8. Click OK to close the Add Action dialog.
9. Click Setup to open the Export Action Settings dialog.

The Fields column in the Selection group contains a list of all the fields in the document. By double-clicking fields in this column, you add them to the column Export Lines.

10. Add the fields Customer, Country, Salesman, Year, and Sales to the column Export Lines.
11. Select the option Include Labels.
12. Select the option Records.
13. Click OK to close the Export Action Settings dialog, then click OK to close the Button Properties dialog.
14. Select a few values, then click the Export button.
The possible values in the specified fields have been copied to the clipboard. To see the result, open another software, for example Excel, and click **Paste**.

### Exporting data to a file

You can also export the data to a file, like you did in the table box example:

1. Open the **Button Properties** dialog for the **Export** button again, and go to the **Actions** page.
2. Select the **Export** action and click **Setup...** to open the **Export Action Settings** dialog.
3. In the group named **Export to**, select **File** instead of **Clipboard**.
4. The **Export File** dialog automatically opens. Type a file name in the **File name** box, e.g. **Export**.
5. As file type, select **Comma Delimited**.
6. The export file should be placed in the same folder as your **Tutorial.qvw** file.
7. Click **Save** to close the **Export File** dialog.

The path to the file appears on the **Export Action Settings** page. Every time you click the export button, all combinations of the possible values of the specified fields will be copied to this file.

8. Click **OK** to close the **Export Action Settings** dialog, then **OK** again to close the **Button Properties** dialog.
9. Test the functionality of your button.

### Launching an export application

If you want the application to be launched as soon as you click the export button, you can specify this by creating a **Launch** action.

1. Right-click the **Export** button. Select **Properties**.
2. Go to the **Actions** page. Click **Add**.
3. From the **External** group, select **Launch**.
4. Click **OK** to close the **Add Action** dialog. The **Actions** page now contains settings relevant for the **Launch** action.
5. Click the **Browse** button next to the **Application** box and browse to the export file **Export.csv**.
6. Click **Open**.
Click OK to close the Button Properties dialog. Select a few values again, then click the Export button. The file Export.csv, containing your exported data, opens.

Close the export file.

Clear your selections.

If you want your newly created buttons to look like the one on the Geography sheet, you can use the format painter to copy the format from one button to the other (see “Copying layout formats between sheet objects” on page 50).

**Saving, closing and exiting**

If you don’t want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 9  SLIDERS, CURRENT SELECTION OBJECTS AND BOOKMARK OBJECTS

This lesson features three additional types of sheet objects which can be used to make QlikView documents more user friendly. The slider/calendar object offers a graphical way of manipulating selections in a field or data in a variable. The current selections box and bookmark objects makes it possible to move menu functionality to a more visible position in the QlikView layout.

Opening the document

1. Start QlikView.
2. Open the file MyTutorial.qvw.

If MyTutorial.qvw is among the most recently used files, you can normally open it directly from the start page.

The slider/calendar object (in slider mode)

A slider allows you to make selections in fields or variables while showing the selection graphically. Slider objects are very versatile and useful.

In this Tutorial we are only showing one of their possible uses: to connect a slider object to a field. For more information about sliders, and about the calendar mode of a slider/calendar object, see the QlikView Reference Manual.

A slider consists of several parts that can all be formatted and defined.

Figure 35. The components of a slider object

1. Go to the Sales sheet.
2. Clear your selections.

Working with QlikView 119
3 Click the Create Slider button in the toolbar or right-click somewhere on the sheet and choose New Sheet Object, Slider/Calendar Object. The General page of the New Slider/Calendar Object dialog box now appears. Slider objects can be used to control a field or one or two variables. In this example we will use it for controlling selections in the field Month.

4 Choose Month in the Field drop-down box.
5 Choose Multi Value in the Mode group.
6 Choose Discrete in the Value Mode group.
7 Go to the Presentation page. Choose Use Custom Scale. Use the arrows to select the following: 12 Major Units, Labels on Every / Major Unit and 0 Minor Units per Major Unit.
8 On the same page, drag the slider for Scale Background to 0% transparency. On the pages Presentation and Layout you will be able to change the looks of your slider object later on.
9 On the Sort page, select Numeric Value (Ascending).
10 On the Layout page, select Use borders and make them Solid.
11 On the Caption page, mark the Show Caption check box and type Month in the Title Text box. Click OK.

The slider object appears on your sheet. In order to show the ticks, you may need to size the slider object by dragging its border.

12 Select months 7, 8 and 9 in the Months list box. A thumb appears in the slider object.

13 Point at the thumb, click and drag it. Note the pop-up showing the months corresponding to the current position of the thumb.
14 Release the mouse button. The selections in the list box will shift in line with the slider position.
15 Position the cursor on one of the slider thumb’s short ends. Click and drag. The range of selections will narrow or widen accordingly.
16 Release the mouse button and the new selection takes effect.

Figure 36. An example of a slider object

120
SLIDERS, CURRENT SELECTION OBJECTS AND BOOKMARK OBJECTS

17 Clear your selections. The thumb disappears from the slider object.

18 Put the cursor inside the slider area (between the arrows). The thumb will reappear.

Creating a Current Selections box

You learned about Current Selections boxes under “Selections” on page 28. This is how you create a Current Selections box:

1 Go to the Customers sheet.

2 Clear your selections.

3 Click the Create Current Selections Box button in the toolbar or choose New Sheet Object, Current Selections Box... from the Layout menu.

4 The General page of the New Current Selections Box now appears. Check the option Use Column Labels and click OK. The current selections box appears on the sheet.

5 Now select a few values in the fields. Note how your choices are reflected in the current selections box.

Creating a bookmark object

Under the Bookmarks menu, users can create and use personal bookmarks that are stored on their own computers as well as document bookmarks that are stored with the QlikView file (for more information about bookmarks, see the QlikView Reference Manual).

However, it is sometimes more convenient to be able to handle bookmarks directly in the QlikView document. This is why we have the bookmark object.
In a bookmark object you can select existing bookmarks from a drop-down list and, depending on configuration, add new and delete old bookmarks.

Let's create a bookmark object:

1. Go to the Customers sheet.
2. Clear your selections.
3. Click the Create Bookmark Object button in the toolbar or choose New Sheet Object, Bookmark object... from the Layout menu.
4. The General page of the New Bookmark Object dialog box now appears. Type the title Bookmarks in the Title box. You do not need to change any other default settings.
5. Click OK.

The bookmark object now appears on your sheet.

6. Make a few selections in some list boxes and then click the Add Bookmark button in your new bookmark object.
7. Type a name for the new bookmark in the dialog that appears. Then click OK.
8. Clear your selections.
9. Select your bookmark in the drop-down list in the bookmark object.

In the last lesson of this part of the tutorial, you will learn how to change settings on document level, how to set user preferences and how to reload data.

**Saving, closing and exiting**

If you don’t want to go on to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 10 DOCUMENT PROPERTIES, USER PREFERENCES AND RELOAD

In the previous lessons, you have been working with the different sheet objects; among other things, you have changed the appearance and behavior of the objects using their Properties dialogs. In this lesson, which is the final lesson of the part Working with QlikView, you will learn how to change the properties of all the objects in the document at the same time.

Furthermore, some settings that affect not only the current document, but all the work performed in QlikView, will be introduced.

At the end of the lesson, you will learn how to update your document, i.e. how to reload data from the data sources that contain the data shown in your QlikView document. You might say that this chapter is a stepping-stone to the next part of the Tutorial where you learn to create a document by loading data from different data sources.

Opening the document

1. Start QlikView.
2. Open the file MyTutorial.qvw.

If MyTutorial.qvw is among the most recently used files, you can normally open it directly from the start page.

Setting Document Properties

Until now, you have been changing the properties of individual sheet objects. However, you will often find yourself in a situation where you would like to give the same appearance to all the sheet objects of the document or format several fields at the same time. You might want to set background colors for all the sheets in the document. This is when the Document Properties dialog is useful. You can also use this dialog to attribute an opening sound or an opening picture to your document.

Setting an opening sound

On the Opening page, you can further improve your document by choosing a picture and/or a sound to be shown or played, respectively, when the document is opened. We are going to set an opening sound:
Go to Settings - Document Properties. Go to the Opening page.

Check-mark the option Sound, then click Select.

Browse to the file tada.wav. It is located in the same folder as your Tutorial file.

Click Open. Use the Play button to play the sound.

Click OK.

Save the document.

Setting properties

Several of the pages in the Document Properties dialog contain settings similar to those of the List Box Properties dialog. The difference is that when you change the settings in the Document Properties dialog, all the sheet objects containing the selected field are affected. The settings are either applied immediately or only on new sheet objects that are created after the changes were made. This is described in more detail in the QlikView Reference Manual.
Choosing a different selection style

The selections in a QlikView document are by default visualized by a color coding: green for selected values, white for possible values and grey for excluded values. This color scheme can be slightly modified, but the basic colors will always remain. As an alternative, windows checkboxes may be used to show the logical state of a value.

1. Choose **Document Properties** from the **Settings** menu.
2. Go to the **General** page.
3. In the **Selection Appearance** group, try out a different color scheme or a different style.
4. Click **OK** to close the properties dialog and make some selections to check the visualization in different object types.

---

**Figure 39. The General page of the Document properties dialog.**

The selections in a QlikView document are by default visualized by a color coding: green for selected values, white for possible values and grey for excluded values. This color scheme can be slightly modified, but the basic colors will always remain. As an alternative, windows checkboxes may be used to show the logical state of a value.

1. Choose **Document Properties** from the **Settings** menu.
2. Go to the **General** page.
3. In the **Selection Appearance** group, try out a different color scheme or a different style.
4. Click **OK** to close the properties dialog and make some selections to check the visualization in different object types.
126

Sorting all future list boxes containing the field Area

2. Go to the Sort page.

You recognize the sort options from the List Box Properties dialog. The Fields box on the left contains a list of all the fields in the document. Here you can select one or several fields to set their sort order:

3. Select Area(km.sq).

Suppose you want the field sorted by numeric value, descending:

4. Select Numeric Value, then Descending.
5. Click OK.

6. Create a new list box containing the field Area(km.sq) and note its sort order.
7. Delete the new list box.

Figure 40. The Sort page of the Document properties dialog.
Applying the same border settings to all the sheet objects

The **Layout** page of the **Document Properties** dialog is identical with the corresponding page in the **List Box Properties** dialog. However, a setting changed here will affect the entire document. Let us give objects (except buttons, text objects and line/arrow objects) a walled border with slightly rounded corners.

1. Go to **Settings - Document Properties**.
2. Go to the **Layout** page.
3. Make sure that **Use Borders** is selected.
4. Pick a border style and width.
5. Click the **Apply to** button. Leave the settings in the **Caption and Border Properties** dialog as they are and click **OK**.
6. Click **OK** again.

The change is implemented throughout the entire document.

7. Undo this change using the **Undo Layout** button.
8. Save the document.

**Themes**

Another even quicker way of applying changes to an entire document is by creating and applying a QlikView theme. You will learn about themes in “Layout themes” on page 163. For more information about themes and document properties, please refer to the **QlikView Reference Manual**.
User Preferences

The User Preferences dialog, found in the Settings menu, contains a number of settings concerning your way of working with QlikView. Settings changed here remain the same regardless of the document you work with. One example is the language of the QlikView interface that you can change here.

Take a few minutes to browse through the settings in the User Preferences dialog. For more information on the available commands, see the QlikView Reference Manual.

Reloading data

The procedure of loading data into QlikView is beyond the scope of this first part of the Tutorial. However, even if you will not build your own documents, knowing how to reload, i.e. update, the data contained in the document is of great importance. This is done in a very easy way:
1 Click the **Reload** button in the toolbar (or choose **Reload** from the **File** menu).

The text object on the *Welcome* sheet has been updated to show the date of the latest script execution. If the source data has changed, all your sheet objects are instantly updated to reflect the changes (in this case, no new data has been added). QlikView thus offers an extremely easy way of keeping your document up to date.

**Saving, closing and exiting**

1 **Save** and close the file.

**Checking your work**

The folder *Working with QlikView* contains a file called *TutorialFinal*. If you want to, you can open this file to compare it with the one you just saved.

**What’s next?**

You have now come to the end of the first part of the Tutorial, called *Working with QlikView*. If you are going to build your own documents, or if you are just curious to find out how else the data that you worked with can be presented in QlikView, you should continue with the following part *Creating a Document*.

In case your focus is on the layout of QlikView documents, there is one more interesting lesson in this tutorial: “Field groups and cyclic display” on page 195 in part III.

**Classroom training**

More layout options and settings as well as design fundamentals and best practices for building good user interfaces are covered in the classroom training course *QlikView Designer I*.

The classroom course *QlikView Designer II* - for advanced designers - presents charts with advanced display options, more object types, complex calculations in objects and report generation.

**E-learning**

Several e-learning courses are available free of charge on QlikView’s homepage, under **Free Training**.
Creating a Document

- Loading data into QlikView
- Layout themes
- Associating data from several tables
- Concatenating tables
- Linking information
- Loading data via OLE DB
INTRODUCTION

In the previous part of the Tutorial, you learned how to work with an existing document. It already contained data that you displayed in list boxes and other sheet objects.

In this second part, you will learn how to create a QlikView document from scratch. Loading data and associating data tables are two of the main topics to be treated. Like in the previous part, there will be a step-by-step presentation of the procedures.

When you start creating documents of your own, you may want to use the Getting Started Wizard (under User Preferences, General, Show Getting Started Wizard when creating new document). This wizard helps new users load data into QlikView without opening the Edit script dialog. As the exercises in this part of the Tutorial aim to educate users about scripting, you will not use the wizard here.

The source data files used in this part are found in the ..\Tutorial\Creating a Document\Data Sources directory. The sample represents a customer database of a fictive company.
LESSON 11  LOADING DATA INTO QLIKVIEW

A QlikView document is created by retrieving data from one or several sources, e.g. from a relational database or from text files containing data tables. This retrieval is done by writing and executing a script, in which the database, the tables and the fields to be retrieved are specified. The script can be generated automatically with the tools included in QlikView. Note that QlikView in itself is not a traditional database, i.e. you cannot add or alter data in the source database.

Figure 42. Data can be imported from text files, or from databases via the ODBC or OLEDB interface. The imported data, together with the made layout, can be saved as a QlikView document.

In this lesson, you will create a simple document consisting of one data table.
Looking at a delimited text file

The simplest way to store a data table is in a text file. In this type of file each record is represented by a row, and the fields (columns) are separated by a special character, e.g. comma, semicolon or tab, etc. Field names are preferably stored in the first row. The type of file that will be used in the examples is the csv (comma separated value) file, which uses comma as delimiter. Start by looking at a csv file in a text editor:

1. Start a text editor, e.g. Notepad (found in the Windows Accessories group).
2. Open the file Country1.csv from the ..\Tutorial\Creating a Document\Data Sources directory (choose All Files in the Files of Type box).

It should look similar to the file in Figure 43. The contents of the file are logically a table, where each row, or record, describes a country and its properties. The columns are separated by commas, and the first line contains the column (field) names.

3. Close the text editor.

Comma separated value files and text files with other delimiters can often be imported to, and exported from, spreadsheet programs. In such a program (e.g. Excel) the same file looks like the one in Figure 44. If you have a spreadsheet program, it might be easier to work in this than in a text editor when creating the tables.

Figure 43. One representation of a table - a comma separated file viewed in a simple text editor.

Figure 44. The comma separated file viewed in a spreadsheet program.
LOADING DATA INTO QLIKVIEW

Creating a new QlikView document

The first thing to do before loading a file into QlikView is to create an empty document.

1. Start QlikView (see the Basics chapter if you have forgotten).
2. Choose New from the File menu or from the toolbar. The Getting Started Wizard opens, but you will not use it for this exercise. Uncheck Show this wizard when creating new documents at the bottom of the page and close the wizard.
3. Save the QlikView file in the ..\Tutorial\Creating a Document folder. Name it something like MyDocument.qvw.

Loading a text file into QlikView

The next thing to do is to create a script that specifies the files to load:

4. Choose Edit Script from the File menu or from the toolbar.

The Edit Script dialog now opens. It is in this dialog that the script will be created. A number of rows starting with SET have already been generated in the script pane. You will learn about their meaning later (Advanced Features page 214). At the bottom of the dialog you will find a row of tabs containing functions for script generation.
Make sure that the check box **Relative Paths** is checked.

Choose **Table Files** on the **Data** tab. This opens the **Open Local Files** dialog box, in which you can browse for the file you wish to load. Make sure that the control **Files of Type**: is set to **All Table Files**.

Find the file **Country1.csv** (the one you opened in the text editor before), select it and choose **Open**. The file is now opened in the **File Wizard**, which interprets the contents of the file and helps you to load the data into the script in a correct way.

The file wizard interprets the file to be a comma separated (delimited) file using the ANSI(Western European) character set. This is a correct interpretation. The wizard also states that the header size is **none**, which means that the file contains no initial information to be omitted.

You want to use the field names **Country**, **Capital** etc. as labels, or headings, in your file.
In the **Labels** drop-down, select **Embedded Labels**. The field names move to the top row, marked gray. See Figure 46.

Since the program has made a correct interpretation of the file, you can click **Finish**.

A script similar to the one below has been generated in the **Edit Script** dialog:

```sql
DIRECTORY;
LOAD Country,
    Capital,
    [Area(km.sq)],
    [Population(mio)],
    [Pop. Growth],
    Currency,
    Inflation,
    [Official name of Country]
FROM Data Sources\Country1.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);
```

Figure 46. Interpretation of the file Country1.csv in the file wizard
Study the script. Note that the words **SET**, **LOAD** and **FROM** are highlighted. This means that they are keywords, i.e. have a special meaning in the QlikView script.

You can change the colors by choosing **Editor Preferences** from the **Tools** menu (of the **Edit Script** dialog). For further details, see the **QlikView Reference Manual**.

In the **load** statement, the fields of the selected file are listed. Some of the field names are enclosed by square brackets; this is necessary when a field name contains spaces. The word **from** is followed by the path to the file. In the Tutorial we use relative paths, which means the script will show the location (folder) and the file name, *Country1.csv*. See “Relative paths and absolute paths” on page 142.

The final parenthesis contains additional information about the file, specifying, among other things:

- **File type:** txt, biff/xls etcetera
- **Character set:** the character set used ANSI, or Windows 1252
- **Embedded labels:** the first row of the file contains field names (column headings). If there are no embedded labels, placeholders will be used as headings instead.
- **Delimiter:** semicolon, comma or tab are examples of characters separating the field value
- **msq:** stands for modern style quoting.

You recognize these terms from the file wizard.

**Note**  
It is a good habit to always save your changes to the script (still in the **Edit Script** dialog) before you try to reload it. That way you can easily go back and make changes if the reload should not be successful. A useful general setting is to mark the check box **Save before Reload** in the **User Preferences** dialog. This means that all your QlikView documents are automatically saved just before the script is reloaded.

![User Preferences](image)

*Figure 47. The Save Before Reload setting is recommended*
LOADING DATA INTO QLIKVIEW

11 Click **Reload**.

12 The data is now loaded into QlikView, and a dialog box in which it is possible to select the fields to be displayed (Figure 48) is opened.

13 Select the fields **Area (km.sq.), Capital, Currency and Population(mio)** by CTRL-clicking their names, then choose **Add** to include them in the list of displayed fields. Another possibility is to double-click the field names. This will immediately put them in the list of displayed fields.

If the check box **Show System Fields** below the field list is selected, the system fields are shown in the list. Their field names, starting with "$", are system fields. You will learn about the system fields later (page 183).

14 Choose **OK** to close the dialog. All the fields in the column **Fields Displayed in Listboxes** are displayed as list boxes on the active sheet.

If you want to add or remove fields, you can open the **Sheet Properties** dialog again at any time. This is done by clicking on the sheet with the right mouse button and choosing **Properties** from the float menu.
If you have followed all the steps correctly, you should now have a display similar to the one shown in Figure 49 This document is ready to be used, although the layout can be improved.

15 Click on a capital, and you will find information connected to it in the other listboxes, for example the currency used in that country. Note that all the information refers to the countries, since every record in the table that was loaded represents a country. Thus, clicking on Paris does not mean that you get the population of Paris. It is still the population of France that is shown.

Relative paths and absolute paths

In the Tutorial we use relative paths, meaning that QlikView will look for files relative to the directory where the current QlikView document is stored.

To use relative paths, mark the check box Relative Paths in the Edit Script dialog. It is also possible to edit a path directly in the script.

An example of a relative path:

```
..\Creating a Document\Data Sources.
```
LOADING DATA INTO QLIKVIEW

A statement using a relative path is preceded by a directory statement in the QlikView script. Learn more about the directory statement in the QlikView Reference Manual.

An absolute path, on the other hand, gives an exact specification of the location of the file. If you move the file to another location (e.g. to a user directory or to another hard disk), the program will no longer be able to find related files and run the script.

An example of an absolute path:
C:\Documents and Settings\Desktop\Creating a Document\Data Sources

Saving, closing and exiting

You have now created a simple QlikView document, consisting of a single table. In the next lesson, you will add two more tables and learn about QlikView’s powerful capability of associating tables.

If you do not want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
ASSOCIATING DATA FROM MANY TABLES

LESSON 12 ASSOCIATING DATA FROM MANY TABLES

Previously, you created a basic document by loading one table into QlikView. However, what you usually want to do is to load and associate data from a great number of tables. In this lesson you will be familiarized with QlikView’s way of automatically associating related tables. You will also learn how to rename fields in order to assure or prevent associations.

Associations

If you have two tables listing different things, e.g. if you have one list of customers and one list of invoices, and the two tables have a field (column) in common, e.g. the customer number, this usually means that there is a relationship between the two tables.

If such a relationship exists, associations are made between the fields that are common to the tables: QlikView assumes that the two fields are one and the same thing, and the two fields are treated as one. Such a field connecting two or more tables is called a key.

There are two basic rules for associations:

• For two fields to be associated, they need to have the exact same name (case sensitive). Thus, Name and name are not the same and will not be associated.

• If a certain field has the exact same value in several different input tables, QlikView will treat it as one value and also assume that the records (rows) containing the value should be associated. For two field values to be associated, they either need to
  – have exactly the same spelling (case sensitive), or
  – have exactly the same numeric value

Thus: Name and name are not the same and are not associated. The numbers 123 and 00123 are the same and are associated.
For a further illustration of the basic rules, study the following example:

Table 1:                   Table 2:                   Table 3:
Name  Number  Number  Age  Name  ID
John   1       3       28   Phil  ab
Phil   2       4       35   john  xy
Betty  5       2       42

*Figure 50.*

The fields named *Number* are assumed to be one and the same according to the first rule. Table 1 and Table 2 are associated via this field. Table 1 and Table 3 are associated in the same way via the field *Name*.

The field *Number* has the value 2 in both Table 1 and Table 2, which means that *Phil* is assumed to be associated with the age 42.

The value 2 in Table 1 is associated with the value *ab* in the field *ID* in Table 3 via the value *Phil* of the field *Name*. *John* in Table 1, however, is not the same as *john* in Table 3, so there will be no association.

*Figure 51.*

An association thus means that links are built between the fields in the tables, so that logical connections can be studied. This way several tables from one or several databases can be included in the QlikView logic simultaneously.

**Opening the document**

If you closed the document and exited QlikView after the previous lesson, you need to open it again.

1. Start QlikView.
ASSOCIATING DATA FROM MANY TABLES

2 Open the file created in the previous lesson (MyDocument.qvw or similar).

Loading and associating a second table

Your document contains a table with country-specific information. In this lesson, you will load an additional table representing a list of customers. The country table and the customer table will be associated through the common field Country. The customers being registered in different countries, the relation between country properties and customer can be studied as a result of the association.

The new table is found in an Excel file, but you can load it in the same easy way as a text file.

1 Choose Edit Script from the File menu or from the toolbar.
2 Place the cursor at the end of the script.
3 Click Table files.
4 Select Customer.xls from the ..Tutorial\Creating a Document\Data Sources directory and choose Open. This opens the file wizard (see page 139).
5 Note that Excel (xls) is set as file type this time, and that the Tables box contains the name of the worksheet. This Excel document contains only one worksheet; if there had been several sheets or named tables, the Tables box would have made it possible to choose from which one of them data should be retrieved.
6 In the Labels drop-down select Embedded Labels.
7 Click Finish. Your script will now look similar to the one below:

```plaintext
Directory;
LOAD Country,
    Capital,
    [Area(km.sq)],
    [Population(mio)],
    [Pop. Growth],
    Currency,
    Inflation,
    [Official name of Country]
FROM Data Sources\Country1.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

Directory;
LOAD [Customer ID],
    Customer,
    Address,
```

Creating a document 147
Study the script. You see that both Country1.csv and Customer.xls contain a field named Country. According to the association rules described above, QlikView will associate the two tables via this field.

8. Choose Reload.

9. The dialog in which you choose the fields to display now appears. The fields from the file Customer.xls have been added to the column of available fields. The field Country has been associated with the previously loaded fields with the same fieldname. Country is now a so called key field, which is symbolized by the small key icon in front of it.

10. Add the fields Customer and Country to the column of displayed fields.

11. Choose OK.

12. Save your document.

It is now possible to click on a capital and find the customers that reside in the country of this capital; at the same time, they are found in the customer register. This is possible although the fields Customer and Capital are found in different tables. The only prerequisite is that there is a field, Country, common to both tables.

13. Click Astana, the capital of Kazakhstan, and note that the fictive company has two customers in Kazakhstan.


You have now built a simple QlikView document containing data from two tables. Several tables can be linked (associated) this way, which makes it possible to study complex relationships in data from many tables.

**Renaming fields**

In the previous section, you learned that associations between tables are made via key fields that are common to the tables. As we have seen, the criterion for two fields to be associated (to be treated as one and the same field) is that they have the same name.

It thus becomes clear that field names are of great importance, and that the renaming of fields is a common procedure when building the QlikView data structure: in real life, fields that should be associated do not always have exactly the same name in dif-
ASSOCIATING DATA FROM MANY TABLES

Different tables. Furthermore, fields that you do not want to associate might have the same name. Renaming fields in order to stop or create associations is an important part of creating a QlikView document.

The directory contains additional files (tables) that are relevant to your document. Suppose you want to associate the file Transact.csv, a file containing information about transactions, sales, etc. concerning the customers in the document:

1. Choose **Edit Script** from the **File** menu or from the toolbar.
2. Place the cursor at the end of the script.
3. Choose **Table Files**.
4. Select Transact.csv and choose **Open**. This opens the **File Wizard**.
5. Make sure that **Delimited** is set as type, **Comma** as delimiter and that **Embedded Labels** is selected.

In the file Customer.xls that we loaded before, there was a field named Customer ID. Note that the new file contains a field named ID Customer. These two fields should be associated, i.e. treated as one. To make this happen, however, you need to rename one of the fields. The file wizard provides excellent possibilities for renaming fields.

6. Click in the table header of ID Customer, then type the new name, **Customer ID**. Make sure not to forget the space between the words: any misspelling prevents QlikView from interpreting the fields as being one and the same.
7. Press ENTER. The name of the field has been changed.
8. Click **Finish**.

The automatically generated script looks similar to the one below:

```
Directory;
LOAD Country,
    Capital,
    [Area(km.sq)],
    [Population(mio)],
    [Pop. Growth],
    Currency,
    Inflation,
    [Official name of Country]
FROM Data Sources\Country1.csv (txt, codepage is 1252,
embedded labels, delimiter is ',', msg);

Directory;
LOAD [Customer ID],
    Customer,
    Address,
    City,
```
Zip,  
Country  
FROM Data Sources\Customer.xls  
(biff, embedded labels, table is [CUSTOMER$]);  
Directory;  
LOAD [Transaction ID],  
Year,  
Month,  
Day,  
[Salesman ID],  
[Product ID],  
[Serial No],  
[ID Customer] as [Customer ID],  
[List Price],  
Sales,  
[Gross Margin]  
FROM Data Sources\Transact.csv (txt, codepage is 1252,  
embedded labels, delimiter is ',', msg);  

Note the line [ID Customer] as [Customer ID]; it has appeared as a result of the  
change you made in the file wizard, and means that the field ID Customer will be  
loaded into QlikView with the name Customer ID (thus assuring the necessary asso-  
ciation).  

9 Choose Reload.  
10 The Fields page of the Sheet Properties dialog appears. Add a field from  
the file Transact.csv to the column of displayed fields, e.g. Sales.  
11 Click OK.  
12 Save your document.  

Three different tables have been loaded, containing information about coun-  
tries, customers and transactions, respectively. By associating the tables in the way  
described, QlikView allows you to find all the relevant information from all the  
tables at the same time - by means of a single click.  

13 Select Finland in the list box Country. The program immediately provides  
the geographical data stored in the country tables - but also displays the  
names of the customers residing in Finland, as well as the sales values  
related to them.  
14 Clear your selections.  

Note It is easy to associate tables in QlikView, and it is possible to link fields and  
tables that should not be linked. If this is done, QlikView will not give you
ASSOCIATING DATA FROM MANY TABLES

relevant answers. Think carefully before assigning field names to fields of different tables, thereby defining the associations.

You should now have acquired some basic knowledge about loading and associating tables. In the following lesson, you will learn how to merge tables containing the same type of information.

Saving, closing and exiting

If you do not want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 13 CONCATENATING TABLES

In the previous lessons, you learned to load data into QlikView and to associate different tables that have fields in common. However, instead of being associated, tables can also be merged. If two input tables are lists of the same things, but contain different values, e.g. if one is a list of countries in Europe and the other one a list of countries in North and South America, the second table can be seen as a continuation of the first. The tables should then be concatenated.

Opening the document

If you closed the document and exited QlikView after the previous lesson, you need to open it again.

1 Start QlikView
2 Open your file MyDocument.qvw.

Automatic concatenation

If two tables that have exactly the same set of fields are loaded, QlikView automatically treats the second table as a continuation of the first. This is called concatenation of tables.

Any number of tables can be concatenated into one table.

Your QlikView document retrieved data from a file with a limited number of countries. The ..Tutorial\Creating a Document\Data Sources directory contains a second file listing countries, whose field names correspond exactly to those of the already loaded Country1.csv. When you load the second file, the two tables will be automatically concatenated.

1 Choose Edit Script from the File menu or from the toolbar.
Position the cursor after the `LOAD` statement loading the file `Country1.csv` (all statements end with a semicolon) and press ENTER to get an empty row. The order of the `LOAD` statements is arbitrary, but you get a better overview of your script by keeping the country files together.

3. Click **Table Files**.

4. Select `Country2.csv`, then choose **Open**. This opens the **File Wizard** (see Figure 46 on page 139).

5. Make sure that **Delimited** is set as file type, **Comma** as delimiter and that **Embedded Labels** is selected.

6. You do not need to rename any fields this time, so click **Finish**. You should now have a script similar to the following:

   ```plaintext
   Directory;
   LOAD Country,
   Capital,
   [Area(km.sq)],
   [Population(mio)],
   [Pop. Growth],
   Currency,
   Inflation,
   [Official name of Country]
   FROM Data Sources\Country1.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msg);
   Directory;
   LOAD [Customer ID],
   ```
Creating a document

**Concatenating tables**

```
Customer,
Address,
City,
Zip,
Country
FROM Data Sources\CUSTOMER.xls
(biff, embedded labels, table is [CUSTOMER$]);

Directory;
LOAD [Transaction ID],
Year,
Month,
Day,
[Salesman ID],
[Product ID],
[Serial No],
[ID Customer] as [Customer ID],
[List Price],
Sales,
[Gross Margin]
FROM Data Sources\Transact.csv (txt, codepage is 1252,
embedded labels, delimiter is ',', msg);
```

Note that the sets of fields in `Country1.csv` and `Country2.csv` are exactly the same.

7 Choose **Reload**. The **Fields** page in the **Sheet Properties** dialog (Figure 48 on page 141) is opened. The fields you selected last time are already in the column of displayed fields. No new fields have appeared in the list of available fields. Only the field values of `Country2.csv` have been added to the corresponding fields of `Country1.csv`.

8 Choose **OK** to close the dialog.

At a first glance, your document will look very much like it did before; however, there are more entries in most list boxes. Some list boxes may have become wider or obtained scroll bars due to longer field contents.

9 Save your document.

**Forced concatenation**

Sometimes you want to concatenate tables also when they have different sets of fields. QlikView will then not automatically concatenate the two tables: you need to use the `concatenate` statement, which concatenates a table with the last created logical table.
In the previous section two tables with identical sets of fields, Country1.csv and Country2.csv, were concatenated. There is also a third file, Country3.csv, that contains only a subset of the fields. All three files are lists of countries. Furthermore, they contain different countries, so it is certainly relevant to concatenate the three files into one logical table.

The values of the missing fields in the concatenated table will be NULL, i.e. QlikView will treat these fields as having no value.

Do the following:

1. Choose Edit Script from the File menu or from the toolbar.
2. Position the cursor after the statement loading Country2.csv. This time the order of the statements is not arbitrary, since the concatenate statement forces concatenation with the last created logical table in the script.
3. Choose Table Files.
4. Select Country3.csv and choose Open. This opens the File Wizard (see Figure 46 on page 139).
5. Make sure that the wizard has made a correct interpretation, then click Finish. This generates a script similar to the one below:

```sql
LOAD Country,
   Capital,
   [Area(km.sq)],
   [Population(mio)],
   [Pop. Growth],
   Currency,
   Inflation,
   [Official name of Country]
FROM Data Sources\Country1.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

LOAD Country,
   Capital,
   [Area(km.sq)],
   [Population(mio)],
   [Pop. Growth],
   Currency,
   Inflation,
   [Official name of Country]
FROM Data Sources\Country2.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

LOAD Country,
   [Official name of Country],
CONCATENATING TABLES

[Area(km.sq)] FROM Data Sources\Country3.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

LOAD [Customer ID],
Customer,
Address,
City,
Zip,
Country
FROM Data Sources\Customer.xls (biff, embedded labels, table is [CUSTOMER$]);

LOAD [Transaction ID],
Year,
Month,
Day,
[Salesman ID],
[Product ID],
[Serial No],
[ID Customer] as [Customer ID],
[List Price],
Sales,
[Gross Margin]
FROM Data Sources\Transact.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

Study the script. The three fields in the file Country3.csv are all found in Country1.csv, which constitutes the last created logical table. However, since the set of fields is not exactly the same, you need to add the word concatenate for the tables to be merged:

6 Position the cursor in front of the load statement that loads Country3.csv and type Concatenate. If the spelling is correct, the word concatenate will turn blue just like load and from etc., since it is also a keyword. Make sure there is a space between the two words:

... CONCATENATE LOAD Country,
    [Official name of Country],
    [Area(km.sq)]
FROM Data Sources\Country3.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);
...

7 Click Reload.
8 Click **OK** to close the **Fields** page in the **Sheet Properties** dialog.

Your document has not changed very much. There are, however, a few more countries.

9 Select the country **Seychelles**.

Seychelles is a country that is listed in the third file, and you can now see that only the list box **Area** contains optional data.

10 Clear your selections.

11 To get a clear picture of the contents of the concatenated table, create a table box containing the fields of the country files, i.e. **Country**, **Capital**, **Area (km.sq)**, **Population(mio)**, **Pop.Growth**, **Currency**, **Inflation**, **Official name of Country**.

12 Use the scroll bar to browse through the data of your table box. You will note that some of the rows are not complete, but contain a '-' instead of a value. This is the case for all the countries from the third country file, containing only a subset of the fields: the values of the missing fields are treated as NULL.

You have now created a neat table structure. In the next lesson you will learn how to keep an overview over the tables and fields loaded. Furthermore you will assign table labels in the script in order to have clear and meaningful table names.

**Saving, closing and exiting**

If you do not want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
Lesson 14 The Table Structure

In this lesson you will take a look at the structure of the tables loaded so far. The Table Viewer is a good help to keep track of tables and fields in your document, especially when you are working with bigger and more complex documents. Finally, you will learn how to assign names to the tables while loading them in order to get a table structure with suitable table names.

Using the Table Viewer

The tables and their associations can be shown graphically in the built-in Table Viewer.

1. Choose Table Viewer from the File menu.

The Table Viewer shows the three logical tables have been loaded so far:

- Country1 (concatenation of Country1, Country2 and Country3) is a table listing countries. Each row contains information concerning a specific country.

- CUSTOMERS is a table listing customers. Each row contains information concerning a specific customer. This table is associated to the table above through the field Country, which is found in both tables.

- Transact is a table listing transactions. Each row contains information concerning one sold unit. This table is associated to the table above through the field Customer ID, which is found in both tables.

![Figure 52. The associations made in the example that loads the tables Country1, CUSTOMERS and Transact](image)

Creating a document 159
Associations are shown with lines connecting the associated fields in the respective tables. When a selection is made in one of the tables, QlikView analyzes how the result of the selection affects the next logical table. When this table is analyzed, QlikView continues with the next logical table, etc. The result of the selection propagates through the chain of tables involved.

**Note**  Structures with circular references, i.e. when the chain becomes a ring, should usually be avoided. These are sometimes a sign of an incorrect data model, in which two similar fields that have slightly different interpretations are treated as one and the same field. If QlikView discovers the circular reference during the execution of the script, the tables will be set to loosely coupled. For further information, see the *QlikView Reference Manual*.

The tables in the **Table Viewer** can be positioned by dragging them with the mouse.

1. Click on the header of the table *Country1*. All tables directly associated with this table (only one actually) will be highlighted.
2. Click on the field *Customer ID* in one of the tables where it appears. Notice that the field name will be highlighted in all tables where it appears.
3. Position the mouse pointer over the field *Currency* in the *Country1* table. QlikView shows information for this field in a pop-up. The information density is 97 %, which means that 97 % of the records in the *Country1* table have a value in this field. The records coming from the file *Country3.csv* do not have a value in this field, therefore the density is not 100%. Furthermore it is indicated that *Currency* is a text field.
4. Right-click the header of the *Transact* table and choose **Preview**. Now QlikView displays the first lines of the Transact table. This is a useful feature to get a quick overview over the content of a table in complex data structures with many tables.
5. Close the table preview.

The table view can be copied to the clipboard for inclusion in documentation or printed with the help of toolbar buttons available.

1. Close the **Table Viewer** by clicking **OK**.

The logical structure can also be studied by looking at the system fields. The part *Advanced Features* provides a lesson in which you can further analyze the structure of your document. See page 184.
Labelling tables in the script

When loading data from files, QlikView uses the file names as table names in the document. Unfortunately, in real life the data source files do not always have meaningful, self-explanatory names. In these case you can and should assign adequate table labels to the tables when loading them in the script. This is done by stating the table label followed by a colon right before the `load` statement loading the table.

In our document, the tables are called `Country1`, `CUSTOMERS` and `Transact`. `Country1` holds data from three files and should better be named just `Country`. `CUSTOMERS` is capitalized and holds an unnecessary dollar-sign that comes from the Excel load. `Transact` is very general, a more specific name, like `Sales`, would certainly be better.

1. Choose `Edit Script` from the `File` menu or from the toolbar.
2. Position the cursor after the first `directory` statement and press `RETURN` to enter a new line.
3. Type “`Country:`”. Do not forget the colon behind the table name. Your script looks like this:

   ... Directory;
   Country:
   LOAD Country,
   Capital,
   [Area(km.sq)],
   ...

4. Name the customer table as follows:

   ... Directory;
   Customer:
   LOAD [Customer ID],
   Customer,
   Address,
   ...

5. Name the sales transactions table as follows:

   ... Directory;
   Sales:
   LOAD [Transaction ID],
   Year,
   Year as YearForecast,
   ...

6. Click `Reload`.

Creating a document 161
7 Click OK to close the Fields page in the Sheet Properties dialog.
8 Choose Table Viewer from the File menu.
9 Check that your tables have the names that you assigned to them.
10 Close the Table Viewer.
11 Save the document.

Improving the layout

This part of the Tutorial being devoted to the creation of scripts, we have neglected the layout so far. However, creating a layout that is easy to work with and that provides a good overview of the information is extremely important in order to fully utilize the possibilities of QlikView.

Having data from three different domains at your disposal, you could create a layout with three different sheets, named Geography, Customers and Sales or something similar. Add list boxes and other sheet objects, move them and size them until you have an document that is easy to work with. If there are steps you do not remember, go back to the first part of the Tutorial, Working with QlikView, to get help.

There is no need to care about formatting captions, adjusting fonts or colors, because in the next lesson you will create a layout theme containing these settings and apply it to your document.

Saving, closing and exiting

If you do not want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 15 LAYOUT THEMES

Themes are very useful because you only need to create a layout formatting once, then copy it to any new documents that you create. The basic idea is to “extract” layout settings from an existing QlikView document to a theme file, and then apply the same settings to the new document.

Creating a theme

You will now create a very basic layout theme containing layout settings for the sheet background and listboxes. The file Tutorial.qvw that you used in the first part of the Tutorial contains all the layout settings that you need for your new document: a QlikView Swirl in the background of the sheets, gray captions for inactive objects and green captions for active ones.

1. Open the file Tutorial.qvw. You find it in the folder Working with QlikView. If you used it recently, you can also start it from the start page.
2. Go to Tools - Theme Maker Wizard.
3. Click Next > to go to Step 1 - Select theme file.
4. Make sure that New Theme is selected and click Next >. The Save As dialog opens.
5. Name the theme file MyTheme.qvt and save it in the ..\Tutorial\Creating a Document folder.
6. In Step 2 - Source selection, in the drop-down list Source, select Document. The Object Type Specific check box is preselected. Leave it that way.
7. Click Next >.

8. Mark the checkboxes Color Map, Document Background, Tabrow, Custom Selection Colors, Sheet Object Styles and Tabrow Style. Deselect all other checkboxes.

9. Click Next > to reach the final page.

10. Click Finish to save the theme and close the dialog.

You have now created a very basic theme containing the sheet background, sheet object styles and tabrow settings. Now you want to add green and gray captions for relevant sheet objects to the theme.

11. Still in the Tutorial.qvw document, open the Theme Maker Wizard again. Go to Step 1 - Select theme file and open your theme from the Creating a Document folder where you saved it.

12. Go to Step 2 - Source Selection.
Under **Source**, select a list box with the correct caption color. In this case you pick the list box **Country**. Mark the check boxes **Object Type Specific** and **Caption & Border**. Click **Next >**. The layout settings from the list box are now added to the theme.

Click **Next >** several times until you reach **Step 4 - Insertion of properties in theme**. Here you mark checkboxes to select what objects the caption and border settings should apply to. It is a good idea not to include buttons, text objects and line/arrow objects in the theme - you might want a different layout for those. Select all other object types.

Click **Next >** to reach the last page of the wizard.

Klick **Finish**.

You have now finished creating the theme. Close the file **Tutorial.qvw**.

## Applying a theme

To apply the settings saved in the layout theme to another document, do the following:

1. Open the file **MyDocument.qvw** that you created in the previous section of the Tutorial.
2. Go to **Settings - Document Properties**, then go to the **Layout** page of that dialog.
3. Click **Apply Theme...** and browse to your theme, called **MyTheme.qvt**. Click **Open**. The theme is now applied to your document: the QlikView Swirl appears, and the captions of all list boxes turn dark gray (or green if they are active).

There is also the possibility to apply a layout theme to a single sheet. This is done the same way as described above, but using the **Apply Theme...** button in the **Sheet Properties** dialog **General** page. To apply a theme to a single object, open its properties dialog, go to the **Layout** page and click **Apply Theme...** there.

You can go back and make modifications to your theme at any time. You may also want to add layout properties for other sheet objects, such as buttons. You can apply the theme to your document as often as you like. For more information about themes, please refer to the **QlikView Reference Manual**.

If you like, you can compare your layout with the layout in the file **SampleDocument.qvw** that you find in the **Creating a Document** folder.
Until now, you have only worked with comma separated text files and an Excel file, which you have been able to load directly into QlikView. In the next lesson, you will get to know other types of files, and you will also learn how to load files via OLE DB.

**Saving, closing and exiting**

If you do not want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
LESSON 16 LOADING ADDITIONAL FILES

All the files you have loaded so far have been text files or Excel files containing field names in the first row. In this lesson, you will learn how to load a tab separated text file without field names. Moreover, you will get an introduction to loading files via the ODBC interface.

Opening the document

If you closed the document and exited QlikView after the previous lesson, you need to open it again.

1  Start QlikView.
2  Open your file MyDocument.qvw.

Loading a tab separated file without labels

The ../Tutorial/Creating a Document/Data Sources directory contains a file with information on the markets to which the different countries belong. Just like the files you have loaded so far, Markets.tab is a text file; however, instead of being separated by commas, its field values are tab delimited. Furthermore, the file does not contain any labels (field names). The loading procedure is similar to the one you have encountered in the previous lessons:

1  Go to the Sales sheet.
2  Choose Edit Script from the File menu or from the toolbar.
3  Position the cursor at the end of the script.
4  Click Table Files.
5  Select Markets.tab, under Tutorial/Creating a Document/Data Sources, then choose Open. This opens the File Wizard.

Delimited is still set as type, but this time Tab is selected as the delimiter.

For QlikView to find relations between the new file and those that have already been loaded, you need to give the fields appropriate names. Naming the first field Market seems like a good choice; the second one should be named Country to be associated with the Country fields of the files Country1.csv and Customer.xls. This is done in the following way:

6  Click in the header of the first column where it says @1. Type Market and press ENTER.
Click in the header of the second column where it says @2. Type Country and press ENTER.

Click Finish. Your script now looks similar to the one below:

```
Directory;
LOAD @1 as Market,
@2 as Country
FROM Data Sources\markets.tab (txt, codepage is 1252,
no labels, delimiter is '\t', msq);
```

Study the script. Note the contents of the final parenthesis: the delimiter is not comma (',') but tab ('\t'), and no labels appears instead of the usual embedded labels.

Click Reload to execute the script.

Move the new field Market to the column of displayed fields, then click OK.

If you have followed all the steps correctly, you can now study the sales development for different markets during different years.

**Loading a file via OLE DB**

Until now you have always loaded files directly into QlikView. However, if you want to access general databases or files that are not stored in a format that QlikView can read, you need to use OLE DB or ODBC (Open DataBase Connectivity).

In this example we will only create an OLE DB connection. For information on ODBC, please refer to the QlikView Reference Manual.

Note QlikView works with both 32-bit and 64-bit ODBC drivers. It is however important to use the correct versions of the ODBC drivers. The 32-bit version of QlikView will only work with the 32-bit ODBC drivers. The 64-bit version of QlikView works with 64-bit ODBC drivers by default, but can be set to use 32-bit ODBC drivers. In this case, use the option Force 32 Bit in the Edit Script dialog.

In the ../Tutorial\Creating a Document\Data Sources directory you will find an Access file named Salesman.mdb, which contains the names of the salesmen who performed the sales described in the file Transact.csv. The names of the salesmen are of great importance, so you would like to associate Salesman.mdb to the data in your document.

One possible way of doing this is to export the database table to a character separated text file, i.e. a file that QlikView can read by means of a load statement.
However, it is also possible to load the file via OLE DB, which is what you will do in this example.

1. Open the **Edit Script** dialog.
2. Place the cursor at the end of the script.
3. In the **Database** drop-down select **OLE DB** and click the **Connect** button to establish a connection with the data source.
4. The **Data Link Properties** dialog opens. Make sure that the **OLE DB Provider for ODBC Drivers** is selected, then click **Next >>** to get to the **Connection** page.
5. Since you are working with a generic data source not yet defined, select the option **Use connection string**, then click the **Build** button. The **Select Data Source** dialog opens.
6. Go to the tab **Machine Data Source**.
7. Select **MS Access Database**, then click **OK**.
8. From the **Login** dialog that opens, click the **Database...** button. The **Select Database** dialog opens.
9. Browse for the file **Salesman.mdb** in the **Tutorial\Creating a Document\Data Sources** directory. Once you find the correct location, the salesman file should be the only one available in the left list. Select it, then click **OK** to close the dialog.
10. Click **OK** to close the remaining dialogs.

Your script now contains a **connect** statement, connecting you to the selected data source. The statement looks similar to this:

```
OLEDB CONNECT TO [Provider=MSDASQL.1;Persist Security
Info=False;Extended Properties="DSN=MS Access
Database;DBQ=C:\Program Files\QlikView\Tutorial\Creating a Document\Data Sources\Salesman.mdb;
DefaultDir=C:\Program Files\QlikView\Tutorial\Creating a Document\Data Sources;DriverId=281;FIL=MS
Access;MaxBufferSize=2048;PageTimeout=5;UID=admin;";]
```

The next step is to select the tables (in this case there is only one, but if you access a database you usually have a great number of tables to choose from) and fields to load:
In the **Edit Script** dialog click the **Select...** button.

The **Create Select Statement** dialog is now opened. The **Fields** box lists the available fields, whereas the **Database Tables** box contains the available tables. At the bottom of the dialog, you get a preview of the statement (a standard SQL **select** statement), which will appear in your script as soon as you click **OK**.

By default, a star is selected in the **fields** list. The star is equivalent to all fields. You want to load all fields, but for a better understanding of the script you will select them to make their names appear in the script:

12 Select **Salesman** in the **Database Tables** list to the left.

13 Click on the field **Distributor ID**, then press the **SHIFT** key and hold it down while clicking **Salesman ID**. See Figure 54.

14 Click **OK**. Your script now looks similar to the following:

```sql
SQL SELECT "Distributor ID",
    Salesman,
    "Salesman ID"
FROM 'C:\Program Files\QlikView\Tutorial\Creating a Document\Data Sources\Salesman.mdb'.SALESMAN;
```

---

170
The *Salesman* table is associated with the existing data via the field *Salesman ID*, which it has in common with *Transact.csv*.

15  Click **Reload**.

16  Add the new field *Salesman* to the *Sales* sheet and study the relations by making a few selections.

17  Clear your selections.

Now you know how to load data from different kinds of files and formats. In the next lesson you will learn how to link external information to field values using a special kind of load process.

**Saving, closing and exiting**

If you do not want to turn to the next lesson right away, you can close the document. You should also save the document, since the following lessons are based on the work you have done so far.
**LESSON 17 LINKING EXTERNAL INFORMATION TO A DOCUMENT**

Besides associating and concatenating tables that contain data, it is also possible to link information to field values in the data. The links are defined in information tables which must be loaded in a special way. In this lesson you will link flags to specific values in the *Country* list box.

**Opening the document**

If you closed the document and exited QlikView after the previous lesson, you need to open it again.

1. Start QlikView.
2. Open your file *MyDocument.qvw*.

**Looking at an info table**

Let’s start by looking at the file containing the information that we want to link.

1. Open a text editor, e.g. *Notepad*, and choose **Open** from the **File** menu.
2. In the box **Files of type**, select **All files**.
3. Open the file *FlagsOECD.csv* in the ..\Tutorial\Creating a Document\Data Sources directory.

![Figure 55. Information table defining bmp files that should be linked to countries](image)
It is a two-column table, in which different values of the field Country are associated with different files. Each value must be put on a separate row.

The file associated with a field value will be shown, played, executed, etc. depending on the file type. Some file types, e.g. files of the bmp (images) or wav (sounds) type are handled internally in QlikView. For other file types, the associated program is used to open the document.

**Note** To associate a file type (with no association) with a program, open the Explorer (for Windows NT, Windows 2000 and Windows XP). Select a file of the concerned type in the structure and double-click it. This opens a list of available programs. Pick an appropriate program, preferably Notepad or Excel, then click **OK**. All files with this extension will from now on be opened with the program you selected. (Another possibility is to choose View, Folder Options from the Explorer menu and go to the File Types page.)

---

4 Close the editor.

### Loading the info table

The next step is to load the info table into QlikView.

1 Choose **Edit Script**.
2 Position the cursor at the end of the script and click **Table Files**.
3 Select the file FlagsOECD.csv and click **Open**. This opens the file wizard.
4 Just like for the files already loaded, **Delimited** is set as type, **Comma** as delimiter. **Embedded Labels** is selected as label.
5 Click **Finish**.

The statement generated will load the file FlagsOECD.csv as a regular data file. However, this is not what you want to do: you would like QlikView to use FlagsOECD.csv to link information to specific field values. This is done in the following way:

6 Change the script by manually adding the word **info** before the **load** statement. As the word **info** is a keyword in the script, it will turn blue. The script should look similar to the following:

```plaintext
Directory;
INFO LOAD Country,
Flag
```
FROM Data Sources\FlagsOECD.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msg);

7. Click **Reload**.
8. The **Fields** page is opened. No new fields have been added. Click **OK**.
9. Save your work.

**Viewing the linked information**

To view the information you have linked, do the following:

1. Select **Germany** from the list of countries.
2. A small info symbol appears in the upper right-hand corner of the list box. Click it.

An independent window containing Germany’s flag now appears in the document.

**Note** The relative paths from the QlikView document to the image files must be stated correctly in the info table for this to work.

3. Close the window
4. Select **France** from the list of countries.
5. Click the info symbol to make the specified picture appear.

**Figure 56. The French flag associated with the field value France**
6 Close the flag and clear all selections.

This way, pictures and multimedia presentations can be shown in the right contexts, other applications can be started, and specific documents opened. You can link almost any type of file to field values. It is also possible to simply type words in the second field of the info table instead of specifying a path to a file. In that case, QlikView will show the text in an internal text viewer.

To learn more about creating and viewing info tables, see the QlikView Reference Manual.

**Embedding external info**

In many cases it is good that pictures etc. do not have to be stored inside a QlikView document and take up space in memory and on disk. However, if there are not too many pictures and if you want to be able to send a QlikView document to other people without worrying about sending the picture files as well, there is an option to embed the info in the QlikView file.

1 Choose Edit Script again.
2 Find the statement that starts with Info Load.
3 Precede that statement with the word Bundle so that it starts Bundle Info Load.
4 Reload the script.
5 Save your document.

The flag pictures are now stored inside the QlikView document itself and do not need to be moved with the QlikView document.

**Displaying info in a text object**

Instead of displaying the picture in a separate window that you need to open manually by clicking the info symbol, you can also display the picture in a text object that is permanently visible and that is updated automatically according to your selections.

1 Go to the Geography sheet.
2 Select Canada in the list box Country.
3 Click the Create Text Object button in the design toolbar.
4 In the Text edit box enter the following:
   =qmem://Country/\&only(Country)
This syntax is a reference to the pictures. The equal sign indicates that the text is an expression. `qmem` stands for a reference to an internal file, i.e. a file stored in the QlikView document. `Country` is the name of the field to which the pictures are related. `only(Country)` is an expression returning the value currently selected in the field `Country`.

The expression is evaluated each time the logical state in the field `Country` changes. For example, when you select `Italy` in the list box `Country`, the expression evaluates to `qmem://Country/Italy`. This is the place where the file is stored in the document.

5 In the drop-down `Representation` choose `Image`.
6 In the drop-down `Image Strech` choose `Keep Aspect`.
7 Under `Background` set the `Transparency` to 100%.
8 Click `OK` to close the dialog.

Now your sheet shows a text object displaying the Canadian flag.

9 Move and size the text object so that it is entirely visible.
10 Clear the selection. As there is no single country selected, the text object is empty.
11 Try another selection in the field `Country` and check the text object.

**Saving, closing and exiting**

You can now save and close the document that you created. If you like, you can compare it with the file `SampleDocument.qvw` that you find in the `Creating a Document` folder.

**What’s next?**

You have now finished the second part of the `Tutorial`. In addition to the basic knowledge about selections, sheets and sheet objects acquired in the first part (`Working with QlikView`), you have learned how different kinds of files are loaded into the associative QlikView database and how the logical structure is created.

The final part of this tutorial, `Advanced Features`, lets you further explore the possibilities of QlikView. It differs from the first two parts in that it contains independent lessons (i.e. the procedures performed are not based on the work done in previous lessons), thereby allowing you to immediately go to the lesson that interests you the most.
The lessons in the final part are especially suitable for application developers, because they deepen the knowledge about loading data and building the data structure.

Furthermore we recommend the training course QlikView Developer I. There you can learn more about the load script, data modeling, database connectivity and typical pitfalls to avoid.

The course QlikView Developer II - for advanced developers - covers complex scripting functionality as well as data cleaning, data model optimization and performance tuning.
ADVANCED FEATURES

- More about associations
- Load inline
- Field groups and cyclic display in charts
- Cross tables
- And-mode
- Number formats
- Security
INTRODUCTION

This final part of the Tutorial deepens the knowledge you have already acquired and lets you further explore the possibilities of QlikView. Among other things, you will learn how to modify the script to load different types of table formats in an optimal way and how to use access restriction. Moreover, Advanced Features provides a chapter on the interpretation and formatting of numbers.

Although most of the functions presented are related to the script, we have also devoted a chapter to advanced layout features: you will learn to create hierarchic and cyclic field groups and to use cyclic expressions in charts.

The lessons in this third part of the Tutorial, Advanced Features, are independent (i.e. the procedures performed are not based on the work done in previous lessons), which allows you to immediately go to the lesson that interests you the most.

The files used in this part are found in the ..\Tutorial\Advanced directory.
LESSON 18 MORE ABOUT ASSOCIATIONS

The Fields page appearing after every script execution contains a check box named Show System Fields. If this check box is selected, the column listing available fields includes six fields preceded by a dollar sign ($). These fields, called system fields, are very useful for obtaining an overview of the logical structure of a QlikView document.

The first section of this lesson describes the system fields and shows how they can be used on a system sheet. The second part shows an example of how you can solve a common problem using the system fields: display of frequency information for key fields.

Creating a system sheet

1. Start QlikView.
2. Open the file Advanced.qvw found in the Advanced folder.
3. Choose Add Sheet... from the Layout menu.
4. Go to the Sheet Properties dialog. Name the sheet System.
5. Go to the Fields page.
6. Make sure the option Show System Fields is selected.
7. Move the system fields (the ones preceded by a dollar sign, $) to the column Fields Displayed in Listboxes.
8. Click OK.
9. Size the list boxes until you see all field names and all field values, then rearrange the boxes.
10. Save the file as System.qvw.

The system fields show
• the names of the fields retrieved ($Field),
• the names of the tables loaded ($Table),
• the number of rows and columns in a table ($Rows and $Fields),
• the column number for a specific field ($FieldNo), and
• the names of the info tables loaded ($Info).
Using the system sheet

Your system sheet is now ready, but to further improve it, choose frequency display for the list box $Field$:

1. Open the Properties dialog for the list box $Field$.
2. On the General page, select the check box Show Frequency.
3. Go to the Sort page and select Frequency, Descending.
4. Click OK.

The values in the field $Field$ are now followed by numbers indicating their number of occurrences in the tables. The list box being sorted by frequency, the field with the greatest number of occurrences is placed at the top.

You see that the field Country occurs in three tables, Customer ID and Salesman ID in two tables, and all the other fields in only one table. Now click the Table Viewer icon to have a closer look at the structure.
MORE ABOUT ASSOCIATIONS

The three fields appearing more than once are the fields used to associate the tables of the document.

Figure 58. The logical structure seen in the Table Viewer

5 Click OK to go back to your document.
6 Click Country in the $Field box.

The program now shows that the field Country occurs in the tables Country1 (a logical table consisting of three concatenated country tables), Customer and Market. The other list boxes provide additional information on the number of rows and fields of the concerned tables, and on the column numbers of the field in the respective tables.

Moreover, the list box $Info on the system sheet shows the info table associated with the field Country.

As soon as only one table or info table is possible (selected or optional) in a list box, a small info symbol is displayed in the top right-hand corner of the list box. Clicking this will allow you to edit the table directly:

7 Click on the value Customer in the list box $Table.
8 The info symbol appears in the top right-hand corner. Click it.
9 The original table is now opened by the associated program. Study it, then close the program to get back to QlikView.
10 Clear your selections.

Note If the file type of the table is not associated with an appropriate editor, the table will not be opened. To associate a file type with a program, open Windows Explorer. Select a file of the relevant type in the structure and double-click it. This opens a list of available programs. Pick an appropriate program, preferably Notepad or Excel, then click OK. (Another option is to
When working with large sets of data with complicated structures, it is impossible to keep the entire data structure in mind. This is when the system sheet is of crucial importance.

**Creating a system table**

Besides displaying the system fields in list boxes, you can also illustrate the relations by creating a system table:

1. Right-click on the **System** sheet to open the **New Sheet Object** menu where you select **System Table**.

The system table now appears on your system sheet. Size it. Study it. You will find that the first column, listing all the fields found in the document, is followed by one column for each loaded table. If a table contains the field listed in the leftmost column, the field also occurs in the table column; if not, a '-' (indicating a NULL value) is displayed. You easily see which of the fields are keys, i.e. common to more than one table. The system table thus clearly shows how the tables of the document are associated. It can be a useful complement to the **Table Viewer** described in Lesson 14 on page 159.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Table</th>
<th>Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer ID</td>
<td>Customer</td>
<td>Customer ID</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Salesmen ID</td>
<td>Salesmen</td>
<td>Salesmen ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capital</td>
<td>Capital</td>
<td>Capital</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pop. Growth</td>
<td>Pop. Growth</td>
<td>Pop. Growth</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initiation</td>
<td>Initiation</td>
<td>Initiation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Official na</td>
<td>Official na</td>
<td>Official na</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer</td>
<td>Customer</td>
<td>Customer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>Address</td>
<td>Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>City</td>
<td>City</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zip</td>
<td>Zip</td>
<td>Zip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction</td>
<td>Transaction</td>
<td>Transaction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Year</td>
<td>Year</td>
<td>Year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Month</td>
<td>Month</td>
<td>Month</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

*Figure 59. The system table*

Below you find one of many examples of situations where the use of system fields is indispensable.
Showing frequency in key fields

Suppose you work with the Customers sheet and want to see how many customers you have in different countries, i.e., how many times the countries occur in the data.

1. Go to the Customers sheet of your document.
2. Click on the list box Country with the right mouse button, then click Properties.
3. Go to the General page.

The check box Show Frequency is disabled, i.e., it is not possible to show frequency for this field. Why?

By studying the System sheet, you clearly see that the field Country occurs in more than one table. As a matter of fact, three of the loaded tables contain a field named Country. As the three Country fields are treated as one due to the associations, it is impossible for the program to know which of the tables it should use for calculating data frequencies. Since making guesses could lead to erroneous results, QlikView has been designed not to allow certain operations when the data interpretation is ambiguous for key fields.

Country and Market, containing geographical information and a list of the markets to which different countries belong, list each country only once. The Customer table, however, contains more than one occurrence of countries in which several customers reside. This is what we are interested in. To obtain the information you need, load the field Country a second time under a new name from the table Customer.xls:

4. Close the List Box Properties dialog.
5. Open the Edit Script dialog.
6. Find the statement loading Customer.xls and position the cursor after the last field (Country), then type ", Country as CustomerCountry". The load statement now looks like this:

   Directory;
   Customer:
   LOAD [Customer ID],
       Customer,
       Address,
       City,
       Zip,
       Country, Country as CustomerCountry
   FROM ..\Creating a Document\Data Sources\Customer.xls
   (biff, embedded labels, table is CUSTOMER$);
You need to keep the field *Country*. If you do not there will be no key field and thus no association with previously loaded tables.

7. Click **Reload**.

8. Move the new field *CustomerCountry* to the list of displayed fields, then click **OK**.

The list box *CustomerCountry* contains only countries in which there are customers. It holds less values than the *Country* list box. This can easily be seen in the status bar.

9. Select all countries beginning with B in the list box *CustomerCountry*.

10. See the information in the QlikView status bar at the bottom of the window.

```
<table>
<thead>
<tr>
<th>Date</th>
<th>Distinct Values</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/31/11 01:02:37*</td>
<td>D: 954</td>
<td>F: 13/181</td>
</tr>
</tbody>
</table>
```

*Figure 60. Status bar information about the list box CustomerCountry*

Besides a time stamp of the last reload of the document, the status bar holds information about the active list box field. Behind the D you see the number of selected values in relation to the number of distinct values in the list box. This means there is a selection of 9 out of 94 distinct values in the field *CustomerCountry*. Behind the F, you see the number of selected records in relation to the total number of values. The selected countries occur in 13 out of 181 records, i.e. there are 13 customers in the selected countries and there are 181 records in total in the *Customer* table. This can be verified on the system sheet.

11. Click the header of the list box *Country* to activate this object.

12. Again look at the information in the QlikView status bar.

There are 9 values selected out of 197. This means the *Country* field holds 197 distinct values in total. There is no information about the number of records as *Country* is a key field and frequency is not available.

However for *CustomerCountry* it is thus possible to show frequency information.

13. Clear the selection.

14. Click on the *CustomerCountry* list box with the right mouse button, then choose **Properties**.

15. On the **General** page, select the check box **Show Frequency**.

16. Go to the **Sort** page and select **Frequency**

17. Click **OK**.

The countries are now displayed in frequency order. You may have to size the list box to see the numbers.
Since it actually makes more sense to have the field CustomerCountry on this sheet than the Country field (you are not interested in the countries in which you have no customers), do the following:

18 Remove the list box Country.

When selecting countries on the Customers sheet, there will now always be at least one customer optional.

19 Adjust the layout.

20 Save the file.

Key fields have yet two limitations besides the inability to show frequency:

• Statistics boxes based on a key field show n/a for most statistical entities.
• In charts it is not possible to create expressions containing functions that depend on frequency information for key fields (e.g. sum, count functions, average) unless the distinct modifier is turned on.

21 Close the file. If you wish, compare it with the file SystemFinal.qvw found in the Advanced folder.

22 If you will not be working with QlikView for a while, you can now exit the program.

For more information, see the QlikView Reference Manual.
Lesson 19 Load Inline

In some cases, you may want to add data by entering it directly in QlikView rather than loading it from a file or a database. In this lesson you will learn how to do this with **load inline**.

**Load inline** can be used for adding data in existing tables or for reading new tables into the document.

Adding a record with load inline

1. Start QlikView and open the file *Inline.qvw* found in the ..\Tutorial\Advanced directory.

The document holds two tables, Customers and Sales. Suppose you want to add a customer to the document, but without changing the original files.

2. Open the **Edit Script** dialog.

3. Position the cursor behind the load statement that loads the *Customer.xls* file.

4. Type the following lines:

   ```plaintext
   Load * Inline [
   Customer ID, Customer, Address, City, Zip, Country
   1181, Alexander's Catering Service, Fisherman's Drive 4, Portsmouth, BH 354 RW, Great Britain];
   ```

   The first line (**Customer ID, Customer, Address, City, Zip, Country**) lists the field names of *Customer.xls* (the table to which you want to add the record).

   The second line (**1181, Alexander's Catering Service, Fisherman's Drive 4, Portsmouth, BH 354 RW, Great Britain**) contains the record that is to be added.

   The star symbol * is equivalent to "all fields", which means that the statement should load all of the fields of the new record.

   **Note** Due to limited space, the record in the above example does not fit in one line. When reproducing this **inline** clause in the script, however, it is important that you put the entire record in one single line: *Portsmouth etc.* should thus follow directly after *Fisherman's Drive 4*.

5. Click **Reload**.

6. Click **OK** to close the dialog.
No new field has been added, but there are new field values in some of the list boxes. Click *Alexander’s Catering Service* in the *Customer* list and check that the record has been read properly.

The data enclosed by the parenthesis after *inline* is treated like an ordinary table. Having the same set of fields as the customer table, the inline table has been concatenated with the customer table. You can easily check this by studying the *System* sheet: only two tables are displayed in the $Table list box (the concatenated table is always given the name of the first table read, which, in this case, is *Customer*).

Save the document as *MyInline.qvw* or something similar.

Naturally, inline tables can be used for other purposes than for adding records to existing tables. If, for instance, you wish to load very small tables, it may be easier to create these directly in the script than to create and load an external file.

**Adding a table with load inline**

The document *MyInline.qvw* contains a field with the months of the year written as numbers. Suppose you want to create a chart with the names of the months spelled out, and another chart showing sales per quarter. This is easily solved with a new table containing this information.

Adding a new table means associating new information to already existing information via a field name. Typical examples could be connecting an account number to an account name or splitting a date into three fields for year, month and day, respectively.

In this example, you will use *load inline* to add month numbers and quarters. As there is a little more data to add this time we will use the built-in inline wizard to create the *load inline* statement, usually a much more convenient method than typing directly in the script.

1. Open the *Edit Script* dialog.
2. Position the cursor at the end of the script.
3. Open the *Inline Data Wizard* from the *Insert* menu, *Load Statement, Load Inline*.
4. The dialog that opens looks like a small spreadsheet and in fact works much like one. However there is no support for formulas in the data cells.
5. The cursor will be positioned in the top left data cell. Enter the data as shown in the picture below. Use *ENTER* or the arrow keys to move between cells and fill in the table as shown below.
6 Finally double-click in the header row over 1 and enter the field name Month. Repeat for the remaining columns as shown below.

Tip! If you already have the table stored in a program such as Excel it can of course be pasted into the QlikView inline wizard.

7 Click OK. You now have a piece of script looking like this:

```
LOAD * INLINE [
  Month, Month Name, Quarter
  1, January, 1
  2, February, 1
  3, March, 1
  4, April, 2
  5, May, 2
  6, June, 2
  7, July, 3
  8, August, 3
  9, September, 3
  10, October, 4
  11, November, 4
  12, December, 4
];
```

8 Click Reload.

Two new fields have been added to the list of available fields, Month Name and Quarter. The inline table has been associated with the Sales table via the field Month.
9 Click OK.

10 Create a bar chart showing sales per quarter (choose Quarter as dimension and add the expression Sum of Sales). In case you need help, see Working with QlikView on page 65.

Figure 62. The potential appearance of your inline document.

11 Save the document and close the file. If you wish, compare your file with the file InlineFinal.qvw.

12 If you will not be working with QlikView for a while, you can also exit the program.
LESSON 20 FIELD GROUPS AND CYCLIC DISPLAY

Instead of displaying single fields as dimensions in charts, it is possible to define groups of fields to be used for this purpose. Working with field groups allows you to display data in a very efficient way, since the resulting charts will show the selected fields in a hierarchical (drill-down) or cyclic sequence. In this lesson, these important features will be explained: you will define both hierarchic and cyclic field groups and create corresponding charts.

The use of field groups should not be confused with cyclic display in charts. Cyclic display, constituting the last part of this lesson, can be applied to any chart having more than one expression, and results in the expressions being displayed sequentially. Just like the use of field groups, however, it saves space and allows you to make quick changes in the data displayed in the chart.

Field groups

One main difference between QlikView and many other database viewers, OLAP tools etc. is that in QlikView there is no need to predefine any hierarchies in the data. The unique associative logic of QlikView gives you the complete freedom to access any field as a full dimension in any order you like.

For most purposes this freedom is extremely powerful. However, there are occasions when a hierarchy could actually help you to display data more efficiently. QlikView therefore offers the possibility to define groups of fields. The groups can be hierarchic (drill-down) or non-hierarchic (cyclic).

Creating a drill-down group

When several fields form a natural hierarchy, it makes sense to create a drill-down group.

1. Start QlikView, then open the file Groups.qvw found in the ..\Tutorial\Advanced directory.
2. In the Settings menu choose Document Properties and go to the Groups page.
3. Click the New... button. The Group Settings dialog opens.
4. In the Group Name box change the default name to Time.
Select Year, Quarter and Month in the list of available fields by CTRL-clicking them, then click Add to move them to the column of used fields. You can also double-click them to move them.

Use the Promote and Demote buttons to get the correct hierarchy: Year, Quarter, Month. This is of great importance, since the order of the fields in the group corresponds to the display order in charts.

Click OK twice to close all dialogs.

You have now created a drill-down group, which you can use as a dimension in a chart.

Creating and using a chart with drill-down functionality

To create a drill-down bar chart, do the following:

1. Go to the Sales sheet, then click the Create chart button in the toolbar (if the design toolbar is not displayed, choose Toolbars - Design from the View menu).

2. Choose Drill-down as window title, then click Next > to go to the Dimensions page.

The Time group that you created previously is listed among the ordinary field names. However, it can easily be distinguished from them: field groups are always preceded by specific symbols. For drill-down groups, this symbol is a straight arrow.

3. Choose Time as dimension by moving it to Used Dimensions.

4. Click Next >.

5. The Edit Expression dialog automatically opens. Compose the expression Sum (Sales), then click Paste. Alternatively, you can type the expression directly in the edit field. Click OK.

6. Type Sales in the Label box.

7. Click Next > until you get to the Colors page. Select the check box Multicolored.

8. Click Next > to get to the Number page.

9. On the Number page, highlight the expression and select Integer. Type 1000$ in the Thousand Symbol box, then click Finish.
FIELD GROUPS AND CYCLIC DISPLAY

The chart, showing the sum of sales per year, looks like any other bar chart. However, as soon as you make a selection causing the field Year to have only one possible value, you discover its drill-down character:

10 Select the bar 2008 in the chart.

An ordinary chart would now display one bar, representing the sum of sales for 2008. This chart, however, shows the sum of sales for each quarter of the year 2008 (the second field in the field list defined being Quarter).

11 Select the bar representing the fourth quarter.
The chart turns to showing the sales for each month of the selected quarter. *Month* is the third, and last, field in the field group.

As soon as more than one value becomes possible in the fields further up in the hierarchy, the chart is automatically drilled back up.

To go back in the hierarchy, click on the drill-up icon next to the field name.

12 Minimize the chart.

### Creating a cyclic group

Sometimes it may be useful to group fields which do not form a natural hierarchy or do not have anything in common at all. The reason would be to make quick changes of the data displayed in a chart and to save space.

Any fields can be grouped together in a cyclic group.

1. In the **Settings** menu choose **Document Properties** and go to the **Groups** page.

2. Click the **New** button. The **Group Settings** dialog opens.

3. In the **Group Name** box change the default name to **Cyclic**.

4. Select the **Cyclic Group** option.

5. Double-click **Country, Salesman and Year** in the list of available fields to move them to the column of used fields. The order of the fields in the list is of no importance when defining cyclic groups.

6. Click **OK** twice.

You have now created a cyclic group. When used as a dimension in a chart, it will allow you to switch between the fields of the group (x-axis) while keeping the same expression (y-axis).

### Creating and using a cyclic bar chart

To create a cyclic chart, do the following:

1. Click the **Create chart** button in the toolbar.

2. Choose **Cyclic** as window title, then click **Next >** to go to the **Dimensions** page.

The **Cyclic** group is listed among the ordinary field names. Just like the drill-down group, it is preceded by a symbol. For cyclic groups, this symbol is a circular arrow.
Double-click the *Cyclic* group to move it to the column of displayed fields/groups.

Click *Next >*. The *Edit Expression* dialog automatically opens. Compose the expression *Sum of Sales*, then click *OK* to close the dialog.

Type *Sales* in the *Label* box.

Click *Next >*. On the *Sort* page, sort the values by *Y-value*, *Descending*. Click *Next >* until you get to the *Dimension Limits* page.

On the *Dimension Limits* page, mark the check box *Restrict which values are displayed using the first expression* and select the radio button *Show only*. Select *Largest* from the drop-down list and enter the number 10.

Click *Next >* until you get to the *Colors* page. Mark the check box *Multicolored*. Click *Next >* to reach the *Number* page.

On the *Number* page, highlight the expression and select *Integer* and type *1000$* in the *Thousand Symbol* box, then click *Finish*.

Initially, your chart shows the sum of sales per *Country*, which is the first field in the field list.

Switch to the next field by clicking the cycle icon in the bottom right-hand corner of the chart. Now *Salesman*, the second field, is displayed.
If you click the icon a second time, the sum of sales per year will be shown. *Year* is the third and last field of the field group.

When the last field in the list has been used, the turn goes back to the first field. The chart can be cycled indefinitely.

It is also possible to right-click on the cycle icon, in which case a list of the fields in the cyclic group is displayed for direct selection.

Minimize the chart.

Showing three charts in one frame in this way is a very efficient way of displaying data. It also allows you to make quick changes of graphically displayed data.

**Cyclic display of expressions**

The *Expressions* page in the *Chart Properties* dialog provides a possibility to group several expressions together. Grouped expressions are displayed sequentially instead of simultaneously. The switching between expressions is done via a button similar to the one used in cyclic charts.

To create a bar chart with cyclic display of expressions, do the following:

1. Click the *Create chart* button in the toolbar.
2. Choose *Cyclic Display* as window title, then click *Next >* to go to the *Dimensions* page.
3 Move the field *Year* to the column of displayed fields, then click **Next >**.

4 The *Edit Expression* dialog automatically opens. Compose the expression *Sum of Sales*, then click **OK** to close the dialog.

5 Type *Sum of Sales* in the *Label* box.

Note that the *Group* button is disabled: you need two expressions in the chart in order to be able to use it.

6 Click **Add** to add a second expression.

7 This time, create the expression *Count (distinct [Transaction ID])*. To do so choose the *Aggregation Total count* and *Field Transaction ID*. Check the *Distinct* option to make sure that several occurrences of the same transaction are only counted once. Click **Paste**.

8 Then click **OK** to close the dialog.

9 Type *Count of Sales* in the *Label* box.

10 The *Group* button is now enabled: click it.

11 Click **Next >** until you reach the *Colors* page. Mark the check box *Multicolored*. Click **Next >**.

12 On the *Number* page, highlight the expression *Sum of Sales* and select *Integer* and set *1000$* as *Thousand Symbol* (for the first expression), then click **Finish**.

The chart looks like an ordinary bar chart showing the sum of sales per year. However, the cycle icon in the bottom left-hand corner indicates that the chart has further potential.

13 Click the cycle icon.
The chart now turns to showing the number (total count) of sales performed during different years:

![Bar chart showing number of sales by year](image)

*Figure 67. The chart using the second expression*

Naturally, you can choose to display more than two expressions this way. It is also possible to combine groups and cyclic display into powerful multi-dimensional charts. Only your imagination will set the limits.

14 Save the document using a name of your choice. If you wish, compare it with the file `GroupsFinal.qvw`.

15 Close the file. If you will not be working with QlikView for a while, you can also exit the program.
LESSON 21 LOADING CROSS TABLES

A cross table is a common type of table featuring a matrix of values between two orthogonal lists of header data. By using the QlikView crosstable statement, you can load this type of table in a very elegant way. The procedure is described in this chapter.

Loading a cross table

You will start by looking at a crosstable in Excel (or a similar program):

Open the Explorer, then find the file Crosstable1.csv in the ..\Tutorial\Advanced\Data Sources directory and double-click it.

Excel opens the file. It looks like below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>45</td>
<td>65</td>
<td>78</td>
<td>12</td>
<td>76</td>
<td>22</td>
</tr>
<tr>
<td>2008</td>
<td>11</td>
<td>23</td>
<td>22</td>
<td>22</td>
<td>45</td>
<td>85</td>
</tr>
<tr>
<td>2009</td>
<td>65</td>
<td>56</td>
<td>22</td>
<td>79</td>
<td>12</td>
<td>56</td>
</tr>
<tr>
<td>2010</td>
<td>45</td>
<td>24</td>
<td>32</td>
<td>78</td>
<td>55</td>
<td>15</td>
</tr>
<tr>
<td>2011</td>
<td>45</td>
<td>56</td>
<td>35</td>
<td>76</td>
<td>68</td>
<td>82</td>
</tr>
</tbody>
</table>

Figure 68. The Crosstable1.csv file

This table holds the number of orders per month. You will start by loading the table into QlikView the usual way:

1. Close the file.
2. Start QlikView and choose New from the File menu. Name the document Crosstable1.qvw and save it in the Advanced folder.
3. Open the Edit Script dialog.
4. Click Table Files and browse for the file Crosstable1.csv in the Advanced Folder under Data Sources. Click Open.
5. If the file wizard has made a correct interpretation, click Finish.

The following statement has been generated in your script:
6. Load the script by clicking **Reload**.

7. In the dialog **Sheet Properties** that now opens, add all the fields except the system fields to the **Fields Displayed in Listboxes**.

8. Click **OK**. The following list boxes appear on your screen:

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>11</td>
<td>23</td>
<td>22</td>
<td>12</td>
<td>12</td>
<td>15</td>
</tr>
<tr>
<td>2008</td>
<td>45</td>
<td>24</td>
<td>32</td>
<td>22</td>
<td>45</td>
<td>22</td>
</tr>
<tr>
<td>2009</td>
<td>65</td>
<td>56</td>
<td>35</td>
<td>76</td>
<td>56</td>
<td>56</td>
</tr>
<tr>
<td>2010</td>
<td>85</td>
<td>78</td>
<td>79</td>
<td>89</td>
<td>82</td>
<td>85</td>
</tr>
</tbody>
</table>

**Figure 69. The resulting list boxes**

The result is of this load process is one field for **Year** and one field for each of the months. This is not what you want: you would prefer to have three fields generated, one for each header category (**Year** and **Month**) and one for the data values inside the matrix.

9. Open the **Edit Script** dialog box again.

10. Now add the **crosstable** prefix, indicating that the table is to be loaded as a cross table, to your **load** statement. The **crosstable** prefix should be followed by a parenthesis containing the names you wish to apply to the new fields, in our case **Month** and **Orders**:

```
Crosstable(Month,Orders) LOAD Year, 
   Jan, 
   Feb, 
   Mar, 
   Apr, 
   May, 
   Jun 
FROM Data Sources\Crosstable1.csv 
(txt, codepage is 1252, embedded labels, delimiter is ',', msq); 
```
11 Click **Reload**. The **Fields** dialog page of the **Sheet Properties** dialog opens. Move the fields **Month** and **Orders** to the column of displayed fields (the field **Year** is already there), then click **OK**.

The following list boxes appear on your screen:

![Figure 70. The list boxes when the script has been run with the crosstable prefix.](image)

This distribution of values makes a lot more sense. In case you want to adjust the layout of the list boxes (change the sort order and number of columns shown), see the chapter about “list boxes and statistics boxes” on page 53.

12 Remove the obsolete (now empty) listboxes for the single months.

13 Save the document, then close it.

### Loading a cross table with more than one regular column

The cross table is often preceded by a number of regular columns that should be loaded in a straightforward way. This is the case in the following table **Crosstable2.csv**:

![Figure 71. Crosstable2.csv](image)
In this table the matrix columns are preceded by two regular columns: Salesman and Year. You would probably like QlikView to show the contents of the table in four fields:

- **Salesman**, containing the values of the first (regular) column
- **Year**, containing the values of the second (regular) column
- **Month**, containing the headers of the remaining columns
- **Sales**, containing the values of the remaining columns

To obtain this result, do the following:

1. Choose **New** from the **File** menu.
2. Name the document *Crosstable2.qvw* and save it in the **Advanced** folder. Open the **Edit Script** dialog.
3. Click **Table Files** and browse for the file *Crosstable2.csv* in the **Advanced** Folder under **Data Sources**. Click **Open**. The **File Wizard** opens. We will use this wizard to create the crosstable statement.
4. Click **Next >** twice. This will take you to the **File Wizard: Options** page.
5. Click the **Crosstable** button. The **CrossTable** wizard opens.
6. Under **Qualifier Fields**, set the number of qualifier fields that precede the table to be transformed to **2**.
7. Under **Attribute Field**, enter the name of the new field that will contain the month names. Type **Month**.
LOADING CROSS TABLES

8 Under **Data Field**, i.e. the field that combines the sales figures, type *Sales*.

![CrossTable](image)

**Figure 72.** The CrossTable wizard uses color coding for the different field types.

9 Click **OK**. In the preview pane you can now see the transformed table.

<table>
<thead>
<tr>
<th>Salesman</th>
<th>Year</th>
<th>Month</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>2007</td>
<td>Jan</td>
<td>45</td>
</tr>
<tr>
<td>A</td>
<td>2007</td>
<td>Feb</td>
<td>64</td>
</tr>
<tr>
<td>A</td>
<td>2007</td>
<td>Mar</td>
<td>78</td>
</tr>
<tr>
<td>A</td>
<td>2007</td>
<td>Apr</td>
<td>12</td>
</tr>
<tr>
<td>A</td>
<td>2007</td>
<td>May</td>
<td>70</td>
</tr>
<tr>
<td>A</td>
<td>2007</td>
<td>Jun</td>
<td>22</td>
</tr>
<tr>
<td>A</td>
<td>2008</td>
<td>Jan</td>
<td>11</td>
</tr>
<tr>
<td>A</td>
<td>2008</td>
<td>Feb</td>
<td>22</td>
</tr>
</tbody>
</table>

**Figure 73.** The transformed table in the File Wizard

10 Click **Finish**. The generated script statement looks as follows:
CROSSTABLE(Month, Sales, 2)
LOAD Salesman,
Year,
Jan,
Feb,
Mar,
Apr,
May,
Jun
FROM Data Sources\Crosstable2.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msg);

Note that the crosstable prefix has the number 2 as a third parameter. This indicates the number of regular columns in the original table. If no parameter is stated, 1 is assumed.

11 Load the script by clicking Reload.

12 The Fields page of the Sheet Properties dialog opens. Move all fields to the column of displayed fields, then click OK.

The following list boxes appear on your screen:

<table>
<thead>
<tr>
<th>Salesman</th>
<th>Year</th>
<th>Month</th>
<th>Orders</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>2007</td>
<td>Apr</td>
<td>11</td>
</tr>
<tr>
<td>B</td>
<td>2008</td>
<td>Feb</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>2009</td>
<td>Jun</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>2010</td>
<td>Mar</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>2011</td>
<td>May</td>
<td>23</td>
</tr>
</tbody>
</table>

Figure 74. The resulting list boxes

13 Save the document, then close it. If you will not be working with QlikView for a while, you can also exit the program.

For a more detailed description of the syntax of the crosstable prefix, see the QlikView Reference Manual.
LESSON 22 AND-MODE IN A LIST BOX

Two selections in different list boxes are always interpreted as logical **and**, i.e. QlikView will show all the field values associated with both the selections. A multiple selection within a list box is however usually interpreted as logical **or**, i.e. QlikView will show data entries associated with *any* of the selected values.

Under some circumstances, a multiple selection within a list box can be set to logical **and**, which means that QlikView will show only data entries associated with *all* of the selected values.

This lesson features a list box set to **and**-mode, which you will use for regular selections as well as for **not**-selections. You will also learn under which circumstances a list box can be set to **and**-mode.

Making an and-selection

In the file *And.qvw* in the ..\Tutorial\Advanced folder, there is a list box for which the **and**-mode can be activated:

1. Start QlikView.
2. Open the file *And.qvw* in the ..\Tutorial\Advanced folder.
3. Choose the tab Geography, and find the list box Membership.

This is a list of organizations and geographical areas that the different countries belong to. A country can be a member of several organizations, and an organization can have many members. There is thus a many-to-many relationship between the field **Country** and the field Membership. Moreover, the field Membership does not link directly to any other field but **Country**. Under such circumstances, the field Membership can be set to **and** mode. A multiple selection in the Membership field will then be interpreted as "show only countries that are members of all the selected organizations".

4. Click on the list box Membership with the right mouse button, then choose Properties.
5 On the General page mark the check box And mode, then choose the OK button.

6 Select Europe by clicking it. The Europe cell should now be green, and have an ampersand "&" to the left. The organizations shown as alternatives (white) are the ones that have one or several members of Europe. The organizations that are excluded are the ones with no members on the European continent.

7 Select G8 by CTRL-clicking. You have now selected Europe and G8, i.e. countries that are members of both. Only five countries remain optional, and these are all European countries in the G8 group.

Making a not selection

It is also possible to exclude countries in a similar way:

1 Deselect G8 by CTRL-clicking.
2 Select G8 by CTRL-clicking it, keeping the mouse button down. Release the button when the cell has turned red.

You have now selected Europe and not G8. Only European countries not in the G8 group are now optional. This type of selection is called forced exclusion, and is very useful in many-to-many relationships.

3 Close the file. If you will not be working with QlikView for a while, you can also exit the program.

Characteristics of the and table

<table>
<thead>
<tr>
<th>Country</th>
<th>Membership</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afghanistan</td>
<td>Asia</td>
</tr>
<tr>
<td>Albania</td>
<td>Europe</td>
</tr>
<tr>
<td>Algeria</td>
<td>Africa</td>
</tr>
<tr>
<td>Algeria</td>
<td>OPEC</td>
</tr>
<tr>
<td>Andorra</td>
<td>Europe</td>
</tr>
<tr>
<td>Angola</td>
<td>Africa</td>
</tr>
<tr>
<td>Angola</td>
<td>OPEC</td>
</tr>
<tr>
<td>Antigua</td>
<td>North America</td>
</tr>
<tr>
<td>Argentina</td>
<td>South America</td>
</tr>
<tr>
<td>Armenia</td>
<td>Europe</td>
</tr>
<tr>
<td>Australia</td>
<td>ANZUS</td>
</tr>
<tr>
<td>Australia</td>
<td>Australia &amp; Pacific</td>
</tr>
<tr>
<td>Australia</td>
<td>OECD</td>
</tr>
<tr>
<td>Austria</td>
<td>EU</td>
</tr>
<tr>
<td>Austria</td>
<td>Eurozone</td>
</tr>
<tr>
<td>Austria</td>
<td>OECD</td>
</tr>
<tr>
<td>Azerbaijan</td>
<td>Europe</td>
</tr>
<tr>
<td>Bahamas</td>
<td>North America</td>
</tr>
<tr>
<td>Bahrain</td>
<td>Asia</td>
</tr>
</tbody>
</table>

Figure 76. An and-table

Not every field can be set to logical and mode. The and mode is only possible if the field corresponds to the second column of a two-column table.

Furthermore, the field must not be fetched from more than one table, the reason being that the and alternative is logically meaningful only if the concerned field is associated to only one other field.
Finally, there must be no duplicate records in the table. Therefore this kind of table is always loaded using the **distinct** predicate (see the *QlikView Reference Manual*).

If the field is loaded this way, the **And mode** control in the **List Box Properties** dialog will no longer be dimmed and the logical mode of the list box can be changed.
LESSON 23 NUMBER FORMATS

QlikView can handle text strings, numbers, dates, times, time stamps and currencies correctly. They can be sorted, displayed in a number of different formats and they can be used in calculations. This means e.g. that dates, times and time stamps can be added to or subtracted from each other.

This lesson deals with the basics of number interpretation and number formatting. The examples have been designed for computers with regional options set to English (United States). If you are using a computer with different regional options, number formats in the data sources, in the QlikView script and in the QlikView layout may look different.

Handling of numeric data

The issue of obtaining correct number formats is really a question of two different things:

• Interpretation of data when it is loaded
• Display of different number-based data types

Data storage inside QlikView

In order to understand data interpretation and number formatting in QlikView, it is necessary to know how data is stored internally by the program. All of the data loaded into QlikView is stored in two representations, as a string and as a number.

1 The string representation is always available and is what is shown in the list boxes and the other sheet objects. Formatting of data in list boxes (number format) only affects the string representation.

2 The number representation is only available when the data can be interpreted as a valid number. The number representation is used for all numeric calculations and for numeric sorting.

If several data items read into one field have the same number representation, they will all be treated as the same value and will all share the first string representation encountered. Example: The numbers 1.0, 1 and 1.000 read in that order will all have the number representation 1 and the initial string representation 1.0.
Interpretation of numeric data

Loading data with default formats

QlikView tries to interpret input data as a number, date, time etc. As long as the system default settings (found in the Control Panel under Regional and Language Options in Windows XP or Windows 7) are used in the data and the number interpretation variables in the script are correctly defined, the interpretation and the display formatting are handled automatically by QlikView, and the user does not need to alter the script or any setting in QlikView.

1. Open the Explorer and find the file Date1.csv in the ..\Tutorial\Advanced\Data Sources folder. Double-click the file.

2. Excel opens the file. It consists of three fields, Date, Customer and Sales. Note that the dates in the Date field are formatted according to the American standard format M/D/YYYY (M=month, D=day, YYYY=the year), and that the numbers in the Sales field have comma as a thousands separator.

3. Close the file.

4. Start QlikView, then choose New from the File menu. Save the document in the Advanced folder and name it Number.qvw.

5. Open the Edit Script dialog. A certain number of set statements, defining separators and number formats via the number interpretation variables, have been generated automatically:

   SET ThousandSep=',';
   SET DecimalSep='.';
   SET MoneyThousandSep=',';
   SET MoneyDecimalSep='.';
   SET MoneyFormat='$#,##0.00;($#,##0.00)';
   SET TimeFormat='h:mm:ss TT';
   SET DateFormat='M/D/YYYY';
   SET TimestampFormat='M/D/YYYY h:mm:ss[.fff] TT';
   SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;...';
   SET DayNames='Mon;Tue;Wed;Thu;Fri;Sat;Sun';

These settings are taken from the regional settings in your computer on which the script is generated and could therefore look somewhat different on your computer. The number interpretation variables ensure a correct reexecution of the QlikView script also on computers with other regional settings, provided that the data files remain the same.
6 Open the Control Panel (Start menu, Settings) and go to Regional Settings.

7 Look through the pages of the Regional Settings dialog, especially Number and Date, and note that the settings correspond to those defined by the variables above. To get the same results as this example, English (United States) must be chosen on the first page.

8 Close the Control Panel.

The number interpretation variables may be deleted, edited or duplicated freely. If changed, they substitute the operating system defaults.

Note that the thousands separator and the date format defined by the number interpretation variables also correspond to the formats used in the file Date1.csv. QlikView will thus interpret everything correctly:

9 Go back to QlikView and click Table Files in the Edit Script dialog.

10 Find the file Date1.csv in the ..\Tutorial\Advanced\Data Sources folder then click Open.

11 If the file wizard has made a correct interpretation of the contents, click Finish.

12 Click Reload to execute the script.

13 Move the fields Customer, Date and Sales to the column of displayed fields, then click OK.

14 The three list boxes appear on your sheet. Move and size them.

There is an easy way to find out if QlikView has interpreted the contents as valid numbers: valid numbers are always right-aligned in the list box, whereas values interpreted merely as text strings are left-aligned. The contents of both Sales and Date being right-aligned, you can conclude that they have been correctly interpreted.

Once QlikView has interpreted the data as valid numbers, you can apply other formats using the Number page in the List Box Properties dialog. Formatting will be treated in the section “Formatting of data” on page 218.

15 Save the document and close it.

Loading data with different formats

Suppose that the values of the field Date have the British date format (DD/MM/YYYY) instead of the American, i.e. a format that differs from the system settings and the formats set at the beginning of the script:
1 Click the **New** button to create a blank document. Save the document in the _Advanced_ folder and name it _Number2.qvw_.

2 Open the **Edit Script** dialog, then click **Table Files**.

3 Find the file _Date2.csv_ in the '..\Tutorial\Advanced\Data Sources' folder then click **Open**.

4 If the file wizard has made a correct interpretation of the contents, click **Finish**.

5 Click **Reload** to execute the script.

6 Move the fields _Customer, Date_ and _Sales_ to the column of displayed fields, then click **OK**.

7 The three list boxes appear on your sheet. Move and size them.

This time, the number interpretation has not worked properly. The first two digits in _Date_ have been interpreted as month although they represent the day. Therefore, dates with a day number greater than 12 have not been recognized as valid dates (these are left-aligned) and in the other values, month and day have been inverted.

As long as a date is not recognized as numeric, you will not be able to change the number format of the field, nor make calculations based on the field.

The problem can be solved in one of the following ways:

- By changing the system settings in the Control Panel
- By changing the date format setting in the script
- By using an interpretation function in the script

Changing the system settings is usually not a good idea, unless most of the files you load have a type of regional settings that is different from yours.

**Changing the date format in the script**

Changing the date format setting in the script is a better solution (moreover, it is very useful if you want a person with different system settings to use the document):

1 Open the **Edit Script** dialog of your file _Number2.qvw_. Change the date format setting to DD/MM/YYYY. The **set** statements are now the following:

```qlik
SET ThousandSep=',,,'
SET DecimalSep='.';
SET MoneyThousandSep=',,,'
```
NUMBER FORMATS

```plaintext
SET MoneyDecimalSep='.';
SET MoneyFormat='$#,##0.00;($#,##0.00)';
SET TimeFormat='h:mm:ss TT';
SET DateFormat='DD/MM/YYYY';
SET TimestampFormat='M/D/YYYY h:mm:ss[.fff] TT';
SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;...';
SET DayNames='Mon;Tue;Wed;Thu;Fri;Sat;Sun';
```

Due to this change, dates in the format DD/MM/YYYY should be interpreted properly. Values in the format M/D/YYYY however are no longer recognized.

2 Reexecute the script by clicking **Reload**.

3 Click **OK** to close the dialog, then study your document and note that the values in the list box **Date** are now right-aligned. They have thus all been interpreted as valid dates.

4 Save the document and close it.

Using interpretation functions

If you load several files which all have different number formats, you may want to use an interpretation function instead. Interpretation functions are used to interpret field contents or expressions.

1 Create a blank document by clicking **New**. Save the document in the **Advanced** folder and name it **Number3.qvw**.

2 Open the **Edit Script** dialog. Note that the date format is M/D/YYYY again, since you have not changed the system settings.

3 Click **Table Files** and open the file **Date2.csv** in the ..\Tutorial\Advanced\Data Sources folder.

4 If the file wizard has made a correct interpretation of the contents, click **Finish**.

5 Modify the script to make it look like below:

```plaintext
LOAD date#(Date, 'DD/MM/YYYY') as Date,
    Customer,
    Sales
FROM Data Sources\Date2.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msg);
```

date# is the interpretation function, Date is the field to be interpreted, and DD/MM/YYYY is the date format according to which you want the field contents to be interpreted. The as is necessary to rename the modified field to it’s initial name Date, otherwise date#(Date, 'DD/MM/YYYY') would be...
used as field name. The syntax of the date# function, as well as further examples, are found in the QlikView Reference Manual.

6 Choose Reload to execute the script.

7 Move the fields Customer, Date and Sales to the column of displayed fields, then click OK.

Study the document and note that the values of the field Date have once again been interpreted correctly. The result is identical with the one of Number2.qvw.

8 Save the document.

Interpretation problems due to different separators are solved in the same way.

**Note** When interpreting dates with only two positions for year, e.g. YY-MM-DD, QlikView will assume that the date falls within a moving window of -50 to +49 years counted from the current year according to the system clock. Thus, 88-08-08 will be interpreted as 1988-08-08, whereas 44-08-08 will be interpreted as 2044-08-08.

Files are not always homogeneous. If you have a file containing differently formatted data in one and the same field, you can use the alt function, which tests if the field contains data formatted according to the specified number representations. See the QlikView Reference Manual.

**Formatting of data**

Once QlikView has interpreted data as valid numbers, they are assigned a default number format which you can see and modify in the Document Properties dialog on the Numbers page.

It is however also possible to choose a different number format in the properties dialog for the sheet object.

1 Click on the list box Date with the right mouse button, then choose Properties... from the float menu.

2 Go to the Number page.

3 Select Override Document Settings in order to set a separate number format for the list box.

4 Change the format to Date by marking the checkbox.
In the Format box, the default date format of the operating system appears. It can be changed to any other format of your choice. For instance, you may prefer the standard ISO format YYYY-MM-DD. Erase the contents of the Format Pattern box and enter the new format, or click the ISO button.

Click OK.

The specified format has been applied to the values of the list box Date. To choose another date format, simply open the Number page of the properties dialog again and change the contents of the Format box.

If the field originally contained differently formatted values, e.g. certain dates with the format M/D/YY and others with the format DD/MM/YY, you may want to return to the original formatting. For ordinary text files, however, this is only possible if the script is re-executed with the Survive Reload check box (Document Properties dialog, Number page) deselected.

The Default from Input button on the Number page is only available for fields with a defined data type read from a database via ODBC.

Save and close the document. If you will not be working with QlikView for a while, you can also exit the program.

It is also possible to set the formatting by using formatting functions in the script. See the QlikView Reference Manual.

For more detailed information about number formats, see the QlikView Reference Manual.
LESSON 24 SECURITY

It is important that information is distributed only to those who have rights to see it. Since QlikView makes the previously cumbersome process of retrieving information a very simple task, it is obvious that security is an issue.

A security mechanism in QlikView can be set up in two different ways: It can either be built into the QlikView document script, or it can be set up through the use of QlikView Publisher.

If the QlikView Publisher is set up to handle security, then each QlikView file will be split up into several files, each containing the data pertaining to the relevant user or user group. These files will be stored in folders with the correct OS security settings, i.e. QlikView lets the operating system handle the access. There is, however, no security built into the file itself, so there is no protection on a downloaded file.

As we cannot assume that you are working with QlikView Server and Publisher, this lesson, which is the last lesson of the Tutorial, refers to the second possibility: security settings that are built in the script of the document. In this case one single file can be made to hold the data for a number of users or user groups. QlikView will use the information in the script to grant or refuse access.

Sections in the Script

Access control is managed via one or several security tables loaded in the same way as QlikView normally loads data. It is thus possible to store these tables in a normal database.

The script statements managing the security tables are given within the access section, which in the script is initiated by the statement **section access**. If an access section is defined in the script, the part of the script loading the “normal” data must be put in a different section, initiated by the statement **section application**. Details on the syntax of the **section** statement can be found in the QlikView Reference Manual.

Access levels

Access to QlikView documents can be authorized to specified users or groups of users. In the security table, users are assigned the access levels ADMIN or USER. If no access level is assigned, the user cannot open the QlikView document.
A person with ADMIN access can change everything in the document. Using the Security page in the Document Properties and Sheet Properties dialogs, a person with ADMIN access can limit the users’ possibilities of modifying the document. A person with USER privileges cannot access those pages.

Example:

```
Section Access;
LOAD * INLINE
    [ACCESS, USERID, PASSWORD
     ADMIN, A, X
     USER, U, Y ];
Section Application;
LOAD ... FROM ...
```

Security fields

The access levels are assigned to users in one or several tables loaded within the section access. These tables can contain several special security fields, typically USER-ID and PASSWORD or NTNAME, and the field defining the access level, ACCESS.
The full set of security fields is described in the QlikView Reference Manual.
Other fields such as GROUP or ORGANISATION may be added to facilitate the administration, but QlikView does not treat these fields in any special way.

None, all, or any combination of the security fields may be loaded in the access section. However, if the ACCESS field is not loaded, the section access will really not be meaningful.

**ACCESS**
A field defining what access the corresponding user should have.

**USERID**
A field containing an accepted user ID. QlikView will prompt for a User ID and compare it to the value in this field. This user ID is not the same as the Windows user ID.

**PASSWORD**
A field containing an accepted password. QlikView will prompt for a Password and compare it to the value in this field. This password is not the same as the Windows password.

**SERIAL**
A field containing a number corresponding to the QlikView license number (serial number). Example: 4900 2394 7113 7304. QlikView will check the license number of the user and compare it to the value in this field.
**NTNAME**

A field containing a string corresponding to a Windows NT Domain user name or group name. QlikView will fetch the logon information from the operating system and compare it to the value in this field.

QlikView will first compare the QlikView license number (serial number) with the field **SERIAL**. After this it will ask the operating system who is logged on. It will then, if necessary, prompt for User ID and password and compare these with the fields **USERID** and **PASSWORD**.

If the combination of Windows User ID, QlikView User ID, QlikView password and license number is found in the Security table, the document is opened with the corresponding access level. If not, QlikView will deny the user access to the document. If the User ID and/or the password are not entered correctly within three attempts the entire log-on procedure must be repeated.

**Example 1:**

Only the license number is checked. One specific computer gets ADMIN access. Everyone else gets USER access. Note that a star can be used to mark “any license number”.

<table>
<thead>
<tr>
<th>ACCESS</th>
<th>SERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN</td>
<td>4900 2394 7113 7304</td>
</tr>
<tr>
<td>USER</td>
<td></td>
</tr>
</tbody>
</table>

**Example 2:**

The administrator and the computer with license number “4900 2394 7113 7304” (the server on which QlikView runs as a batch job) gets ADMIN access. Everyone else gets USER access when entering “USER” as user ID and password.

<table>
<thead>
<tr>
<th>ACCESS</th>
<th>SERIAL</th>
<th>USERID</th>
<th>PASSWORD</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN</td>
<td>*</td>
<td>ADMIN</td>
<td>ADMIN</td>
</tr>
<tr>
<td>USER</td>
<td>4900 2394 7113 7304</td>
<td>USER</td>
<td>USER</td>
</tr>
</tbody>
</table>

If you have once opened a document with access restrictions by entering the correct user name and password, the document will open again using the same credentials without prompting for them as long as the QlikView session lasts.

**Note**  Before you start this exercise, you should take a backup of the file you intend to use. The smallest mistake in the security table could make it impossible to open the file again.
Loading security tables

Suppose you have two tables containing security information. The first table named AccessList.csv contains the security fields USERID, PASSWORD and ACCESS. The second table named AccessSerial.csv the security field SERIAL. Since the same associative logic that is the hallmark of QlikView is used also in the access section, the tables will be associated via the optional field COMPUTER NAME.

Note All fields listed in load or select statements in the section access must be written in UPPER CASE. Any field name containing lower case letters in the database will be converted to upper case when being read by the load or select statement. However, the user ID and the password entered by the end-user opening the QlikView document are case insensitive.

<table>
<thead>
<tr>
<th>USERID</th>
<th>PASSWORD</th>
<th>ACCESS</th>
<th>GROUP</th>
<th>COMPUTER NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharon</td>
<td>7VFI1R</td>
<td>ADMIN</td>
<td>IT</td>
<td>All</td>
</tr>
<tr>
<td>Sharon</td>
<td>FROMME2U</td>
<td>USER</td>
<td>IT</td>
<td>All</td>
</tr>
<tr>
<td>Bob</td>
<td>LOVE15</td>
<td>ADMIN</td>
<td>Marketing</td>
<td>Bob</td>
</tr>
<tr>
<td>Bob</td>
<td>15ALL</td>
<td>USER</td>
<td>Marketing</td>
<td>All</td>
</tr>
<tr>
<td>Pete</td>
<td>NUMBER1</td>
<td>USER</td>
<td>Personnel</td>
<td>All</td>
</tr>
<tr>
<td>Sarah</td>
<td>ABSOLUT</td>
<td>USER</td>
<td>Personnel</td>
<td>Sarah</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>COMPUTER NAME</th>
<th>SERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharon</td>
<td>1234 5678 9012 3456</td>
</tr>
<tr>
<td>Bob</td>
<td>1234 5678 9012 3457</td>
</tr>
<tr>
<td>Pete</td>
<td>1234 5678 9012 3458</td>
</tr>
<tr>
<td>Sarah</td>
<td>1234 5678 9012 3459</td>
</tr>
<tr>
<td>All</td>
<td>*</td>
</tr>
</tbody>
</table>

Note The license number must be given in 4x4 number groups separated by a blank.

You will now load the above tables into QlikView:

1. Open the document for which you want access control, e.g. Advanced.qvw.
2. Save the file as Access.qvw in the same folder.
3. Open the Edit Script dialog and position the cursor at the beginning of the script, but after the set statements.
4 For the tables to be used for access control, the statements loading them need to be placed in a separate section. Type \texttt{section access;}, and press \texttt{RETURN} to get to a new line. Do not forget the semicolon. It indicates the end of a statement.

5 Click \texttt{Table Files}.

6 Select the files \texttt{AccessList.csv} and \texttt{AccessSerial.csv} (in the ..\\texttt{Tutorial\Advanced\Data Sources} directory) and click \texttt{Open}.

7 The files are opened in the file wizard. Make sure the labels are recognized properly, then click \texttt{Finish} for both files.

8 To distinguish the access section from the application section, position the cursor after the statements loading the security tables, then type \texttt{section application;}. Again, do not forget the semicolon.

Now, the first part of your script has the following appearance:

\begin{verbatim}
Section access;
Directory;
LOAD USERID, PASSWORD, ACCESS, GROUP, [COMPUTER NAME]
FROM Data Sources\AccessList.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

LOAD [COMPUTER NAME], SERIAL
FROM Data Sources\AccessSerial.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

Section application;
Directory;
Country:
LOAD Country, Capital,...
\end{verbatim}

9 Choose \texttt{Reload} to execute the script.

10 Click \texttt{OK} to close the dialog.

The following access rights will be granted:

- Sharon will have access rights from all the computers (since all the license numbers are allowed). Depending on which password she uses she will be granted either \texttt{ADMIN} or \texttt{USER} access rights.
Bob will have ADMIN rights when he sits at his own computer (license number “1234 5678 9012 3457”) and enters his UserID (Bob) and Password (LOVE15). He will have USER rights on all the computers (all license numbers allowed) when he gives his UserID (Bob) and Password (15ALL).

Pete will have USER access from all the computers provided he gives his UserID and correct password.

Sarah will have to use her own computer (License number “1234 5678 9012 3459”) and give a correct UserID and Password to be able to open the QlikView document with USER access rights.

**Using the Security pages**

People with ADMIN privileges can prevent the execution of certain commands:

1. Choose **Document Properties** from the **Settings** menu.
2. Go to the **Security** page.
The Security page contains a list of QlikView commands. By deselecting a check box, that command cannot be executed any more.

3 Deselect Add Sheets and Edit Script, then click OK. Check that the commands you deselected are now dimmed, i.e. unavailable.

The deselected commands are unavailable even for users with ADMIN access, but these can - unlike users with USER access - reactivate them any time. If the deselected commands should be available for ADMIN users any time, you can check the option Admin Override Security.

4 Save the file, then close it and exit QlikView.

There is also a Security page in the Sheet Properties dialog, containing security settings on sheet level.
Opening a document with access restriction

Suppose you are Pete and wish to work with the document Access.qvw:

1. Open QlikView, then choose Open from the File menu.
2. Find the file Access.qvw and click Open.
3. QlikView prompts for the correct User ID. Enter Pete, then click OK.
4. QlikView now prompts for the correct password. As Pete, you have USER rights from all the computers. Enter your password, i.e. NUMBER1 (case insensitive). Click OK.

If you have done everything correctly, the document now opens and you can work with it. Note, however, that you cannot add sheets or view the script, since these commands have been inactivated. Note also that you cannot access the Security pages: these pages are only available for ADMIN users.

If you wish to be granted access to all the parts of the document, you need to enter Sharon’s UserID and Password (make sure to pick the password granting her ADMIN access rights).

5. Close the file. If you will not be working with QlikView for a while, you can also exit the program.

Apart from the security settings mentioned above, QlikView supports a feature by which some of the data in a document can be hidden from the user based on the section access login. For an example please refer to the QlikView Reference Manual.
WHAT’S NEXT?

You have now finished the entire Tutorial. You know how to work with QlikView documents and you are familiar with basic steps of creating a script and an appropriate data structure as well as a appealing, efficient layout.

Of course, QlikView offers much more functionality than we can present in this Tutorial. Further information on functions, settings and features can be found in the QlikView Reference Manual and in the QlikView Help.

But apart from the documentation there are many more useful resources available for QlikView users. Be sure to take advantage of all relevant information you can get hold of. Here is a short overview.

QlikView Training Program

Apart from this Tutorial the QlikView training program offers a variety of courses, both classroom training and online e-learning, ranging from the most basic beginner level to more advanced levels. All information on the training program is found on www.qlikview.com under Services - Training.

The page contains recommendations on suitable courses for different user groups such as end users, designers, developers and administrators. You can register for courses in your regions, find out about new courses and download a course guide from there. The training team in your region is also available for all questions on training and courses.

QlikCommunity

Another highly valuable resource is the QlikCommunity found at http://community.qlikview.com. QlikCommunity is the global online community for QlikView, bringing together all kind of QlikView users to interact, learn and share their experiences.

QlikCommunity features blogs with latest news and interesting information from QlikTech employees but also hyperlinks to third-party blogs related to QlikView.

Forums for the different QlikView products cover countless user questions and provide professional answers from the very basics to advanced and complex issues. The forum can be considered a huge knowledge base and it is growing every day.
QlikCommunity also holds a place where community members can share their QlikView documents and make their work available to other users. No matter if you are looking for a nice design template, a specific business application or a solution to a technical problem, it is always worth having a look at the shared QlikViews.

Finally, QlikCommunity is linked to local QlikView user groups all over the world to provide information for local markets in local languages.

**QlikView Demo Applications**

At demo.qlikview.com you can have a look at a large number of sophisticated QlikView demo documents for different industries and areas of application. All these documents are excellent inspiring examples of how to use QlikView efficiently to turn data into valuable and accessible information.
INDEX

A
Access restriction ..................... 221–228
security pages ...................... 196–226
Activating sheet objects .......... 45
Adding
Object ........................................43
Sheet ..........................................41
Adjusting columns
in table .....................................81
in table box ..............................105
Aligning values
in list box .................................57
And-mode ......................... 209–212
Associating tables ........ 145–151, 183–189

B
Back/forward .............................32
Bar chart ...........................................65
multi-dimensional ........77 , 91
Bookmarks ........................................35
Border .............................................127
Button ..................................... 114–118
export button ..........................116
shortcut button ..........................115

C
Chart ........................................... 61–97
bar chart .....................................65
multi-dimensional ........77, 91
cloning ......................................72
color settings ................................74
copying to Clipboard ..............98
cyclic chart ............................. 198
detaching .................................72
drill-down chart ..............96, 196
fast type change ......................64
gauge chart ................................95
line chart ...................................89
number format ......................71
numbers on data points ............71
pie chart ....................................73
pivot table .............................78
printing .................................98
QuickChart .......................... 65
scatter chart ................. 94
selections ......................... 63
sort order ......................... 70
straight table ..........................82
sorting columns .....................83
Cloning charts .........................72
Closing a document ...................20
Colors in chart .........................74
Columns in table
adjusting ............................. 81
Concatenation .............. 153–160
automatic ......................... 153
forced ........................................155
Conventions ...............................17
Copying
formats ......................................50
object ........................................46
to Clipboard ..........................98
Creating
a document ......................... 131
a statistics box ...................... 58
multi box ................................102
table box ................................104
Cross tables .............................203–208
Cyclic
chart .....................................198
display of expressions ...........200
groups ....................................198

D
Detaching charts .......................72
Drill-down chart ..............96, 196
creating ............................196

E
Exporting
with button ....................... 116, 117

F  Fast type change .......................64
Field groups .................. 195–200
cyclic ..................................198
drill-down ......................... 195
Font ............................................50
forced exclusion .................. 210
Format painter .................. 50
Formatting of numbers .......... 218
Frequency
  in key fields .................... 187
Frequency in list box ..............53

G  Gauge chart .................. 95
Groups of fields
  see Field groups

H  Help ............................................20

I  Input box .................... 107
  Entering data .................... 107
Interpretation of numbers ........214

L  Line chart ...................... 89
Line/arrow object ..................113
Linked Object .................... 50
Linking info to a document ........173–177
List box .................. 53–57
  aligning values ..................57
  frequency ...................... 53
  number format ..................56
  properties .................. 53
  sort order .................. 55
Load inline ....................... 191–194
Locking
  selections ....................... 32

M  Moving
  selections ....................... 31
  sheet ...................... 43
Multi box .................. 101–103
  creating ....................... 102
  promoting fields .............. 103
  selections .................. 101, 102

N  Notation .................. 17
not-selection ................... 210
Number format
  Chart ......................... 71
  List box ...................... 56
Number formats ........... 213–219
Numbers
  Formatting .................. 218
  Interpretation .............. 214
Numeric search ..................... 33

O  Object
  adding .................. 43
  copying .................. 46
  font ...................... 50
  linked Object ................ 50
  removing .................. 49
  sizing .................. 46
OLE DB
  loading a file via .............. 168–171
Opening a document ................. 20

P  Partial sums
  in pivot table .................. 81
Path
  absolute .................. 142
  relative .................. 142
Pie chart .................. 73
Pivot table .................. 78
  collapsing .................. 79
  dragging dimensions ........... 80
  expanding .................. 79
  partial sums .................. 81
Printing charts .........................................98
Properties list box .......................................53
Q
QlikView Help ...........................................20
short presentation .........................11
starting .......................................19
QlikView Server ................................21
Queries in QlikView .......................27
QuickChart ........................................65
R
Reloading data ....................................128
Removing Object ........................................49
Renaming fields .............................148–151
Renaming tables ..................................161
S
Saving a document ....................................20
Scatter chart .........................................94
Search ..................................................33
Security ........................................221–228
Security field ......................................222
Security pages ........................................226
Selection ...........................................28
Selections back/forward .........................32
bookmarks .........................................35
locking ..............................................32
moving .............................................31
of objects .......................................45
search .............................................33
unlocking ..........................................32
Sheet ........................................39–43
adding ..............................................41
moving .............................................43
Shortcut button ..................................115
Sizing object ........................................46
Sort order in chart .....................................70
in list box .........................................55
Sorting columns in straight table ..................83
in table box ..................................106
Start page ............................................19, 39
Starting QlikView .........................19
Statistics box ..................................57–59
creating .........................................58
Status Bar .......................................188
Straight table ....................................82
sorting columns ..................................83
System fields ......................................183
System table .....................................186
T
Table box ........................................104–107
adjusting columns .......................105
creating ........................................104
selections ..................................104
sorting columns ..................................106
Table label .......................................161
Terminology .........................................28
Text file ...........................................136
Text object ......................................112–113
Text search .........................................33
U
unlocking selections ..........................32
Updating a document .......................128
User Preferences ................................128
V
Visual cues .........................................84